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Introduction 

Paragon Hard Disk Manager™ 11 Professional is an integrated set of powerful tools that is specially designed to tackle 

most of the problems you might face while using PC. Its functionality covers all aspects of a computer life cycle 

beginning from carrying out all the necessary partitioning operations to install the system from scratch and providing its 

data reliable protection to secure utilization of an outdated hard disk. 

In this manual you will find the answers to many of the technical questions, which might arise while using the program. 

 

 

Our company is constantly releasing new versions and updates to its software, that's why 

images shown in this manual may be different from what you see on your screen. 

 

What’s New in Hard Disk Manager 11 

 Migrate OS to SSD to move any Windows OS since XP from a regular hard disk to a fast SSD (Solid State Drive) 

even of a smaller capacity, thanks to advanced data exclusion capabilities. 

 GPT Loader, a special system driver to allow use of all space of modern ultra high capacity drives (larger than 

2.2TB) on systems that don't support it. 

 The updated P2V Copy/Restore Wizards to migrate a Win2K+ physical system (live or from a Paragon’s backup) 

to a virtual environment of one of the supported virtualization software vendors. In the latest version of the 

product the wizards enable to: 

- Create and properly configure virtual machines according to your preferences. Depending on the selected 

virtualization vendor you’ve got the option to specify a version of the future virtual machine, its name, 

location, RAM to allocate, a disk controller, the guest OS, etc. So when the migration is over, you’ll get not 

only a virtual disk that contains an operating system and/or data, but a ready-to-use virtual machine. 

- Convert any combination of hard disks and partitions to migrate your entire computer or certain partitions 

in one operation. Complex backups that contain partitions from different hard disks are supported as well. 

- Employ MS VSS (Volume Shadow Copy Service) to synchronously migrate from several hard disks, thus 

ensuring data consistency during online migration of a system, which seats on several partitions or hard 

disks. This is achieved by taking a point-in-time snapshot of the whole disk subsystem. 

- When migrating from several hard disks, all their signatures will be kept intact, so you’ll get the same drive 

letters in a virtual environment. 

 The updated P2V Adjust OS Wizard allows creation of virtual machines as well, so besides its primary function, 

you can now build virtual machines out of supported virtual disks or Windows Vista/7 backup images. 

 Connect VD to connect a virtual disk as if it’s an ordinary physical disk, thus opening up all functionality available 

for physical disks to virtual. You’ve now got the option to: 

- Mount a virtual disk in the read-only mode to make sure no data will be changed on the virtual disk during 

copy or any other operation on it. 

- Support for VMware ESX Server’s export format to copy/retrieve data from virtual machines of this vendor. 

It’s useful for offline V2V and V2P operations. 
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 Create VD Wizard to create an empty virtual disk or with specific data of one of the supported virtualization 

vendors. 

 The updated P2P Adjust OS Wizard to successfully start up a Windows physical system on a different hardware 

platform (P2P) by allowing injection of all required drivers and the other actions crucial for this type of 

migration. Including the third generation of Paragon’s Adaptive Restore™ technology, it now can: 

- Analyze all installed drivers inside a target system to report on devices without drivers. 

- Search for and install lacking drivers from the built-in Windows repository. 

- Notify the user about boot critical devices without drivers (HDD/RAID controllers, etc.), automatically 

prompting to provide a path to a driver repository. 

- Name all devices according to their model description, not some alphanumeric code, which requires 

additional deciphering. 

- Determine and install drivers not only for boot critical devices, but for physically connected NICs as well. 

 Automatic partition alignment during partitioning/copy operations to optimize performance of your hard disk. 

 Check FS Integrity and Data Loss Policies to let you specify the acceptable balance between the operation 

performance and the risk of data loss. 

 Conversion of basic MBR disks to basic GPT to enjoy all benefits of the newest partitioning scheme with 

minimal effort. 

 WinPE 3.0 based bootable environment to enjoy support of a wider range of hardware configurations with the 

option to add drivers for specific hardware on-the-fly. 

 The updated Boot Corrector for WinPE that now equals the functionality of the Linux/DOS counterpart. 

 Backup files or entire disks to an FTP/SFTP server to provide a new level of system and data protection. 

 Besides US DoD 5220.22-M and a custom wipe algorithms, there are two more available to use: Russian GOST 

and Paragon’s. 

 Better support for 64-bit platforms to reboot your computer to one of the three special modes (Windows 

native, Linux, or DOS) to automatically complete operations, which cannot be accomplished under 64-bit 

Windows. 

 AFD (Advanced Format Drive) ready. 

 Support of 2TB+ and non-512B sector size drives. 

 USB 3.0 ready. 

Product Components 

In order to cope with different tasks, the product contains several components: 

 Windows based set of utilities is the crucial part of the product. With the help of an easy to use launcher you 

may find and run tasks of any complexity in the field of data and system protection, hard disk partitioning and 

cloning, etc. 

 Linux/DOS based recovery environment is a multi-platform bootable media that enables to run utilities under 

Linux or PTS DOS, and that way to get access to your hard disk for maintenance or recovery purposes. Both 

platforms have their strong sides, for instance Linux can boast support of FireWire (i.e. IEEE1394) or USB 

devices. It enables to burn CD/DVD discs. However there can be some difficulties with detecting new hardware. 
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DOS in its turn has no problems of that kind but is limited in features. The Linux/DOS recovery environment 

requires no installation and can be of great help when the system fails to boot. Besides it offers a Windows XP 

like environment. 

 WinPE based recovery environment. Especially for keen followers of Windows, our product also offers a WinPE 

3.0 based bootable media. Unlike the Linux/DOS recovery environment it can boast an excellent hardware 

support and the same interface as the Windows version can. However its system requirements are much 

tougher. 

Features Overview 

This chapter dwells upon key benefits and technical highlights of the product. 

Features  

Let us list some of the features: 

User Friendly Fault Minimizing Interface 

 Graphical representation of the data to gain a better understanding. 

 A handy Launcher to easily find and run the required tasks. 

 Comprehensive wizards to simplify even the most complex operations. 

 Resize partitions directly on the Disk Map with the drag-and-drop technique. 

 A context sensitive hint system for all functions of the program.  

 Previewing the resulting layout of hard disks before actually executing operations (so-called virtual 

operations). 

Backup Facilities 

 Archive Database to help the user easily manage backup images (get properties, add, delete, mount, etc.). 

 

 
This feature is only available for the Windows installation of the program. 

 

 Available location for backup images: 

- Backup to local mounted partitions. 

- Backup to local unmounted (without drive letter assigned) partitions. 

- Backup to an external mounted storage to provide for a higher level of data protection and system 

independence. 

- Backup to a special secured place on the hard disk called the Backup Capsule that has an independent system 

layout (e.g. a separate partition) and will stay operable should the active file system be damaged. To avoid an 

accidental removing or unauthorized access of the backup data, this partition is hidden and thus cannot be 

mounted in the operating system. 

- Backup to external media (CD/DVD) to guarantee a high level of data protection as long as the backup media is 

kept secure. 

- Backup to a network drive to stand a better chance of success in case of a hard disk failure. 
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- Backup to an FTP/SFTP server to provide a new level of system and data protection. 

 Smart Backup Wizard to secure system and data with the minimal efforts possible. With a unique intelligent 

work algorithm and a highly intuitive user interface, you can easily back up exactly what you need - the whole 

system, e-mail databases (MS Outlook, Express, Windows Mail) media files or office documents of the My 

Documents folder, or any other files and folders. 

 Differential backup to a sector image to only archive changes since the last full sector-based image, thus 

considerably saving the backup storage space. To restore this kind of backup you will require a full image and 

one of its differentials. 

 Incremental backup to a file image to only archive changes since the last full or incremental file-based image. 

An incremental image is smaller and takes less time to create, but you will require the initial full image and all of 

its incrementals to restore the latest point of this kind of backup. 

 File backup to a sector image. It is a unique technology on the market so far that bridges two principally 

different approaches of the data backup: the file-based backup and the disk imaging backup. With its help you 

can now create a sector-based backup of your system to get it back on track in minutes in case of a virus attack 

or a hardware malfunction and then just make file-based incremental images to the previously created sector-

based backup to keep updated only information that is critical for you. Thus you will considerably save your 

system resources. 

 Cyclic backup to automate the backup of separate partitions. It is an ideal option if you want to establish a self-

acting data protection system. 

 

 
This feature is only available for the Windows installation of the program. 

 

 Synthetic backup to change any property (merge a given differential image with its full image, split/un-split, 

compress/de-compress, etc.) of an existing backup image without carrying out a physical backup operation. 

 Bootable Backup Capsule to get the choice to launch the Linux or PTS DOS recovery environment every time 

you start up the computer. With its help you will be able to run utilities under Linux or PTS DOS, and that way to 

get access to your hard disk for maintenance or recovery purposes. 

 

 
This feature is only available for the Windows installation of the program. 

 

Restore Facilities 

 Restore an entire disk, separate partitions or only files you need from the previously created backup image. 

 Restore with Shrink to restore a backup image to a free block of smaller size taking into account only the 

amount of actual data of the image. 

 Adaptive Restore to successfully migrate a Windows physical system to a different hardware platform (P2P) by 

allowing automatic injection of all required drivers and the other actions crucial for a migration of this kind. 
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This feature is only available for the bootable recovery environment. 

 

Copy Facilities 

 Migrate OS to SSD to move any Windows OS since XP from a regular hard disk to a fast SSD (Solid State Drive) 

even of a smaller capacity, thanks to advanced data exclusion capabilities. 

 Partition/hard disk copy to successfully transfer all on-disk information including standard bootstrap code and 

other system service structures, thus maintaining the operating system’s working capability. 

 

 
Copy functionality can also be used as an alternative way of data protection. 

 

Virtualization Facilities 

 Connect VD to connect a virtual disk as if it’s an ordinary physical disk, thus opening up all functionality available 

for physical disks to virtual. 

 P2V Copy to migrate a Windows physical system to a virtual environment in the online mode. 

 P2V Restore to migrate a Windows physical system backed up with a Paragon disaster recovery tool to a virtual 

environment. 

 P2V Adjust to recover the startup ability after unsuccessful virtualization with a 3rd party tool. 

 Create VD to create an empty virtual disk or with specific data of one of the supported virtualization vendors. 

 

 
Virtualization is the latest trend in the system migration, protection, and evaluation. 

 

Boot Management Facilities 

 Boot Manager Setup Wizard to easily manage several operating systems on one computer. 

Partition/Hard Disk Management Facilities 

 Basic functions for initializing, partitioning and formatting hard disks (create, format, delete). Instead of the 

standard Windows disk tools, the program supports all popular file systems. 

 Express Create Partition Wizard to create a new partition in the most appropriate place of a hard disk, format it 

to NTFS and then make it available in the system by assigning a drive letter. 

 Merge Partitions Wizard to consolidate the disk space, which originally belongs to two adjacent partitions 

(NTFS, FAT16/FAT32), into a single, larger partition. 

 Redistribute Free Space Wizard to increase free space on one partition by up-taking the on-disk unallocated 

space and the unused space of other partitions. 

 Express Resize Partitions Wizard to increase free space on one partition by up-taking the unused space of an 

adjacent partition of a hard disk (including partitions of Apple Boot Camp). 
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 NTFS hot resize upward to enlarge an NTFS partition (system, locked) without rebooting Windows and 

interrupting its work. 

 Convert a file system (FAT16/32, NTFS, Ext2/Ext3) without reformatting. 

 Mount a partition (assign a drive letter) of any file system type to make it available for your operating system. 

 Modify file system parameters (make active/inactive, hide/unhide, etc.). 

 Install New OS Wizard to make a system ready to install a new operating system. 

 Undelete Partitions Wizard to recover an accidentally deleted partition. 

File System Optimization Facilities 

 27 defragmentation strategies available to defragment FAT and NTFS file systems. 

 MFT defragmentation and shrinking to improve performance of NTFS. 

 Safe Defragmentation Mode to guarantee data loss free defragmentation of any version of NTFS and FAT. 

 Low free space defragmentation (less than 1% of the free space required) to successfully defragment almost full 

disks. 

 

 

Defragmentation is accomplished with a separate component called Paragon Total Defrag. 

To know more on the subject, please consult its help. 

 

Wipe Facilities 

 Data wiping to successfully destroy all on-disk information including the standard bootstrap code and other 

system service structures. 

 Free space clearing to destroy any remnants of deleted files/directories left on disk without affecting the used 

data. 

Automatization Facilities 

 Task scheduling to automate routine operations. It can be particularly effective when you have to repeat a 

sequence of actions on a regular basis. 

 

 
Scheduling is only available for the Windows installation of the program. 

 

 Scripting to make the program create a script of any set of operations you need. Besides support of all 

operations available in the interactive mode, the unattended mode provides some additional features, such as 

conditional execution, subroutines, repeatable iterations, disk/partition properties analysis, errors 

management, etc. 

Auxiliary Facilities 

 GPT Loader is a special system driver to allow use of all space of modern ultra high capacity drives (larger than 

2.2TB) on systems that don't support it. 

 Conversion of basic MBR disks to basic GPT to enjoy all benefits of the newest partitioning scheme with 

minimal effort. 
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 File Transfer Wizard to make such operations as transferring of files/directories or burning of them to CD/DVD 

as easy and convenient as possible. Providing access to Paragon backups as regular folders, it may also help to 

replace corrupted data from a previously created image in case of an operating system failure. 

 Volume Explorer is a handy tool when you have different file systems on the disk, whether they contain an 

operating system or just data. Volume Explorer will let you explore a file system of any type and provide access 

to the necessary files and directories regardless of their security attributes. 

 Recovery Media Builder to create a bootable recovery media on a CD, DVD disc, or flash memory, which can 

later be used to boot and recover your computer in case of an operating system failure. Moreover, with its help 

you can save data from partitions of your hard disk directly to compact discs or burn ISO-images. The utility 

supports various formats of laser discs: CD-R/RW, DVD-R/RW, DVD+R/RW, DVD-R, DVD+R double layer, Blu-ray 

and can handle multi-session burning. 

 Network Configuration Wizard to establish a network connection a bootable recovery media either to save a 

backup of a partition/hard disk or just several files on a network computer or retrieve a previously made backup 

from a network computer for recovery purposes. 

 Boot Corrector to fix most of the system boot problems that can be a result of a human factor, program error or 

a boot virus activity. 

 

 
Boot Corrector is only available for the bootable recovery environment. 

 

Supported Technologies 

Along with using innovative technologies from outside, Paragon has developed a number of its own original 

technologies that make its products unique and attractive for customers: 

 Paragon Hot Backup™ technology to back up locked partitions and hard disks under Windows NT+ family 

operating systems providing both high operating efficiency as well as low hardware requirements. 

 Paragon Hot Copy™ technology to copy locked partitions and hard disks under Windows NT+ family operating 

systems providing both high operating efficiency as well as low hardware requirements. 

 Paragon Adaptive Restore™ technology to successfully migrate a Windows physical system to a different 

hardware platform (P2P). 

 Paragon Power Shield™ technology to provide data consistency in case of a hardware malfunction, power 

outages or an operating system failure. 

 Paragon UFSD™ technology to browse partitions of any file system including hidden and unmounted, modify 

and copy files and folders, etc. 

 Paragon Hot Resize™ technology to enlarge NTFS partitions (system, locked) without rebooting Windows and 

interrupting its work. 

 Paragon Restore with Shrink™ technology to restore a backup image to a free block of smaller size taking into 

account only the amount of actual data of the image. 

 Paragon Smart Partition™ technology to securely perform hard disk partitioning operations of any complexity. 

 Paragon BTE™ technology to set tasks for execution during the system restart, thus saving from the need to use 

a bootable media when modifying system partitions. 
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 Paragon VIM™ (Virtual Image Management) technology that enables Paragon products work with virtual disks 

as though they are physical hard disks. 

 Microsoft Volume Shadow Copy Service (VSS) to provide the copy/backup infrastructure for the Microsoft 

Windows XP/Vista/7/Server 2003/2008 operating systems. It offers a reliable mechanism to create consistent 

point-in-time copies of data known as shadow copies. Developed by Microsoft in close cooperation with the 

leading copy/backup solution vendors on the market, it is based on a snapshot technology concept. 

 Microsoft Dynamic Disk (simple, spanned, striped, mirrored, RAID-5) to offer more management flexibility 

without the partition limitation of basic disks. Dynamic storage can be particularly beneficial for large-scale 

businesses when dealing with many physical hard disks involving complex setup. 

 GUID Partition Table (GPT). It is the next generation of a hard disk partitioning scheme developed to lift 

restrictions of the old MBR. GPT disks are now supported by Windows Vista/7, Server 2008, Mac OS X and Linux. 

Supported Virtual Machines 

 Microsoft Virtual PC 

 VMware Workstation 

 VMware Fusion 

 Oracle VirtualBox 

Additionally for Connect VD and P2V Adjust OS only 

 MS Windows backups (.vhd images) 

Additionally for Connect VD only 

 Parallels Workstation 

 XenServer (.vhd only) 

Supported File Systems 

 Full read/write access to FAT16/FAT32 partitions. 

 Full read/write access to NTFS (Basic Disks) under Windows, Linux and PTS DOS. Compressed NTFS files are also 

supported. 

 Full read/write access to Ext2FS/Ext3FS/Ext4FS partitions. 

 Limited read/write access to Apple HFS+ partitions. 

 

 

Unfortunately, support of non-Roman characters for the HFS+ file system is unavailable at 

the moment. The company is about to implement it in the nearest future. 

 

Supported Media 

 Support of both MBR and GPT hard disks (2.2TB+ disks included) 

 IDE, SCSI and SATA hard disks 

 SSD (Solid State Drive) 

 AFD (Advanced Format Drive) 
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 Non-512B sector size drives 

 CD-R, CD-RW, DVD-R, DVD+R, DVD-RW, DVD+RW, DVD-R, DVD+R double layer and also Blu-ray discs 

 FireWire (i.e. IEEE1394), USB 1.0, USB 2.0, USB 3.0 hard disks 

 PC card storage devices (MBR and GPT flash memory, etc.) 

Getting Started 

In this chapter you will find all the information necessary to get the product ready to use. 

Distribution 

Paragon Hard Disk Manager 11 is distributed in two ways: 

 Boxed package from Paragon Software GmbH and resellers 

 Downloadable package over the Internet at the company’s web-site 

Distributive CD 

The boxed package includes a distributive CD that is in fact a bootable recovery environment with auto-run of the 

Windows installation, thus it can be used as a ready-made solution. But if you’re going to run the Windows components, 

you need to install them first (see Installation). 

If you want to download an update/upgrade of the product, it will be in form of the downloadable installation package 

as described in Online Distribution). 

Online Distribution 

Hard Disk Manager 11 purchased over the Internet will be in form of an MSI package. After installing the product you 

can launch the Recovery Media Builder to prepare a recovery media. 

 

 

Depending on your product and edition, you might need to additionally download an image 

of our WinPE recovery environment, which opens the option to prepare it on a CD/DVD/BD 

or a flash card before installing our software. 

 

Registration 

Paragon Software GmbH provides a wide range of online services through its web-portal - www.paragon-

software.com/support/: 

 Registration of new users; 

 Registration of purchased products for registered users; 

 Available around-the-clock downloading center, where registered users can get product updates/upgrades as 

well as all the necessary documentation; 

 Downloadable free demo versions and open documentation for all users. 

 

 
It is recommended to use Internet Explorer 5+ or any compatible browser. 

 

http://www.paragon-software.com/support/
http://www.paragon-software.com/support/
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To register as a new user 

To register as a new user, please do the following: 

1. Run an Internet browser and visit the page: www.paragon-software.com/my-account/; 

2. Click Create of the Create a Paragon Account section; 

3. Fill out a registration form; 

4. Click Register. 

The most important field in the form is an E-mail address, as it serves as a login to enter the system. Besides your access 

password will be sent to this address as well. 

To register a new product 

If you are a registered user and would like to register Hard Disk Manager 11, please do the following: 

1. Run an Internet browser and visit the page: www.paragon-software.com/my-account/; 

2. In the Email field of the Authorization section, enter an E-mail used for registration; 

3. In the Password field enter a password received after registration; 

4. Click Sign in; 

5. If the user name and password are valid, you will get to your account; 

6. Click Register new product of the Products section; 

7. Enter your product serial number in the Serial Number field. You can find it in the product box or obtain from 

your reseller. Click Next; 

8. On the next page you will be asked to provide some additional data. Also you will need to decide whether you 

want to get confirmation on registering the product by E-mail or not. Click Next, and then click Finish. 

That is all. The product is now registered. 

How to Download Updates/Upgrades 

Downloading of updates/upgrades can be fulfilled in the following way: 

1. Run an Internet browser and visit the page: www.paragon-software.com/my-account/; 

2. In the Email field of the Authorization section, enter an E-mail used for registration; 

3. In the Password field enter a password received after registration; 

4. Click Sign in; 

5. If the user name and password are valid, you will get to your account; 

6. Select My Downloads of the Products section to see what updates are available for you; 

7. Select the desired update and click Download. 

Contacting Paragon Software GmbH 

If you have any questions about the company products, please do not hesitate to contact Paragon Software GmbH. 

Service Contact 

Visit Paragon Software web site www.paragon-software.com 

Registration & updates web-service www.paragon-software.com/support 

https://www.paragon-software.com/my-account/login.htm
https://www.paragon-software.com/my-account/login.htm
https://www.paragon-software.com/my-account/login.htm
http://www.paragon-software.com/
https://www.paragon-software.com/support/index.html
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Knowledge Base & Technical Support kb.paragon-software.com 

Pre-sale information sales@paragon-software.com 

 

System Requirements 

For the Windows installation package 

 Operating systems: 

- Windows XP (32 and 64 bit) 

- Windows Vista (32 and 64 bit) 

- Windows 7 (32 and 64 bit) 

 Internet Explorer 5.0 or higher  

 Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed  

 128 MB of RAM (256+ recommended) 

 Hard disk drive with 250 MB of available space  

 SVGA video adapter and monitor  

 Keyboard 

 Mouse 

 

 
During the installation additional free space (up to 1GB) will be required. 

 

For the Linux bootable environment 

 Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed 

 256 MB of RAM  

 SVGA video adapter and monitor  

 Keyboard 

 Mouse 

For the WinPE bootable environment 

 Intel Pentium III CPU or its equivalent, with  1000 MHz processor clock speed  

 At least 512 MB of RAM 

 SVGA video adapter and monitor  

 Keyboard 

 Mouse 

Additional requirements 

 Network card to send/retrieve data to/from a network computer 

http://kb.paragon-software.com/
sales@paragon-software.com
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 Recordable CD/DVD drive to burn data to compact discs 

 External USB hard drive to store data. 

Installation 

To install Paragon Hard Disk Manager 11, please do the following: 

1. Run Setup Application. Click on the *.MSI file. This application will guide you through the process of the 

program installation. The setup utility is compiled with the InstallShield SDK, hence it contains the standard user 

interface and set of installation steps. 

 

 

In case there is some previous version of the program installed on the computer, the 

program will offer the user to uninstall it first. 

 

2. Starting Setup. The Welcome page informs that the application is being installed. Click the Next button to 

continue. 

3. Confirm License Agreement. The License Agreement page displays the Paragon License Agreement. Read the 

agreement and then select the appropriate option to accept. If you do not agree with any conditions stated 

there, the installation process will be interrupted. By clicking the Print button, the License Agreement may also 

be printed out. 

4. Provide Registration Information. On the Registration page you are to provide your product key and serial 

number. 

5. Provide Customer Information. On the Customer Information page you are to provide the standard 

information, i.e. a user name and an organization. Besides you need to decide whether to make the program 

available for all users of this computer (if several) or only for the current one. 

6. Select an Installation Folder. The Destination Folder page allows you to choose a folder where the program will 

be installed. By default, the installation folder will be created as: 

C:\Program Files\Paragon\Paragon Hard Disk Manager 11. To select another folder, click the Change… button. 

After you have selected the required folder, click the Next button to continue. 

 

 

Do not install the program on network drives. Do not use Terminal Server sessions to install 

and run the program. In both cases, the program functionality will be limited. 

 

7. Confirm Installation. On the Ready to Install the Program page click the Install button to start the installation or 

the Back button to return to any of the previous pages and modify the installation settings. 

8. Copying Files. The Copying Files page shows the overall progress of the installation. Click the Cancel button to 

abort the setup. 

9. Finishing the Installation. The Final page reports the end of the setup process. Click the Finish button to 

complete the wizard. 

 

 

To accomplish online operation on locked partitions/hard disks the program uses a kernel 

mode hotcore driver, thus the system reboot is required to complete the installation 

procedure. 
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First Start 

To start Paragon Hard Disk Manager 11 under Windows, please click the Windows Start button and then select 

Programs > Paragon Hard Disk Manager™ 11 > Paragon Hard Disk Manager™. 

 

 

The program provides wide opportunities in the field of hard disk structure modification, so 

just to be on the safe side, please make a backup of your data before carrying out any 

operation. 

 

The first component that will be displayed is called the Express Launcher. Thanks to a well thought-out categorization 

and hint system, it provides quick and easy access to wizards and utilities that we consider worth using on a regular 

basis. With its help you can also start up the traditional launcher, the help system or go to the program’s home page. 

 

 

 

To know more on how to handle the product’s interface and accomplish typical operations, 

please consult the Windows Components chapter. 

 

Building Recovery Media 

Recovery Media Builder can help you accomplish the following operations: 
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 Prepare the Linux/DOS recovery environment (included in the installation package) on external media (CD, DVD, 

or flash memory) to boot and run utilities under Linux or PTS DOS, and that way to get access to your hard disk 

for maintenance or recovery purposes (strongly recommended); 

 Prepare a custom Linux/DOS recovery environment by adding any data you like to the standard image; 

 Prepare a bootable recovery environment from any ISO image, including our WinPE 3.0 image (strongly 

recommended); 

 Create from the master CD the Linux/DOS or WinPE recovery environment on a CD/DVD disc, or flash memory. 

Below you can find how to build our WinPE 3.0 based recovery environment on a thumb drive: 

1. Plug in a thumb drive of at least 250 MBs in size. Please note all data on that drive will be deleted. 

2. In the Main Menu: select Tools > Recovery Media Builder… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. On the Wizard's Welcome page, click the Next button. 

4. Select the Flash Memory option. 

 

5. Select the User specified CD/DVD image (.iso file) option, then browse for an ISO image of our WinPE 3.0 

recovery environment or manually type in a full path to it. By selecting the Typical option you can build our 

Linux/DOS recovery environment, which we highly recommend you to do as well. 

 

 

 

You can get an ISO image of our WinPE 3.0 recovery environment through the company’s 

web service. 

 

6. Select the required thumb drive from the list of flash memory devices available in the system at the moment (if 

several). 
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7. You will have to confirm the operation. 

 

Booting from the Linux/DOS Recovery Media 

The Linux/DOS recovery environment can be used to boot your computer into Linux or PTS DOS to get access to your 

hard disk for maintenance or recovery purposes. It also has the PTS DOS safe mode, which may help in a number of non-

standard situations such as interfering hardware settings or serious problems on the hardware level. In this case, only 

basic files and drivers (such as hard disk drivers, a monitor driver, and a keyboard driver) will be loaded. 

Startup 

To start working with the Linux/DOS recovery environment, please take the following steps: 

1. Start up the computer from our Linux/DOS recovery media. 

 

 

Recovery Media Builder can help you prepare our recovery environment either on a 

CD/DVD disc or a thumb drive. 

To automatically boot from the recovery media please make sure the on-board BIOS is set 

up to boot from CD/USB first. 

 

2. Launch a boot mode you need (Normal, Safe, Low-Graphics Safe) in the Boot menu. 

 

 
By default the Normal Mode will be automatically initiated after a 10 second idle period. 

 

3. Click on the required operation to start. Hints on the selected at the moment item will help you make the right 

choice. 

4. Consult the help system by pressing ALT+F1 to know more on the subject. 

Boot menu 

The Boot menu contains the following commands: 
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 Normal Mode. Boot into the Linux normal mode. This mode uses the full set of drivers (recommended); 

 Safe Mode. Boot into the PTS DOS mode. This mode can be used as an alternative of the Linux normal mode if it 

fails to work properly; 

 Low-Graphics Safe Mode. Boot into the PTS DOS safe mode. In this case, only the minimal set of drivers will be 

included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu; 

 Floppy Disk. Reboot the computer from a system floppy disk; 

 Hard Disk 0. Boot from the primary hard disk; 

 Find OS(s) on your hard disks. The program will scan hard disks of your computer to find any bootable operating 

system. 

To move within the menu, please use the arrow keys of the computer keyboard. 

 

 

While working with the recovery environment you might experience some inconvenience 

caused by possible video artifacts. It is just a result of changing video modes and in no way 

will affect the program functionality. If this is the case, please wait a bit and everything will 

be OK. 

 

Normal Mode 

When the Normal mode is selected, the Linux launch menu appears: 
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 Hard Disk Manager (enables to run wizards and dialogs, to specify program settings, to visualize the operating 

environment and the hard disk configuration); 

 Simple Restore Wizard (allows restoring hard disks and partitions); 

 Disk Copy Wizard (helps to clone a hard disk); 

 Undelete Partition (allows recovery of accidentally deleted partitions); 

 Wipe Wizard (enables to destroy all on-disk information or only remnants of deleted files/directories); 

 File Transfer Wizard (allows coping files/folders to another disk or a partition as well as recording them to 

CD/DVD); 

 Boot Corrector (helps to correct the Windows System Registry without Windows being loaded); 

 Network Configurator (enables to establish a network connection under Linux); 

 

 

If you are going to use network resources, first launch the Network Configuration Wizard to 

establish a network connection. 

 

 Log Saver (helps to collect and send the necessary log files to the Technical Support); 

 View the mounted partitions (the list of all mounted partitions will be displayed); 

 

 

The Linux/DOS recovery environment assigns drive letters to partitions the way it is done in 

DOS, i.e. one after another, primary partitions at first. Thus mounted partitions may have 

different drive letters from Windows. 

 

 Eject CD/DVD; 

 Command Line (allows experienced users to execute any operation); 

 Reboot the computer; 

 Power off the computer. 

To move within the menu, please use the arrow keys of the computer keyboard. 

Safe Mode 

When the Safe mode is selected, the PTS DOS launch menu appears. It has nearly the same functionality as for the 

Normal mode except for the Network Configurator and Log Saver commands. Besides due to certain limitations of the 

PTS DOS environment, there is no possibility to burn CD/DVD discs. 

Low Graphics Safe Mode 

When the Low Graphics mode is selected, the PTS DOS launch menu appears. It has the same functionality and looks 

similar to the Safe mode but graphically simpler. 
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Booting from the WinPE Recovery Media 

The WinPE recovery environment can be a real alternative to the Linux/DOS recovery environment. Providing nearly the 

same level of functionality it offers an excellent hardware support and the same interface as the Windows version does. 

Startup 

To start working with the WinPE recovery environment, please take the following steps: 

1. Start up the computer from our WinPE recovery media. 

 

 

Recovery Media Builder can help you prepare our recovery environment either on a 

CD/DVD disc or a thumb drive. 

To automatically boot from the recovery media please make sure the on-board BIOS is set 

up to boot from CD/USB first. 

 

2. Once it has been loaded, you will see the License Agreement. Read the agreement and then mark the 

appropriate checkbox to accept. If you do not agree with any conditions stated there, you won’t be able to use 

the program. 

 

3. Once you accept the agreement, you will see the Universal Application Launcher. In general it enables to run 

components of the product, load drivers for undefined hardware or establish a network connection. 
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4. Click on the required operation to start. Hints on the selected at the moment item will help you make the right 

choice. 

5. Consult the help system by pressing ALT+F1 to know more on the subject. 

 

 

Our WinPE 3.0 based recovery environment offers excellent hardware support. However in 

case it doesn’t have a driver for your disk controller, your hard disks will be unavailable. 

Please consult the Adding specific drivers scenario to know how to tackle this issue. 

 

Basic Concepts  

This chapter explains terms and ideas that show how the program works. To understand these helps to obtain a general 

notion of the operation performance and makes it easier for the user to operate the program. 

System and Data Protection  

The data protection issue is a growing cause of worrying for more and more people today. Indeed, it is hardly to find a 

person who will be particularly happy when all precious information on the hard disk is irreversible lost as a result of its 

malfunction. So how this tragedy can be prevented? 

File Backup versus Sector Backup 

Since the advent of the computer age people were in the search of ways to guarantee data safety. As a result we’ve got 

now two principal approaches: the file-based backup and the sector-based backup. The main difference between the 

two lies in the way data is treated. 
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A sector-based backup operates with an image (or a snapshot) of the whole disk system or its separate partitions. It not 

only includes the contents of all user-made files, but additionally contains the exact structure of directories, information 

about file allocation, file attributes and other related data. Thus it enables to successfully process system or encrypted 

partitions of any file system type, no matter what kind of information they contain. 

In contrast, a file-based backup takes into account a file system structure and only functions on a file or folder level. So 

it is very efficient when archiving separate files or folders, but in no way will help you back up a system partition. 

You should understand pretty well that each of the two approaches is only good when properly chosen. In the 

comparison table below you can see when this or that approach will suit you at most. 

Sector-Based Backup File-Based Backup 

Merits 

It does not dependent on a particular file system. 

Thus it can successfully process system or 

encrypted partitions of any file system type, no 

matter what kind of information they contain. 

Functioning on a file/folder level, it is ideal for 

archiving separate files or folders. 

It can create an exact image of a partition, 

including its service data. Thus it is ideal for a 

backup/restore of a system partition or a fast 

deployment to a bunch of identical computers. 

It enables to automatically build up contents of 

the future backup image by using an advanced 

system of filters. 

 It allows archiving data of the same volume with 

different backup policies. 

 It is easy and efficient when creating backup 

chains. 

Demerits 

Resulted backup images may contain a lot of 

redundant data. 

It depends on a file system structure, so you 

won’t be able to process unknown file systems. 

It is ineffective when trying to maintain a backup 

chain, especially when little amount of data is 

being changed. 

It cannot be used to back up a system partition. 

 It is much slower when processing large amount 

of data. 

Backup Types 

At the present moment the market is offering various types of backup imaging to meet the needs of any user. Besides 

supporting them all, our program offers a unique backup type, called File Increment to a Sector Backup. 

Full and Differential Sector Backups 

A full sector-based backup image includes all contents of a partition or a hard disk at the moment of its creation. If you 

roll back your system to the initial state on a regular basis, that’s exactly what you’re looking for. But if you want to have 

multiple backup archives of the same partition reflecting certain time stamps, unchanged data will inevitable be 
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duplicated in all archives and take additional space on backup media. To tackle this issue there has been developed a 

supplementary technique called Differential Sector Backup. 

A differential archive only contains data changed since the time of creating a full archive, which forms a base (or a 

parental image) in this case, thus considerably saving your system resources. It is realized by the exact bit-wise 

comparison of the previous partition's data (saved in the parental image) with the current data (that is actually the 

partition itself). To restore this kind of backup you will require a full image and one of its differentials, what is very 

convenient. 

 

 

 
This function is only available for single primary and logical partitions. 

 

Full and Incremental File Backups 

A full file-based archive only contains files and folders. It is really efficient when backing up an e-mail database or 

particular documents, as no redundant data is processed. But if you care about maintaining a files history, you can 

benefit from one more supplementary technique called Incremental File Backup. 

An incremental archive only contains data changed since the time of creating a full or incremental file-based archive. It 

is smaller and takes less time to create, but you will require the initial full image and all of its increments to restore the 

latest point of this kind of backup. 
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File Increment to a Sector Backup 

File Increment to a Sector Backup is a unique technology on the market so far that bridges two principally different 

approaches of the data backup: the file-based backup and the sector-based backup. With its help you can now create a 

sector-based backup of your system to get it back on track in minutes in case of a virus attack or a hardware malfunction 

and then just make file-based incremental images to the previously created sector-based backup to keep updated only 

information that is critical for you. Thus you will considerably save your system resources. 

Backup Storage 

Our program supports several techniques of storing backup images. Let’s take a closer look at them all to understand 

what kind of storage is able to provide better security: 

 You can place a backup image to a local partition. Despite the fact that it is the most convenient way, try not to 

use it. You can delete your backup just by accident or lose it as a result of a hardware malfunction, or a virus 

attack; 

 You can place a backup image to an external mounted storage to provide for a higher level of data protection 

and system independence; 

 You can place a backup image to a special secured place on the hard disk called the Backup Capsule that has an 

independent system layout (e.g. a separate partition) and will stay operable should the active file system be 

damaged. To avoid an accidental removing or unauthorized access of the backup data, this partition is hidden 

and thus cannot be mounted in the operating system. However it won’t help you in case of a hardware 

malfunction; 

 You can place a backup image to external media (CD/DVD) to guarantee a high level of data protection as long 

as the backup media is kept secure; 

 You can place a backup image to a network drive to stand a better chance of success in case of a hard disk 

failure. Moreover, by storing it on a special-purpose server you may be pretty sure nothing will happen to it; 

 Finally you can place a backup image to an FTP server to provide a new level of system and data protection. 

Known Issues on FTP/SFTP 

1. You need to check out yourself Windows Firewall or programs of this kind let our program work with the 

required port (21 by default). 

2. You cannot restore data selectively (with Restore Wizard) from an FTP/SFTP server. 

3. You can browse an FTP server in the passive mode only. 

4. Parallel access to several FTP/SFTP servers is limited - only one password for all servers is available. 

Adaptive Restore 

Technology Background 

Windows family operating systems are notorious for their excessive sensibility to hardware, especially when it turns to 

replacement of such a crucial device as HDD controller or motherboard – actually Windows will most likely fail to boot 

as a result of this operation. 

In 2008 our company came with an exclusive technology called Paragon Adaptive Restore™. Initially aimed at restore of 

Windows Vista or Server 2008 from a backup to a different hardware configuration, its current realization, available in 

the P2P Adjust OS Wizard, enables to make any Windows OS since XP bootable on dissimilar hardware by allowing 

automatic injection of all required drivers and the other actions crucial for this type of migration. 
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Technology Concept 

Let’s take a closer look at how Paragon Adaptive Restore works. 

 

As you see, successful migration of a Windows system to a different hardware platform involves several actions: 

1. Change of the Windows kernel settings according to the new configuration. The program detects the given 

hardware profile and automatically installs the appropriate Windows HAL and kernel. 

2. Installation of drivers for boot critical devices. The program detects those without drivers and automatically 

tries to install lacking drivers from the built-in Windows repository. If there’s no driver in the repository, it 

prompts the user to set a path to an additional driver repository, strongly recommending not to proceed until all 

drivers for the found boot critical devices are installed. In case drivers for these devices are installed, but 

disabled, they will be enabled. 

3. Installation of drivers for a PS/2 mouse and keyboard. This action will only be accomplished for Windows 

XP/Server 2003. 

4. Installation of drivers for network cards. The program detects those without drivers and automatically tries to 

install lacking drivers from the built-in Windows repository. If there’s no driver in the repository, it prompts the 

user to set a path to an additional driver repository. 

These actions guarantee a Windows system will start up on dissimilar hardware. After the startup, Windows will initiate 

reconfiguration of all Plug'n'Play devices. It’s a standard procedure, so please don’t worry and prepare the latest drivers 

at this step to get the most out of the system. 

 

 

Though all Windows systems have built-in driver repositories, please be prepared to have 

additional drivers when dealing with Windows XP/Server 2003, because for these systems 

they are very modest. 
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Technology Application 

Let’s consider a number of situations when the Adaptive Restore technology can help you out: 

 If you need to migrate to a different hardware platform with minimal effort 

 If you need to upgrade hardware while keeping all programs and settings intact 

 If you need to replace failed hardware and cannot find an exact match for original system specifications 

Known Issues 

1. After transferring Microsoft Vista and later versions to different hardware, you will need to re-activate license of 

the system. It’s normal behavior as these systems keep tracking any change of hardware. Re-activation is legally 

justified in this case, as you transfer your system to another PC. 

2. If you’ve installed several operating systems on one partition, we can only add drivers to the latest version of 

OS. Microsoft highly recommends that you install an operating system on a separate partition. 

3. Please note drivers are not cached during selection. That’s why if you select a driver to add to the system, but 

it’s already unavailable during the operation, the program will end the operation with an error. 

System Virtualization 

With new powerful x86 computers, system virtualization has become extremely popular. It’s a software technology that 

enables to run several virtual machines on one physical machine, providing resources of that single computer are shared 

across several environments. As a result one and the same physical computer can have multiple OSs and applications 

operating simultaneously, thus opening up enormous opportunities for both, business and home users, exactly: 

 Avoid underutilization of up-to-date powerful computers; 

 Increase flexibility of a physical infrastructure; 

 Provide for increased availability of hardware and applications; 

 Cut expenses on hardware and energy; 

 Guarantee smooth and cost saving system migration; 

 Enjoy working with old applications you can’t launch on your current PC; 

 Take advantage of having multiple operating systems on one Windows PC, including Linux, Mac OS X, etc.; 

 Forget about hunting for replacement of the failed hardware, and many more… 

Known Issues 

1. You should install integration services (e.g. VMware Tools) on the virtual system yourself. We only guarantee its 

smooth startup. 

2. After transferring Microsoft Vista and later versions to a virtual disk, you will need to re-activate license of the 

system. It’s normal behavior as these systems keep tracking any change of hardware. Re-activation is legally 

justified in this case, as you transfer your system to another PC. 

3. If your system hosts several Windows OSes, our program will find them all and automatically patch to run in a 

virtual environment. However we cannot guarantee smooth startup of all found Windows systems, but the 

guest OS, for its configuration parameters may be incompatible with the others. 
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Paragon Hot Processing & Volume Shadow Copy Service 

Offline versus Online Data Processing 

In the course of time there have been developed various methods of data processing. Despite different work concept, 

all of them can be divided into two principal groups: offline (cold) and online (hot) data processing techniques. 

As the name infers, offline data processing can only be accomplished when the data is in consistent state (the operating 

system and all the applications are completely shut down). Actually it is the most preferable way of image creation or 

data cloning, since software can obtain an exclusive right to process data that guaranties high level of operating 

efficiency. However, the offline data processing is absolutely out of question when dealing with 24/7 production 

environments. 

In contrast, online data processing enables to create a consistent snapshot even as the data is currently modified. It is 

particularly useful for systems with high availability requirements, but it won’t be accomplished until all active 

transactions are complete. The point is to provide a coherent state of all open files and databases involved in a process, 

taking into account that applications may still keep writing to disks. As a result an online data processing cannot boast 

high operating speed. 

Our program supports both offline and online methods of data processing. As far as online method is concerned it offers 

its own hot processing algorithm together with the possibility to use snapshot technologies provided by the Microsoft 

VSS framework. 

Paragon Hot Processing Technology 

Paragon Hot Processing is an online copy/backup technology for Windows NT+ family operating systems. Developed 

back in 2001, nowadays it is integrated with all copy/backup solutions offered by the company. 

Paragon Hot Processing is not exactly a snapshot technology, though it has much in common with it. During an online 

copy/backup, the program uses the kernel mode driver HOTCORE.SYS to intercept and control disk write activity of 

applications and the operating system. The hotcore driver as an integral part of the program is installed during the setup 

procedure (that’s why the system reboot is required to complete the setup procedure). For the most part the driver is in 

the idle mode until it is activated with the program. While in this mode it bypasses any calls having no effect on the 

overall system performance, but a few kilobytes of the system memory. 

Paragon Hot Processing technology offers copy/backup of locked partitions and hard disks under Windows NT+ family 

operating systems providing both high operating efficiency as well as low hardware requirements. 

 

 

It is not recommended to use Paragon Hot Processing with active SQL Server, Exchange or 

Oracle databases since the backup image contents may be corrupted. 

 

Volume Shadow Copy Service 

Microsoft Volume Shadow Copy Service (VSS) is designed to provide the copy/backup infrastructure for the Microsoft 

Windows XP/Vista/Server 2003/2008 operating systems. It offers a reliable mechanism to create consistent point-in-

time copies of data known as shadow copies. Developed by Microsoft in close cooperation with the leading 

copy/backup solution vendors on the market, it is based on a snapshot technology concept.  

Initiated by a VSS aware copy/backup utility, VSS creates snapshots for the selected volumes and represents them as 

virtual read-only devices, called volume shadow copies. Once the shadow copies are created, the copy/backup utility 

starts processing the data while applications keep writing to original volumes. 



33 

Copyright© 1994-2011 Paragon Software Group. All rights reserved. 

Unlike Paragon Hot Processing the VSS technology provides a unique possibility to make a synchronous snapshot of 

multiple volumes. This very feature can be particularly beneficial when backing up active SQL Server 2003, Exchange 

2003 or Oracle databases located on multiple volumes the way it is recommended by Microsoft to improve the level of 

database performance and reliability, thus providing 100-percent data consistency. 

 

 
To use VSS it is necessary to have a mounted 300 MB+ NTFS partition. 

 

Dynamic Disks 

As you probably know, MS-DOS, Microsoft Windows 95/98/Me/NT/2000/XP/Vista/Server 2003/2008 support four 

primary partitions per physical hard disk, one of which can be extended. Certainly there is the possibility to create 

logical drives within the extended partition. Such types of disks are called basic. Windows XP Professional, Windows 

2000, Windows Vista and Windows Server 2003/2008 follow the same strategy: You can have a maximum of four 

primary partitions, one of which can be an extended partition with logical drives. However, these operating systems also 

introduce a new disk configuration type - dynamic disk - which must be understood to effectively configure and manage 

hard disks. 

Dynamic disk is a physical disk that doesn't use partitions or logical drives. Instead, it contains only dynamic volumes. 

Regardless of what format you use for the file system, only Win2K computers can access dynamic volumes directly. 

However, computers that aren't running Win2K can access the dynamic volumes remotely when connected to the 

shared folders over the network. 

Dynamic disks can co-exist on a system with basic disks. The only limitation is that you cannot mix Basic and Dynamic 

disks on the same hard drive. 

There are five types of dynamic volumes: simple (uses free space from a single disk), spanned (created from free disk 

space that is linked together from multiple disks), striped (a volume the data of which is interleaved across two or more 

physical disks), mirrored (a fault-tolerant volume the data of which is duplicated on two physical disks, and RAID-5 

volumes (a fault-tolerant volume the data of which is striped across an array of three or more disks). 

With dynamic storage, you can perform disk and volume management without the need to restart Windows. 

Limitations: 

 Dynamic disks are not supported on portable computers. 

 Dynamic disks are not supported on Windows XP Home Edition-based computers. 

 You cannot create mirrored volumes or RAID-5 volumes on Windows XP Home Edition, Windows XP 

Professional, or Windows XP 64-Bit Edition-based computers. 

Thus, the dynamic disk is a new way of looking at hard disk configuration. Dynamic disks offer you more management 
flexibility without the partition limitation of basic disks. Dynamic disks can contain an unlimited number of volumes, but 
they cannot contain partitions or logical drives. Dynamic storage can be particularly beneficial for large-scale businesses 
when dealing with many physical hard disks involving complex setup. 

GPT versus MBR 

GUID Partition Table (GPT) is the next generation of a hard disk partitioning scheme developed to lift restrictions of the 

old MBR. Being a part of the Extensible Firmware Interface (EFI) standard proposed by Intel to replace the outdated PC 

BIOS, it offers a number of crucial benefits: 
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 Up to 128 primary partitions for the Windows implementation (only 4 in MBR); 

 The maximum allowed partition size is 18 exabytes (only 2 terabytes in MBR); 

 More reliable thanks to replication and cyclic redundancy check (CRC) protection of the partition table; 

 A well defined and fully self-identifying partition format (data critical to the platform operation is located in 

partitions, but not in un-partitioned or hidden sectors as this is the case with MBR) 

Apple Boot Camp 

Boot Camp is a special utility to help you set up a dual boot system (Mac OS X and 32-bit Windows XP/Vista) on Intel-

based Macs. It enables to securely re-partition your hard disk (resize an existing HFS+ partition to create a separate 

partition for Windows) and then launch the installation process. With Boot Camp all the necessary drivers will be at your 

disposal. Moreover after Windows has been installed it will serve as a boot manager to choose what operating system 

to start up. 

 

 

It is strongly recommended not to modify the hard disk configuration with Windows Disk 

Manager. Otherwise it may lead to unexpected consequences, right up to BSOD and 

inability to boot in Windows XP/Vista. Please use our program to correctly update both 

MBR and GPT. 

 

64-bit Support 

The bulk of software today is written for a 32-bit processor. It can meet the requirements of almost any end user. 

However that is not the case when dealing with servers processing large amounts of data with complex calculations of 

very large numbers. That is where 64-bit architecture comes into play.  

It can boast improved scalability for business applications that enables to support more customer databases and more 

simultaneous users on each server. Besides a 64-bit kernel can access more system resources, such as memory 

allocation per user. A 64-bit processor can handle over 4 billion times more memory addresses than a 32-bit processor. 

With these resources, even a very large database can be cached in memory.  

Although many business applications run without problems on 32-bit systems, others have grown so complex that they 

use up the 4 GB memory limitation of a 32-bit address space. With this large amount of data, fewer memory resources 

are available to meet memory needs. On a 64-bit server, most queries are able to perform in the buffers available to the 

database. 

Some 32-bit applications make the transition to the 64-bit environment seamlessly others do not. For instance, system-

level utilities and programs that provide direct hardware access are likely to fail. Our program offers a full-fledged 

support of the 64-bit architecture providing fault-tolerant work for such system dependent modules as Hot Processing. 

Copy Operations 

Hard drive duplication nowadays is becoming highly popular among PC users. That is due to some definite advantages it 

can offer. First of all, many people clone hard disks just to back up data for security reasons. The present day copy 

utilities enable to successfully transfer all on-disk information including standard bootstrap code and other system 

service structures, thus maintaining the operating system’s working capability. In case of a system malfunction, the user 

can get the system back on track in minutes. No additional configuration is required, what is very convenient. 

The second possible application is the upgrade of a hard disk to a new one. The capacity of a modern hard drive doubles 

every two years, thus opening up new possibilities for software developers. As a result programs become more 

complicated and require considerable amount of free space. One day the user realizes that there is no more free space 
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left on the hard disk and the only way out is to upgrade. Usually that means that besides purchasing a new hard disk, 

the user is to face a large re-installation procedure spanning several days of tedious work. But all of this can be avoided 

just by copying the contents of the old hard disk to a new one proportionally resizing the partitions. 

And the last but not least is the copying of hard disks for cloning purposes. It may be of great use when setting up 

similar computers. There is no need for a system administrator to install an operating system from scratch on every one 

of them. It is enough just to configure one and then clone it to the others. 

Drive Partitioning 

As you probably know a hard drive is to be split into one or more partitions, since it cannot hold data until it is carved up 

and space is set aside for an operating system. Until recently most PCs used to have just one partition, which filled the 

entire hard disk and contained an OS. The situation has changed however, thanks to new cost-effective high capacity 

hard drives, thus opening up numerous possibilities for PC users, such as editing video, archiving music, backing up CD 

images, etc. Huge increase in space is great, but it poses a number of problems, most important of which are effective 

data organization and speed. 

Large drives are always going to take longer to search than smaller volumes, and an operating system is going to have its 

work cut out both finding and organizing files. It is for this reason that many people decide to invest in multiple hard 

drives, but there is an easy solution – drive partitioning. Partitioning lets you divide a single physical drive into a number 

of logical drives, each of which servers as a container with its own drive letter and volume label, thus enabling the 

operating system to process data more efficiently. Besides partitioning makes it possible to organize data so that it is 

easy to find and manage. You can set aside, for instance, 40 GB of a 160 GB hard drive for the OS, 70 GB for storing 

video and another 50 GB for your favorite music collections to provide transparent data storage. 

It is also worth mentioning to that with a hard drive properly partitioned, such routine operations as files de-

fragmentation or consistency check will not be that annoying and time-consuming any more. 

By detaching the OS from the rest of the data you can tackle one more crucial issue – in case of a system malfunction, 

you can get the system back on track in minutes by recovering it from a backup image located on the other partition of 

the hard drive. 

But that is not all drive partitioning may be used for. If you are willing to play games in Windows while browsing the 

Internet in Linux, 100-percent sure that no virus will attack your PC, drive partitioning is a necessity. In order to run 

several OSs on a single hard drive you are to create a corresponding number of partitions to effectively delineate the 

boundaries of each OS. 

Data Sanitization 

Data security is a two-sided problem. It is to be made clear, that providing confidentiality implies not only information to 

be stored properly, but also be destroyed according to certain rules. The first step to protecting yourself is to know 

exactly which security precautions work and which do not. 

Many people believe the misconception that repartitioning a disk will result in complete destruction of its contents. 

Actually that is not quite so. Repartitioning the drive only alters references to partitions in the Partition Table, leaving all 

file data intact. In fact, there are a number of programs available to successfully recover previously deleted partitions. 

Formatting a drive also does not guarantee data destruction. Formatting procedure implies modification of the Master 

File Table (MFT) that keeps track of where file contents are stored on the disk and verification of each sector for 

consistency. Even a low-level format does not actually erase the file contents for good, since they can still be 

resurrected from their deleted state with minimal effort by using the popular today Magnetic Force Microscopy 

technology. 
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The only way to make sure that all the data has been erased from a hard drive is to overwrite all on-disk sectors with 

random patterns of ones and zeros. Although this sounds complex, there is an easy way to do this. 

The process of deliberately, irreversibly removing or destroying the data stored on a memory device (magnetic disks, 

flash memory drives, etc.) is generally known as Data Sanitization. A device that has been sanitized has no usable 

residual data and even advanced forensic tools should not ever be able to recover it, thus providing maximum level of 

security. 

Data Security Standards 

To irreversibly destroy all on-disk information there have been developed a number of disk sanitizing standards. They 

are distinguished by wiping patterns and number of passes: 

1. US DoD 5220.22-M. US Department of Defense recommends to overwrite all addressable locations with a 

character, its complement and then a random character. Finally, the target data area is to be verified; 

2. US Navy standards NAVSO P-5239-26. 

 NAVSO P-5239-26 for RLL encoded drives. At first to write the fixed value (0xffffffff) to the target data area, 

then the fixed value (0x27ffffff), and then random values. Finally, the target data area is to be verified; 

 NAVSO P-5239-26 for MFM encoded drives. At first to write the fixed value (0xffffffff) to the target data 

area, then the fixed value (0xbfffffff), and then random values. Finally, the target data area is to be verified; 

3. British HMG Infosec Standard No.5. At first to write a single character pattern, then its complement and then a 

random character. Finally, the target data area is to be verified; 

4. German VSItR Standard. Overwrite the deleted information 7 times, consistently filling it with the following 

patterns: 0x00, 0xFF, 0x00, 0xFF, 0x00, 0xFF, 0xAA. Finally, the target data area is to be verified; 

5. Australian ASCI 33. Overwrite with a character (C), then verify. Overwrite with –C (the first pass character’s 

inverse), then verify again. Overwrite everything with both C and –C once again but without verification. Fill 

everything with random characters; 

6. Russian GOST R 50739-95. Destroy information by a single pass with writing random characters into each sector 

byte; 

7. Peter Gutmann's algorithm. A whopping 35 passes, with 27 random-order passes using specific patterns 

combined with eight passes using random patterns; 

8. Bruce Schneier's algorithm. Two passes of specific patterns followed by five passes using a cryptographically 

secure pseudo-random sequence; 

9. Paragon's algorithm. 

 Overwrite each sector with a forcefully randomized 512-byte string, new for each sector, using CSPRNG 

(cryptographically secure pseudo-random number generator); 

 Overwrite each erased sector with its complement; 

 Overwrite each sector with a 512-byte string (CSPRNG), again forcefully randomized and different from the 

first pass, and new for each sector; 

 Fill each erased sector with 0xAA value. Finally, the target data area is to be verified. 



37 

Copyright© 1994-2011 Paragon Software Group. All rights reserved. 

 

Military and government standards always require 100 percent residual data verification. It 

is necessary to make sure that the operation has been properly accomplished. Besides 

corrupted sectors discovered during the operation are to be logged to keep the user 

informed, since these sectors may contain classified information. 

The list of supported military and government standards may vary for your product. 

Anyway you’ve always got the possibility to create a customized algorithm, defining up to 4 

wiping patterns, number of passes for each wiping pattern and for the group of patterns, 

thus providing the maximum possible security level. 

 

Scheduling  

The automation of operations is particularly effective when you have to repeat a sequence of actions on a regular basis. 

For example, developing a specific project on a day-to-day basis and having to make a backup every evening so as not to 

lose the valuable data, you will really appreciate, when this kind of routine operations will be carried out automatically 

without your participation. 

Another aspect of any automation process is that it allows an optimization of your computer’s work-load. This is 

especially important when operations require a considerable amount of computer resources – processor time, memory 

and more. A number of tasks, which can decrease the performance, can be run during the night or whenever the 

computer has the least work-load to perform. 

The program has a special tool for scheduling. You can set out a timetable for any operation and it will start at a 

specified time without interrupting your current activity. 

Windows Components 

In the given section you can find all the information necessary to successfully work with the Windows version of the 

product. 

Interface Overview 

This chapter introduces the graphical interface of the program. The design of the interface precludes any mistake being 

made on the part of the user. Most operations are performed through the system of wizards. Buttons and menus are 

accompanied by easy understandable icons. Nevertheless, any problems that might occur while managing the program 

can be tackled by reading this very chapter. 

General Layout 

When you start the program, the first component that is displayed is called the Launcher. It enables to run wizards and 

dialogs, to specify program settings, to visualize the operating environment and the hard disk configuration. 

The Launcher’s window can be conditionally subdivided into several sections that differ in their purpose and 

functionality: 



38 

Copyright© 1994-2011 Paragon Software Group. All rights reserved. 

 

1. Main Menu  

2. Tool Bar  

3. Virtual Operations Bar  

4. Common Tasks Bar  

5. Explorer Bar  

6. Disk Map  

7. Partition List 

8. Properties Bar 

9. Legend Bar 

10. Status Bar 

A number of panels offer similar functionality with a synchronized layout. The program enables to conceal some of them 

to simplify the interface management. 

All panels are separated by vertical and horizontal expandable sliders, allowing the user to customize the screen layout. 

Main Menu 

The Main Menu provides access to the entire functionality of the program. The available functions are as listed below: 

MENU ITEM FUNCTIONALITY 
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Tools 

View Log Files View logs on the carried out operations 

Send Log Files Compress and send the log to the Paragon Support Team 

Setup Boot Manager… Manage several operating systems on one computer 

Recovery Media Builder… Restore the system even when the current operating system cannot boot 

anymore 

Check Recovery Discs… Verify the recovery media for integrity and ability to boot from 

File Transfer Wizard… Transfer data from any media 

Settings... Edit the general settings of the program  

Exit Exit the program 

Changes 

Generate Script… Generate a script for the task 

Save to Scheduler… Schedule pending operations 

Undo `the last virtual 

operation` 

Cancel the last virtual operation on the List of Pending Operations 

Redo `the last virtual 

operation` 

Cancel the last undo virtual operation on the List of Pending Operations 

View Changes… Display the List of Pending Operations 

Apply Changes Launch the real execution of virtual operations 

Discard All Changes Cancel all virtual operations on the List of Pending Operations 

Reload Disk Info Refresh the current information about disks 

Wizards 

Express Create Partition… Create an NTFS partition and make it ready for work 

Create Partition… Create a partition of any file system 

Format Partition… Format a partition of any file system 

Delete Partition… Delete a partition of any file system 

Total Defrag Launch Total Defrag to optimize NTFS and FAT file systems 

Wipe Hard Disk or 

Partition... 

Destroy all on-disk information or only remnants of deleted files/directories 

Express Resize Partitions… Increase free space on one partition by up-taking the unused space of an 

adjacent partition 
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Undelete Partitions… Recover an accidentally deleted partition 

Merge Partitions… Merge adjacent partitions of NTFS, FAT or FAT32 file systems 

Redistribute Free Space… Redistribute available disk space of existed partitions 

Install New OS… Make your system ready to install a new operating system 

Smart Backup… Back up exactly what you need - the whole system, e-mail databases (MS 

Outlook, Express, Windows Mail) media files or office documents of the My 

Documents folder, or any other files and folders 

Differential Backup… Create a differential to a partition backup 

Create a File Complement… Create an increment to a full partition backup 

Create a File Increment… Create an increment to a file backup 

Restore… Restore an entire hard disk, separate partitions, or files from the backup image 

Manage Backup Capsule… Create and manage the backup capsule 

Check Archive Integrity… Perform integrity check for the required backup image 

Cyclic Backup… Automate a partition backup 

Synthetic Backup… Change any property of an existing archive (splitting, password protection, 

compression level, etc.) without accomplishing the backup operation 

Create Virtual Disk… Create an empty virtual disk or with specific data of one of the supported 

virtualization vendors 

P2V Copy… Migrate a live Windows physical system to a virtual environment 

P2V Restore… Migrate a Windows physical system backed up with a Paragon disaster 

recovery tool to a virtual environment 

P2V Adjust OS… Make Windows Vista/7 backups bootable on virtual hardware; recover the 

startup ability after unsuccessful virtualization with a 3rd party tool 

Migrate OS… Move any Windows OS since XP from a regular hard disk to a fast SSD 

Copy Hard Disk… Create a hard disk copy 

Schedule Hard Disk Copy… Set a timetable for a hard disk copy 

Copy Partition… Create a partition copy 

Schedule Partition Copy… Set a timetable for a partition copy 

Hard Disk 

Back Up Hard Disk… Create a backup archive of the selected hard disk 

Burn Hard Disk to CD or Back up the selected hard disk and burn the resulted image to CD/DVD 
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DVD… 

Restore Hard Disk… Restore the selected hard disk from a backup image 

Convert to Basic… Convert a dynamic MBR disk containing simple volume(s) into a basic MBR disk 

Convert to Basic MBR hard 

disk… 

Convert a basic or a dynamic GPT disk containing simple volume(s) into a basic 

MBR disk 

Convert to GPT hard disk Convert a basic MBR disk into a basic GPT disk 

Update MBR Update MBR (Master Boot Record) of the selected hard disk 

Change Primary Slots… Modify the primary partitions enumeration for the selected hard disk 

Wipe Hard Disk… Irreversibly destroy all on-disk information 

Edit/View Sectors… View/edit sectors of the selected hard disk 

Connect a Virtual Disk Connect a virtual disk to work with it as if it’s a physical disk 

Disconnect a Virtual Disk Disconnect a virtual disk 

Properties… Get in-depth information on the properties of selected hard disk 

Partition 

Create Partition… Create a partition 

Format Partition… Format a partition 

Delete Partition… Delete a partition 

Back Up Partition… Create a backup archive of the selected partition 

Burn Partition to CD or 

DVD… 

Back up the selected partition and burn the resulted image to CD/DVD 

Restore Partition… Restore the selected partition from a backup image 

Move/Resize… Move/Resize the selected partition 

Convert File System… Convert file system of the selected partition 

Assign Drive Letter… Assign drive letter to the selected partition 

Remove Drive Letter… Remove drive letter for the selected partition 

Hide Partition… Make the selected partition unavailable for the operating system 

Unhide Partition… Make the selected partition available for the operating system 

Mark Partition as Active Make the selected partition bootable by default 

Mark Partition as Inactive Make the selected partition non-bootable by default 

Change Volume Label… Change volume label of the selected partition 
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Change Cluster Size… Change cluster size of the selected partition 

Change Serial Number… Change serial number of the selected partition 

Downgrade NTFS version… Decrease version of the selected NTFS partition 

Change Partition ID… Change identifier of the selected partition 

Make Partition Primary… Make the selected partition Primary 

Make Partition Logical… Make the selected partition Logical 

Wipe Partition… Irreversibly destroy all on-partition information 

Clear Free Space… Destroy any remnants of deleted files/directories left on disk 

Test Surface… Test surface of the selected partition/block of free space 

Check File System 

Integrity… 

Check the selected partition for possible file system errors 

Edit/View Sectors… View/edit sectors of the selected partition 

Properties… Get in-depth information on the properties of selected partition 

View 

Layouts Manage the Launcher layout with several predefined profiles 

Toolbar Manage the Tool Bar representation: show / hide standard and navigation 

buttons, text labels and large icons 

Status Bar Display the Status Bar 

Common Tasks Bar Display the Common Tasks Bar 

Disk Map Legend Display the Disk Map legend 

Properties and Commands Display the Explorer Bar 

Disk Map Location Select whether the Disk Map will be located on the top of the main window or 

at the bottom 

Help 

Help Open the Help system (you can also do it by pressing F1) 

About Open the dialog with information about the program 

 

 

The Main Menu contents available at the moment may vary depending on the selected 

object. 
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Tool Bar 

The Toolbar provides fast access to the most frequently used operations: 

BUTTON FUNCTIONALITY 

 

Back up exactly what you need with 

Smart Backup Wizard 

 

Increase free space on one partition 

by up-taking the unused space of an 

adjacent partition 

 

Copy a hard disk 

 

Migrate OS to SSD 

 

Defragment the selected partition 

 

Switch to Express launcher 

 

Open the Help system 

Virtual Operations Bar 

The program supports previewing the resulting layout of hard disks before actually executing operations (so-called 

virtual mode of execution). In fact, when the virtual mode is enabled, the program does not accomplish operations 

immediately, but places them on the List of Pending Operations for later execution. 

The Virtual Operations Bar enables to manage pending operations. 

BUTTON FUNCTIONALITY 

 
Cancel the last virtual operation on the List of Pending Operations 

 
Cancel the last undo virtual operation on the List of Pending 

Operations 

 
Display the List of Pending Operations 

 
Launch the real execution of virtual operations 

 
Cancel all virtual operations on the List of Pending Operations 

 

 

Virtual mode is an effective way of protection from any troubles, since no operations will 

be executed until clicking the Apply button for confirmation, thus giving a second chance to 

weigh all pros and cons of this or that particular operation. The program politely reminds 
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the user that there are unsaved changes by showing the following window: 

 

 

Common Tasks Bar 

The Common Tasks Bar is located on the left side of the main window. It is intended for easy access to the program's 

wizards. 

The bar contains several tabs. Each tab includes a separate button bar which can be folded by clicking it. 

Basic Partitioning Tasks 

 
Starting the Express Create Partition Wizard to create an NTFS partition and make 

it ready for work. 

 
Starting the Create Partition Wizard to create a partition of any file system. 

 
Starting the Format Partition Wizard to format an existing partition to one of the 

file systems supported by the program. 

 
Starting the Delete Partition Wizard to delete a partition of any file system. 

Advanced Partitioning Tasks 

 
Starting Total Defrag to optimize NTFS and FAT file systems. 

 
Starting the Express Resize Partitions Wizard to redistribute free space between 

two adjacent partitions. 

 
Starting the Merge Partitions Wizard to merge adjacent partitions of NTFS, FAT, 

FAT32 file systems. 

 
Starting the Redistribute Free Space Wizard to redistribute available disk space of 

existing partitions. 

 
Starting the Undelete Partitions Wizard to recover accidentally deleted partitions. 

Copying Tasks 

 
Starting the Migrate OS to SSD Wizard to migrate Windows OS to a fast SSD. 

 
Starting the Copy Hard Disk Wizard to copy a hard disk. 
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Starting the Copy Partition Wizard to copy a partition. 

Backup Tasks 

 
Starting the Smart Backup Wizard to back up exactly what you need - the whole 

system, e-mail databases (MS Outlook, Express, Windows Mail) media files or 

office documents of the My Documents folder, or any other files and folders. 

 
Starting the Manage Backup Capsule Wizard to create, resize or delete the backup 

capsule. 

 
Starting the Restore Wizard to restore a hard disk, separate partition, or files from 

the backup image. 

Tools 

 
Starting the File Transfer Wizard to transfer data from any media. Besides it 

provides access to Paragon backups as regular folders to browse through their 

contents or copy required files. 

 
Starting the Boot Manager Setup Wizard to easily manage several operating 

systems on one computer. 

 
Starting the Install New OS Wizard to install a new operating system. 

Help and Documentation 

 
Launching the help system (you can also do it by pressing F1). 

 
Opening the page which contains information about the program. This page will 

be displayed in the Explorer Bar. 

 
Opening a brief review on the Paragon Scripting Language. 

Disk Map 

The Disk Map is displayed in the Explorer Bar when the Disk View tab is selected. It is located either at the top or at the 

bottom of the window, depending on the state of the Disk Map Location option (Main Menu: View > Disk Map 

Location). 

As the name infers, the Disk Map displays the layout of physical and logical disks. Physical disks are represented with 

rectangle bars that contain small-sized bars. These small-sized bars represent logical disks. Their color depends on the 

file system of the appropriate partition. 

 

Large-sized bars display the following information about physical disks: 
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 Manufacturer, 

 Model. 

Small-sized bars display the following information about logical disks: 

 Serial number, 

 Drive letter, 

 Total size, 

 File system. 

Furthermore, it is possible to estimate the used disk space by looking at the size of the bar’s shaded area. The program 

offers to choose from several types of the disk layout scaling. It’s done especially to increase the program usability. For 

instance, if you’ve got a high capacity hard drive containing both very large (more than 100 GB) and rather small (less 

than 10 GB) partitions, you can select the logarithmic type to make all partitions readable, otherwise (selecting the 

linear type) you won’t be able to see small partitions at all, but thing strips. On the other hand, if the proportional disk 

layout is critical for you, the linear type is exactly what you need.  

Nevertheless there’s a compromise solution – linear scaling with the minimal limit to small partitions. So if a partition is 

too small it will remain readable. 

Just click on the arrow icon on the top right side of the Disk Map to select the desired scaling type. 

 

Disk Map is synchronized with the Explorer Bar. Thus by selecting a disk on the Disk Map, the Explorer Bar will 
automatically display detailed information on it. 
 

 

The drag-and-drop functionality is not available when the logarithmic type of the disk 

layout is selected. 

 

Explorer Bar 

The Explorer Bar is located in the center of the main window which emphasizes its importance. The bar displays 

reference information including: 

 The help system 

 General information on the product including its name, version and a list of helpful links 

 Detailed information about disks selected on the Disk Map 

 List of scheduled operations 

 List of archives 

 Volume Explorer utility 

 Disk Editor utility 

According to these categories the Explorer Bar has several tabs: 

 Disk View, which offers the user the following options: 
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- Partition List to get a clear-cut picture of the current state of the system hard disks/partitions 

- Disk Editor to view/edit sectors of the selected partition/hard disk 

- Volume Explorer to browse and export contents of the selected partition/hard disk 

- Properties to view detailed information on the selected partition/hard disk in the bright graphical form 

 

 

You can switch between these components by clicking tabs on the left side of the Explorer 

Bar. 

 

 Scheduled Tasks, which gives the user the possibility of browsing and editing scheduled operations and the 

program scripts. 

 Archives, which enables to manage the Archive Database. 

 Help, which contains the program help and general information on the product. 

You can access the desired information by clicking on the appropriate tab. 

The Explorer Bar is a fully-functional embedded HTML browser, which offers the possibility to address, for example, the 

company's website to look through important technical notes or download the latest updates without having to close 

the program.  

The program help is also HTML-oriented. You can read it and follow external links from to get additional information. 

To easily navigate through browsed pages, the program provides the following functionality: 

BUTTON FUNCTIONALITY 

 
Return to the previously browsed 

page 

 
Open the next browsed page 

 
Stop loading the current page 

 
Refresh the contents of the current 

page 

Partition List 

The Partition List is another helpful tool that enables you to get a clear-cut picture of the current state of the system 

hard disks/partitions. Partitions are sorted according to their starting position. For every item of the list there is the 

possibility to call the context-sensitive popup menu with available operations. Besides, the program provides detailed 

information on all hard disks/partitions found in the system including the following properties: 

   - Name, 

   - Volume label (if exists), 

   - Partition type (Primary/Extended /Logical), 

   - File system type, 

   - Size, 

   - Amount of used and unused (free) space, 
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   - Start/End cylinder, 

   - Start/End head, 

   - Start/End sector 

   - Free size in sectors/bytes 

   - Active/Inactive attribute 

   - Hidden/Unhidden attribute 

You may customize outlook of the Partition List by clicking on the arrow icon on the top right side of the panel. 

 

By marking a checkbox opposite the required item you can choose whether to display it or not. Besides, you can change 

its order by pressing the Move up or Move down buttons. 

If you don’t need the Disk Map, please click the shown below icon to disable it: 

 

Properties Bar 

The Properties Bar provides information on the selected at the moment partition/hard disk: 

For a hard disk 

 Model, 

 Serial number, 

 Type of hard disk (basic or dynamic), 
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 Total size (in GB), 

 Information on geometry of the disk (amount of sectors per track, heads and cylinders). 

For a partition 

 Drive letter assigned to the disk, 

 Volume label (if available), 

 Type of the logical disk, 

 File system (represented by the color of the graph and the selected bar), 

 Total size, used space and free space (in GB or MB). 

Besides you can modify practically any partition property by clicking on the required value. 

Legend Bar 

The Legend Bar explains the color scheme used for disk and partition presentation. You can hide (or show) the bar with 

the appropriate Main Menu item: View > Disk Map Legend. When it is activated it can be found at the bottom of the 

Explorer Bar.  

The program distinguishes between the following types of known file systems: 

   - FAT16/32 

   - NTFS 

   - Linux Ext2/3/4 

   - Linux ReiserFS 

   - Apple HFS 

Status Bar 

This is the bottom part of the main window. The Status Bar displays menu hints, for each item the cursor points to. 

The user can hide (or show) the bar with the appropriate Main Menu item: View > Status Bar. 

Settings Overview 

The Settings dialog is available from the Main Menu: Tools > Settings. All the settings are grouped into several sections, 

which functions are described in the following paragraphs. The list of sections is placed on the left side of the dialog. By 

selecting a section from the list, you can open a set of options. 

 

  

To get a detailed description to any setting, control, or field of the program just click the 

hint button and then the object you need. 
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General Options  

 

This section contains a set of general options that will be taken into account during any operation carried out with the 

program: 

 Partition Alignment mode. There are three options you can choose from: 

- Legacy. DOS and Windows OSes before Vista required that partitions had to be aligned to the “disk cylinder” 

or 63 sectors to address and access sectors correctly. It was OK, until 4K hard drives came into scene. When 

partitions are aligned this way on this type of disk, each logical cluster is linked to two physical 4K clusters, 

thus resulting in a double read-write operation. 

- Vista. Since Windows Vista, operating systems do not use the archaic CHS (cylinder/head/sector) addressing 

scheme, but the Logical Block Addressing (LBA), where sectors are addressed continuously over the whole 

disk drive. It is optimal for both, 512B and new 4K disk drivers. 

- Inheritance. Select the option to disable automatic alignment of partitions. 

 Check FS integrity policy. Accomplishment of any data-sensitive operation (resize, move, merge, redistribute, 

change cluster size, etc.) is potential with data loss. To minimize this risk, it’s recommended to check integrity of 

your file system before this type of operations, despite the fact that it’s quite time consuming. We offer you 

several options to let you choose, which is best for you: 

- Always. Maximum protection, but minimal performance. The file system integrity will be checked each time 

it’s necessary to guarantee the maximum protection for the on-disk data. 

- Once. Standard protection with acceptable performance. The file system integrity will be checked for each 

volume only once just before accomplishing data-sensitive operations. 

- Never. No protection, but maximum performance. If you’re not 100% sure your disk is rock solid, please do 

not use this option. 

 Data Loss Protection mode. To guarantee safety for your information when a data-sensitive operation has been 

abruptly interrupted as a result of a computer reset, or a power outage, there are several techniques, that 

correspond to the options below: 

- Do not protect. No protection, but maximum performance. If you’re not 100% sure you’re completely safe 

from a power outage, or an accidental reset of your computer, please do not use this option.  
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- Reset. Standard protection with acceptable performance. Maintaining a special journal, our program 

enables to automatically complete a data-sensitive operation interrupted by an accidental reset of your 

computer from our bootable recovery media, thus reviving the corrupted partition. 

- Power loss. Maximum protection, but minimal performance. Besides journaling, our program will also 

disable cache of your disk when accomplishing data-sensitive operations to avoid data loss even in case of a 

power outage. 

Backup Image Options  

 

This section contains a set of options that will be taken into account during backup/restore operations: 

 Control archive integrity. Mark the checkbox to guarantee that all backup images created with the program are 

100 percent flawless. If you decided not to control the archive integrity, the backup operation would take about 

3-5% less time. 

 Set image file names automatically. Mark the checkbox to make the program automatically set a file name for 

every volume of a complex backup image. Otherwise you will need to do it manually during the backup 

operation. 

 Compression level. From the pull-down list you can select the desired compression level for backup images that 

will be used by default. 

 Enable image splitting. Mark the checkbox to automatically split every backup image to volumes of a particular 

size. 

 

 

Splitting images enables to tackle problems caused by a maximum file size limitation of 

some file systems. 

 

 Maximum split size. With the spinner control you can specify a maximum size for backup volumes. 
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General Copy and Backup Options  

 

This section contains a set of options that will be taken into account during copy and backup operations: 

 HDD raw processing. Mark the checkbox to copy/back up a hard disk in the sector-by-sector mode, thus 

ignoring its information structure (e.g. unallocated space or unused sectors of existing partitions will be 

processed as well). This can help to avoid problems with hidden data created by certain applications or the 

system administrator. However, it will take more time to accomplish the operation. 

 Partition raw processing. Mark the checkbox to copy a partition in the sector-by-sector mode to successfully 

process unknown file systems. However it is not recommended to enable this option when working with 

supported file systems as it takes more time to accomplish the operation. 

 Skip OS auxiliary files. Mark the checkbox to skip OS auxiliary files (like pagefile.sys, hiberfil.sys, etc.), thus 

reducing the operation time and the resulted size of the backup image. 

 Skip archive files stored in archive library. Mark the checkbox to skip backup images registered in the archive 

database, thus reducing the operation time and the resulted size of the backup image. 

 

 

By clicking the link at the bottom of the window you can jump to the Copy/Backup Exclude 

Options. 
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CD/DVD/BD Recording Options  

 

This section contains a set of options that will be taken into account during CD/DVD/BD burn operations: 

 Burn every CD/DVD/BD to the end. By default, the program does not create ISO 9660 compliant burning 

sessions, as it processes data on-the-fly and can only estimate the resulted session size. That’s why no third 

party tool will get access to the recorded data. To tackle the issue, mark the checkbox to make the program 

create a standard Disk-at-Once session. It may slow down the burning process, as every CD/DVD/BD will be 

recorded up to the end, no matter how much actual information to contain. 

 Recording speed. The user may define how fast a CD/DVD/BD will be recorded (minimum, normal and 

maximum). Besides there is an automatic mode when the program will set the most appropriate speed for 

every CD/DVD/BD. 

 Bootable ISO image. That’s the image to be placed together with the backup data. By default, the program 

offers its own bootable ISO image, which contains a Linux/DOS recovery environment. However, the user is free 

to use any bootable ISO image. 

 CD/DVD/BD boot capability. The program enables to choose whether any recorded CD/DVD/BD will be 

bootable, or only the first one for a session, or without that function at all. 

 Folder where the ISO image is to be placed. When the user decides not to physically burn a CD/DVD/BD, but 

create an ISO image file, this very folder will be used to contain these images. 
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Hot Processing Options  

 

In this section you may configure the hot processing mode: 

 Enable hot processing. Mark the checkbox to enable the so called hot data processing mode that is specially 

designed to process data without restarting your operating system. 

 Hot processing technology. From the pull-down list you can select the required hot processing technology. 

 Always use hot processing. Select the option to process partitions without making them locked. Thus you will 

be able to keep working with them as usual. 

 Use hot processing only when partition is locked. Select the option to use the hot processing only when 

partitions are locked and cannot be processed without restarting the computer. Please keep in mind, that once 

you start any operation on a partition in this mode, it will automatically be locked by the program, thus you 

won't be able to keep working with it as usual. 

 Hot processing temporary drive. Here you can select a disk drive that will be used to store the temporary hot 

backup data (by default – C:). 

 Attempts to start VSS. Here you can set how many attempts to start Microsoft VSS the program is to do before 

automatically rebooting the system and accomplishing the operation in a special boot-up mode. 

 Timeout between attempts (in seconds). Here you can set a time period between different attempts to start 

Microsoft VSS. 

 Switch between hot processing technologies. Mark the checkbox to automatically switch between Paragon Hot 

Processing and Microsoft VSS if one of them is unavailable at the moment. 

 

 

By clicking the link at the bottom of the window you can jump to the Run during Backup 

Options. 
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Run during Backup Options 

 

In this section you can specify external applications to execute at various phases of the backup process. It can be 

particularly useful when imaging systems with high availability requirements (MS SQL, MS Exchange, etc.), since it 

enables to create a consistent snapshot even as the data is currently modified. The point is to provide a coherent state 

of all open files and databases involved in a backup, taking into account that applications may still keep writing to disks. 

Actually the backup process consists of two phases: the preparation phase (snapshot) and the data-copying phase. 

There are three points of the backup when external commands/programs can be launched: 

 Execute at the beginning of the backup process before taking a snapshot. Here you can specify an executable 

file that will help you to prepare running applications for taking a snapshot. It may contain specific 

commands/programs to delete unnecessary files, suspend services, flush transactions or caches, etc. Everything 

depends on the used applications. 

 Execute after taking a snapshot. Here you can specify an executable file that will run just after taking a 

snapshot. It may contain specific commands/programs, e.g. to resume the previously suspended services, etc. 

Everything depends on the used applications. 

 Execute after finishing the backup process. Here you can specify an executable file that will run after the 

backup process has been accomplished. It may include commands/ programs that will move the backup image 

to a particular location, etc. 

 

 

By clicking the link at the bottom of the window you can jump to the Hot Processing 

Options. 

 

By clicking the Browse button you can get into the browser-like window to choose an executable file. 
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The program provides the ability to work with three types of executable files (.exe, .bat, .cmd). It is up to the user to 

write batch files to safely prepare applications for backup. There are some certain general requirements for that: 

 All programs and commands must execute sequentially and finish before the .bat file completes its work. 

 It is recommended to use external commands/programs in the following format - Start/wait program.exe. The 

wait option will help to start an application and wait until it completes its work. This will guarantee that all 

included commands/programs complete their execution before the batch file does. 

 

 

This function is only available when the Hot Processing mode is enabled. 

The program enables to set parameters for an executable file directly from the line. 

However, if the file path contains word gaps it is necessary to enclose it in quotes in order 

to make the program distinguish between the path and the used parameters. 

By clicking the link at the bottom of the window you can jump to the Hot Processing 

Options. 

 

Wipe Options 

 

Here you can set a specific data erasure algorithm that will be used by default during wipe operations. 
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The list of supported military and government standards may vary for your product. 

 

Wipe Report Options 

 

In this section you can specify contents and properties of generated wipe reports: 

 System information. Mark the option to include a computer name, BIOS version and the used operating system. 

 Hardware Information. Mark the option to include information on the used processor, disk drivers, network and 

USB adapters, etc.  

 Bad blocks information. Mark the option to include information on the found bad blocks. 

 Supervisor Approval. Mark the option to add a signature field for an executive or supervisor responsible for 

data sanitization procedures in your company. 

 Font size… Select the most suitable font size from the list (12 pts by default). 

Partitioning Options 

 

This section contains a set of options that will be taken into account during partitioning operations: 

 Enable 64 KB cluster size for FAT16. Mark the checkbox to enable 64KB clusters for FAT16 partitions. Thus you 

will be able to create FAT16 partitions up to 4GB in size 
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Due to the maximum cluster size of 32KB for Windows 95/98/ME or MS DOS, FAT16 

partitions larger than 2GB are not reliably accessible under these operating systems. 

 

 Request confirmation before partition deletion. Mark the checkbox to activate an additional security 

mechanism. Thus when going to delete a partition you will be automatically requested to enter its label. 

 Request confirmation when converting FAT16 to FAT32. Mark the checkbox to automatically request 

confirmation before converting FAT16 to FAT32. There are a number of situations when this kind of conversion 

is the only way out to accomplish the operation. For instance, you are going to migrate your system to a larger 

hard disk with the proportional resize of existing partitions, what is very convenient. As a result you can get 

original FAT16 partitions go beyond the 4GB limit. Thus without conversion to FAT32, this operation will in no 

way be possible to accomplish. The same goes for any copy hard disk/partition or restore hard disk/partition 

operation involving an extra upsizing. 

E-Mail Options 

 

This section contains a set of options that will be taken into account during the Send log files and Send e-mail 

notification operations: 

 Outgoing mail server (SMTP). To send messages by using the built-in mail client, it is necessary to have access to 

a computer running an SMTP (Simple Mail Transfer Protocol) server. All outgoing messages are first sent to the 

SMTP server, which in its turn delivers them to the required recipients. The address may be represented as a 

traditional Internet host name (e.g.: mail.com) or as an IP numeric address (e.g. xxx.xxx.xxx.xx). 

 User e-mail address. Specify an e-mail address that has been assigned by the Internet Service Provider or 

organization's e-mail administrator. 

 My outgoing server requires authentication. Activate the option to allow the program to make authentication 

on the server before sending messages. 

- User name. Enter the name that will be used to log in to the e-mail account. 

- Password. Enter the password that will be used to access the mail server. 

 Send e-mail notification on apply. Specify an e-mail to send notifications on the carried out operations.  
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- Send mail in HTML format. Activate the option to create messages in the HTML format instead of plain text. 

- Send complete report after applying operations. Activate the option to create an in-depth report on the 

carried out operations and send it after performing the last operation. 

- Send graphical view of the disk sub-system before and after apply. Activate the option to allow the program 

to attach two pictures of the disk layout made before and after the operation is completed. 

 

 

By clicking the link at the bottom of the window you can jump to the Operation 

Dependency Options. 

 

Operation Dependency Options 

 

This section contains a set of options that will be taken into account when the Send e-mail notification on apply function 

is enabled. By marking/unmarking a checkbox opposite the required operation you can choose whether to receive an e-

mail notification on its completion or not. 

 

 
You won't be notified if an operation requires the system restart. 

 

Virtual Mode Options 

 

In this section you may configure the virtual mode: 
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 Allow virtual mode. Mark the checkbox to enable the virtual mode. It is an effective way of protection from any 

troubles, since no operation will be executed until confirmation, thus giving you a second chance to weigh all 

pros and cons of this or that particular operation. 

 

 
We strongly recommend you to enable this mode. 

 

 Close progress dialog automatically. Mark the checkbox to automatically close the progress dialog after 

accomplishing operations. 

File System Conversion Options 

 

This section contains a set of options that will be taken into account when converting FAT and NTFS file systems. By 

default, the program takes locale (regional) settings from the system. Problems might occur however because of 

different standards for file names and file time stamps (Created, Modified and Last Access Time) of NTFS and FATxx file 

systems. 

To tackle problems of that kind you can manually set: 

 Time zone to use during the convert operation. NTFS keeps file timestamps in GMT (Greenwich Mean Time) 

while FAT uses a fixed local date and time. The program takes proper account of these differences and enables 

to adjust timestamp values. 

 

 
An incorrectly chosen time zone might lead to inability to launch certain software. 

 

 Language for file names to use during the convert operation. NTFS stores file names in Unicode while 

FAT/FAT32 uses ANSI to save short file names (also called the DOS aliases). The codepage information is 

required for the correct conversion of non-English file names from Unicode to ANSI and vice versa. 

 

 

An incorrectly chosen codepage will certainly result in corruption of non-English file 

names. 

 

 Request confirmation of settings before NTFS < - > FAT/FAT32 conversion. Mark the checkbox to automatically 

display the local settings dialog to check and modify (if necessary) the default parameters before launching the 

convert file system operation. 
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Copy/Backup Exclude Options 

 

In this section the program enables to specify what data should be automatically ignored during copy and sector-based 

backup operations. You can filter certain files or folders either by the manual selection or by creating masks, what is 

more preferable. Thus you will be able to effectively manage contents of your backup images or partition/hard disk 

copies. 

By default, there are no available filters. To create a filter, please click the Add Category… button. 

 

In the opened dialog the program allows the user to define the following parameters: 

 Name. Give to the filter any name you like, but try to use an informative one; 

 Filter. Press the Browse button to select files or folders you would like to be excluded or specify a filter mask by 

using * or ? wildcards; 

 Description. Add a short description to the filter not to miss it up later. 

Click the OK button and you will get a new item on the list of filters. By marking/unmarking a checkbox opposite its 

name you can choose whether to use it or not. 

 

 

By clicking the link at the bottom of the window you can jump to the General Copy and 

Backup Options. 
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File Backup Exclude Options 

 

In this section you can find a lot of ready-made exclude filters to effectively control contents of your file-based backup 

images. Please note, by selecting certain filters you specify what data will be ignored during file-based backup 

operations, thus you specify the data you’d like not to be added to the resulted archives. 

Anyway you’ve got the option to create your own filter by clicking the Add category… button. 

 

In the opened dialog the program allows the user to define the following parameters: 

 Name. Give to the filter any name you like, but try to use an informative one; 

 Filter. Press the Browse button to select files or folders you would like to be excluded or specify a filter mask by 

using * or ? wildcards; 

 Description. Add a short description to the filter not to miss it up later. 

Click the OK button and you will get a new item on the list of filters. By marking/unmarking a checkbox opposite its 

name you can choose whether to use it or not. 
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File Backup Include Options 

 

In this section you can find a lot of ready-made include filters to effectively control contents of your file-based backup 

images. Please note, by selecting certain filters you specify what data will be processed during file-based backup 

operations, thus you automatically ignore files that do not match, so they won’t be added to the resulted archives. 

Anyway you’ve got the option to create your own filter by clicking the Add category… button. 

 

In the opened dialog the program allows the user to define the following parameters: 

 Name. Give to the filter any name you like, but try to use an informative one; 

 Filter. Press the Browse button to select files or folders you would like to be excluded or specify a filter mask by 

using * or ? wildcards; 

 Description. Add a short description to the filter not to miss it up later. 

Click the OK button and you will get a new item on the list of filters. By marking/unmarking a checkbox opposite its 

name you can choose whether to use it or not. 
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Log Files Options 

 

In this section you can specify a storage life span for the stubact.log file: 

 Infinite not to empty the file ever; 

 Minimal to have the file emptied all the time; 

 Custom to set a certain storage life span for the file. Please note, once the defined period has been expired, the 

file will be emptied. 

 

 

We strongly recommend you not to choose the Minimal option, as in case of having 

problems with the program, our Support Team won’t be able to study operation logs, thus 

help you out. 

 

Viewing Disk Properties  

The main tool to view in-depth information on the properties of hard disks is the Disk Map. It represents the actual state 

of the computer’s hard disks. 

Generally the hard disks are represented on the map by rectangular bars, which also contain small-sized bars. The small-

sized bars represent logical disks (partitions). When you select a large-sized bar, the Explorer Bar displays information 

about the disk in a bright, graphical form. 
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The model and serial number of the disk serve as the title of the browsed page. The disk layout is shown in form of a 

circular graph, where the color of a sector corresponds to a file system of an appropriate partition. On the right you may 

see a table, which contains the following information: 

 Type of hard disk (basic or dynamic), 

 Total size (in GB), 

 Information on geometry of the disk (amount of sectors per track, heads and cylinders). 

Below there is a list of available wizards. If you click a corresponding record the appropriate wizard will be started. All 

default values for the operation parameters will correspond to the disk’s settings. The list of wizards contains a detailed 

description of tasks that can be performed by the wizard. This nullifies the possibility of selecting the wrong wizard. 

 

When you select a small-sized bar (i.e. corresponding to a logical disk) the Explorer Bar will display information on it as 

well. The page title will contain a drive letter, which is assigned to the disk. The disk layout graph will be colored in 

accordance with the volume ratio of the used space to the free space (the light colored sector). The table on the right 

will contain the following information: 

 Volume label (if available), 

 Type of the logical disk, 

 File system (represented by the color of the graph and the selected bar), 

 Total size, used space and free space (in GB or MB). 

Below there is a list of wizards, which may be called for this disk. All default values of parameters will correspond to the 

disk settings. 

Viewing Image Properties 

General information on backup archives can be obtained either with the following tools: 

Using the Restore Wizard  

 In the Main menu: select Wizards > Restore… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 
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At first, the wizard displays the Welcome page – simply click the Next button at the foot of the dialog window. 

The next page refers to Browse for Archive. By clicking the Switch to Archive List View link, you can see a list of images 

contained in the Archive Database (if any). 

 

To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. Archive File 

Details) display a short description, including: 

 Information on a type of the archive contents (whether it is sector-based or file-based), 

 Whether the archive is compressed or not, 

 Whether the archive is password protected or not, 

 The date, when the archive was created. 

In addition, there are some special graphical flags to indicate crucial properties: 

FLAG FUNCTIONALITY 

 Disk archive 

 Partition archive 

 File archive 

 MBR archive 

 System archive 

 Encrypted archive 
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 Compressed archive 

 Complex archive 

 Filtered archive 

 Differential archive 

 Incremental archive 

 File increment to a partition 

archive 

To easily manage images in the Archive Database, the program provides the following functionality: 

BUTTON FUNCTIONALITY 

 Refresh the contents of the database 

 Show only existing archives 

 Add the selected archive to the database 

 Delete the selected archive from the 

database 

Besides you may filter backup archives to decide whether to show only file, partition or hard disk archives. To do that, 

please select the required filter in the left top corner of the page. 

 

By clicking the Switch to File View link, you can find the required image in the browser-like window. 
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The section below (i.e. Archive File Details) displays a short description of the selected image, including: 

 Information on a type of the archive contents (whether it is sector-based or file-based), 

 Whether the archive is compressed or not, 

 Whether the archive is password protected or not, 

 The date, when the archive was created. 

Moreover, on this page you’ve got the possibility to create new folders, delete existing files/folders or map network 

drives by clicking the appropriate buttons. 

The next page (i.e. What to restore) displays detailed information about the contents of the archive. 
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If you want to restore the image contents, click the Next button. In order to cancel, click the Cancel button. 

Using the Archive Database 

To open the Archive Database, click the appropriate tab in the Explorer Bar. The database window can be conditionally 

subdivided into several sections that differ in their purpose and functionality: 
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1. Explorer Bar that displays properties of the selected image. 

2. Volume Explorer that enables to access the selected image as a regular folder to 

explorer its contents or to retrieve certain files. 

3. Archive List that displays a list of images contained in the Archive Database (if any). 

Besides the program provides all the necessary functionality to manage backup images in 

the database (add, delete, mount, refresh, etc.) 

 

 

All panels offer a synchronized layout and are separated by vertical and horizontal 

expandable sliders, allowing the user to customize the screen layout. 

 

Data Backup and Rescue 

In this chapter you will find all the information necessary to establish a reliable data protection system. 

Creating Backup Images 

Depending on a type of information you need to protect and the way this information should be processed, the program 

offers a number of handy backup wizards. To make your job with the program as easy and convenient as possible, all 

backup wizards share similar work algorithm. By going through steps of the wizard, you configure all the necessary 

settings to launch the backup operation. To minimize the possibility of making any mistake, the wizard provides auxiliary 

information on every single option. Moreover you can get an in-depth description to any setting, control, or field of the 

wizard just by clicking the hint button and then the object you need. 
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Smart Backup Wizard Startup 

 In the Main Menu: select Wizards > Smart Backup 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Smart Backup Wizard Setup 

The wizard offers the following steps to accomplish the backup operation: 

 The object to back up. Click on a section you find answering to your task. 

 

- Disk or Partitions to create a sector-based backup of the whole disk system, or only separate partitions; 

- E-mail to create a file-based backup of e-mail databases, accounts and address books of MS Outlook, MS 

Express, and Windows Mail; 

- Media Files to create a file-based backup of all media files (photo, video, music, etc) stored in the My 

Documents folder; 

- Documents to create a file-based backup of all office documents stored in the My Documents folder; 

- Other Files and Folders to create a file-based backup of any files and folders. 

 

 

If selecting Disk or Partitions or Other Files and Folders you will need to specify more 

exactly the object of operation. To know more on the subject, please consult the Backup 

Scenarios chapter. 

 

 Name and location of the resulted image. Provide a file name for the new image and its exact location. The 

program automatically offers an easy to understand name containing the date and the time of the archive 

creation, which can anyway be modified. 
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The program automatically calculates size of the future archive and informs the user about 

space available on the selected destination. 

 

 Archive Comment. You can add some additional description to the archive that will later help to distinguish it 

from the others. 

 

Result 

After the backup operation is completed you receive an image of the selected object. This image is placed into the 

specified destination, its features defined by the wizard. 

 

Available operation scenarios: 

 Backing up a hard disk or partition to the Backup Capsule 

 Backing up a hard disk or partition to external media (CD/DVD) 

 Backing up a hard disk or partition to a network drive 

 Backing up files to an FTP/SFTP server 

 Backing up a dual boot Mac to an external USB drive 

 Backing up files to a local mounted/unmounted (without drive letter assigned) partition 

 Creating a differential to a full partition backup 

 Creating an increment to a full partition backup 

 Creating an increment to a full file backup 

 Creating a cyclic partition backup 

 Merging a full partition backup with one of its differentials 
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Restoring System and Data 

The program includes a convenient and reliable restore wizard. With its help you can restore all types of backup images 

created with the program. It provides easy to understand instructions to configure and perform all the necessary 

settings. Moreover you can get an in-depth description to any setting, control, or field of the wizard just by clicking the 

hint button and then the object you need. 

Startup 

 In the Main Menu: select Wizards > Restore… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Setup 

The wizard offers the following steps to accomplish the restore operation: 

 A backup image to be restored. The Browse for Archive page enables to find a backup image you need. 

By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive Database (if 

any). 

 

To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. 

Archive File Details) display a short description. 

 

 
To know more on the subject, please consult the Viewing Image Properties chapter. 

 

By clicking the Switch to File View link, you can find the required image in the browser-like window. The section 

below (i.e. Archive File Details) will also display a short description of the selected image. 



74 

Copyright© 1994-2011 Paragon Software Group. All rights reserved. 

 

Moreover, on this page you’ve got the possibility to create new folders, delete existing files/folders or map 

network drives by clicking the appropriate buttons. 

 

 
To know more on the subject, please consult the Viewing Image Properties chapter. 

 

File Backup Restore 

 Data to restore. You’ve got the option to restore not only the entire archive, but separate items of it (the so 

called selective restore functionality) by marking checkboxes next to the data items you need. 

 

 A place to restore. From the pull-down list you can choose whether to restore contents of the backup image to 

its original location or specify some other one. 
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Besides if you select the Original location option, you can additionally define whether to replace already existing 

files during the restore operation (good for recovering presumably corrupted files) or leave them intact (good 

for recovering accidentally deleted files). 

Sector Backup Restore 

 Data to restore. You’ve got the option to restore not only the entire archive, but separate items of it (the so 

called selective restore functionality) by marking checkboxes next to the data items you need. 

 

 

 

If you select separate files or folders to restore, the wizard will continue working as though 

you’ve got to do with a file backup. 

 

 A place to restore. Selecting the destination, please note - all contents on the disk selected for restoring 

purposes will be deleted during the operation. 

 

To help you get a clear-cut picture of the operation outcome, the program allows inspecting the resulted disk 

layout. 

Restoring Partition: 

 Size of the restored volume and free space before and after it on the disk. 

 

 Drive letter assignment after restore. The pull-down list contains vacant drive letters that can be associated 

with the restored partition. 
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Restoring Hard Disk: 

 Copy data and resize partitions proportionally. If this option is activated, the program proportionally changes 

the size of partitions keeping their relative order intact. The option can be useful when restoring to a larger hard 

disk. 

 Perform surface test. Define whether the surface test will be accomplished during the operation or not. 

 

 

 

All contents on the disk selected for restoring purposes will be deleted during the 

operation. 

 

Result 

The wizard will restore the archived data, and make it available to use in the operating system. 

 

 

To make Windows bootable on different hardware, please additionally complete the P2P 

Adjust OS Wizard. 

 

Available operation scenarios: 

 Restoring a hard disk from the bootable Backup Capsule 

 Restoring a system partition from external media (CD/DVD) 

 Restoring a system partition from a network drive 

 Restoring a system partition from a local drive 

 Restoring a dual boot Mac from an external USB drive 

 Restoring a file increment 

 Restoring a file increment to a partition backup 

 Restoring separate files and folders from a backup 

Copy Tasks 

In this chapter you will find all the information necessary to make a copy of a hard disk or a separate partition. 
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Cloning Hard Disks 

You can clone a hard disk of any file system. During the hard disk copying process, the program moves controlling 

records of used partitioning scheme, the bootstrap code and on-disk partitions. That’s why this operation cannot be 

substituted by simply copying all on-disk partitions. 

Copy Hard Disk Wizard 

The Copy Hard Disk Wizard is a traditional-like wizard. By going through its steps, you configure all the necessary 

settings to launch the copy operation. To minimize the possibility of making any mistake, the wizard provides auxiliary 

information on every single option. Moreover you can get an in-depth description to any setting, control, or field of the 

wizard just by clicking the hint button and then the object you need. 

 

 
You need at least two hard disks to carry out this operation. 

 

Startup 

 In the Main Menu: select Wizards > Copy Hard Disk… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Setup 

The wizard offers the following steps to accomplish the copy hard disk operation: 

 The hard disk to copy. Select a hard disk you want to copy. 

 

 The target hard disk. Select a hard disk (if several) where all data of the source disk will be copied to. 

 

 Copy parameters. The wizard enables to specify the following options: 
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Copy options 

- HDD raw copy to copy the hard disk in the sector-by-sector mode, thus ignoring its information structure (e.g. 

unallocated space or unused sectors of existing partitions will be processed as well). This can help to avoid 

problems with hidden data created by certain applications or the system administrator. However, it will take 

more time to accomplish the operation. 

- Partition raw copy to copy the on-disk partitions in the sector-by-sector mode to successfully process 

unknown file systems. However it is not recommended to enable this option when working with supported file 

systems as it takes more time to accomplish the operation. 

- Change masks for files to exclude from copy to manage contents of the resulted duplicate. By default the 

program will take into account exclude filters set in the Settings dialog. If you need to change them, please mark 

the checkbox and specify additional filters on the next page of the wizard. 

Resize options 

- Remove free blocks between partitions not to keep blocks of free space between partitions on the targeted 

hard disk. 

- Copy data and resize partitions proportionally to make the program proportionally change the size of 

partitions keeping their relative order intact. The option can be useful when upgrading the hard disk to a larger 

one. 

Verification options 

This section allows you to define whether the Surface and/or the Writing verification tests will be accomplished 

during the operation. 

Result 

After the operation is completed, you receive a fully functional duplicate of the existing hard disk. 

 

 

To make Windows bootable on different hardware, please additionally complete the P2P 

Adjust OS Wizard. 

 

Available operation scenarios: 

 Migrating system to a new HDD (up to 2.2TB in size) 
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Cloning Partitions 

You can duplicate partitions to protect oneself from downtime in case of a system malfunction or for cloning sample 

partitions. The program enables to duplicate all partition data including files, the exact structure of directories and file 

system metadata (location of files, security information, access quotas, etc.). 

The Copy Partition Wizard will help you copy a partition of any file system. To minimize the possibility of making any 

mistake, the wizard provides auxiliary information on every single option. Moreover you can get an in-depth description 

to any setting, control, or field of the wizard just by clicking the hint button and then the object you need. 

Startup 

 In the Main Menu: select Wizards > Copy Partition… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Setup 

The wizard offers the following steps to accomplish the copy partition operation: 

 The partition to copy. Select a partition you want to copy. 

 

 Destination disk. Select a hard disk with enough unallocated space to perform the operation. 

 

 

 

The program enables to copy a partition to a block of free space, which is smaller than the 

partition itself, taking into account only actual amount of data. 

 

 Copy parameters. The wizard enables to specify the following options: 
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- Partition size. Define the size (in Mb) of the copied partition. 

- Free space before. Define the position (in Mb) of the copied partition relative to the beginning of the available 

range of disk space. 

- Free space after. Define the amount of trailing free space (in Mb) at the end of the available range of disk 

space. 

 

 

Partition size and position may also be defined by using the drag-and-drop technique. To do 

that, just carry out the required operation on the Disk Map. 

 

Result 

After the operation is completed you receive a fully functional duplicate of the existing partition. 

 

 

To make Windows bootable on different hardware, please additionally complete the P2P 

Adjust OS Wizard. 

 

Boot Management 

Our program enables to easily manage several operating systems on one computer with the help of the Boot Manager 

Setup Wizard. Among the key features of the wizard the following should be mentioned: 

 Up to 16 operating systems on one PC; 

 Secure adding/removing of the Boot Manager startup record to/from the MBR; 

 Auto Boot option to automatically start up the previously chosen OS after a certain time period; 

 Hiding of any primary partition except selected at the moment. 

Startup 

 In the Main menu: select Tools > Setup Boot Manager… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 
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Setup 

The wizard offers the following steps to accomplish the operation: 

 Boot menu options. In this section you can switch between the following modes: 

- Normal mode. Choose this mode to display the boot menu every time the computer starts up and define a 

timeout on the expiry of which the program will automatically select the previously chosen item of the menu. 

- Hidden mode. Choose this mode not to display the boot menu until pressing a hot key. For this mode you 

should define a hot key used to enable the Boot Manager and a time period in seconds the startup message will 

be displayed. 

 

 Deactivating/Configuring the Boot Manager. These two options will only be available once the wizard has been 

completed and launched again. Select the Deactivate option to remove the Boot Manager from the MBR 

(Master Boot Record) or Configure to modify the previously set parameters of the startup process. 

 

Result 

After the Boot Manager Setup Wizard is completed the program updates the original record in the MBR to get control of 

the booting process and to be able to display the boot menu. 

Available operation scenarios: 

 Creating Dual Boot Systems 

Partition Management 

In this chapter you will find all the information necessary to carry out partitioning operations supported by the program. 

Basic Partitioning Operations 

Here you can learn how to accomplish basic partitioning operations (create, format, delete). 

Creating Partitions 

The program provides the ability to create a new partition within a block of un-partitioned space. 

Restrictions 

1. Do not use the Create Partition function in order to undelete the last deleted partition. 

2. The program allows creating new partitions only within blocks of un-partitioned space. It cannot convert a free 

space on an existing partition to a new partition. 
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3. The program cannot create new partitions on Dynamic Disks. 

Express Create Partition Wizard Startup 

 In the Main menu: select Wizards > Express Create Partition… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Create Partition Wizard Startup 

 In the Main menu: select Wizards > Create Partition… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Dialog Startup 

1. Select a block of free space on the Disk Map; 

2. Select in the Main Menu: Partition > Create Partition. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Express Create Partition Wizard Setup 

Thanks to a highly intelligent work algorithm, the wizard requires minimal involvement in the operation, thus you only 

need to choose a method you find the most suitable to create the partition (if several available), which actually differ in 

the amount of space to allocate. For easy perception, you can see the resulted disk layout on the disk map by selecting 

this or that mode. 

 

 

  

The number of available methods depends on your disk layout. 

To learn more on the way the wizard works, please click the corresponding link on the first 
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page of the wizard. 

 

Create Partition Wizard Setup 

The wizard offers the following steps to accomplish the operation: 

 Partition destination. Select a hard disk (if the computer has several hard disks) and then choose position for 

the future partition on the disk: at the end (preferable), at the beginning or somewhere in the middle between 

other partitions. 

 

 

  

By default, the program allows you to create a new partition only as the last primary or as 

the last logical drive within the extended partition. However, by activating the advance 

mode on the first page of the wizard you can remove this restriction that in its turn might 

result in some boot problems. 

 

 Partition size. There is no restriction on size of the future partition, merely depending on space available on the 

hard disk. 

If there is not enough free space in one block, the wizard enables to redistribute free space, joining all free 

space blocks together into one united block and moving partitions when necessary. If the total amount of free 

space is still not enough, it is possible to split a fragment of space from one of the existing partitions, thus 

resizing it. 
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If a partition to resize is locked and cannot be processed, the wizard makes the system 

reboot to create the partition and then automatically boots the system again. (The 

rebooting mechanism is different for different versions of Windows.) 

 

You can also choose whether the future partition will be primary or logical by marking the appropriate 

checkbox. 

 Partition properties. On the next page of the wizard you can set a number of additional parameters: 

 

- Partition type. From the pull-down list select a file system the newly created partition will be formatted to, 

otherwise the partition will remain unformatted (so that it will not be ready to use). 

- Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually 

used for drive identification. 

- Surface test level. Define the level of the surface check to make the program find bad and unstable sectors and 

mark them unusable in the file system metadata. 

Dialog Setup 

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Yes 

button to confirm the operation. 
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 Define whether the partition will be Primary, Extended or Logical. You can choose the desired partition type 

from the pull-down list. As a matter of fact, the available alternatives fundamentally depend on the selected 

block of free space - within the Logical free space, only Logical partitions can be created; Within the Primary free 

space, both Primary partitions or the Extended Partition can be created. 

 Partition Size. Define the size (in Mb) of the new partition. 

 Free space before. Define the position (in Mb) of the new partition relative to the beginning of the block of free 

space. 

 Free space after. Define the amount of trailing free space (in Mb) at the end of the new partition. 

 

  

Partition size and position may also be defined by using the drag-and-drop technique. To do 

that, just carry out the required operation on the Disk Map. The virtual operations are to be 

available. 

 

 File system for new partition. From the pull-down list select a file system the newly created partition will be 

formatted to, otherwise the partition will remain unformatted (so that it will not be ready to use). 

 Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually 

used for drive identification. 

 Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with the newly 

formatted partition. 

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). 

To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on 

the chosen file system, the following options become available: 
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 Use OS built-in routine. Mark the option to restrict the available values according to the used OS. 

 Whether the surface test will be performed. Define the level of the surface check to make the program find bad 

and unstable sectors and mark them unusable in the file system metadata. 

 The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. Set 

the number of sectors to be reserved for the boot area on the partition with this spinner control. 

 The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum 

amount of files/directories to be placed in the Root Directory on the FAT16 partition. 

 The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control. 

 

  
Number of available options depends on the selected file system type. 

 

Result 

After the operation is completed you receive a fully functional partition. 

Available operation scenarios: 

 Creating a new partition to detach operating system from the rest of data 

Formatting Partitions  

Any partition should contain some file system to be used for keeping data. The process of installing a file system is 

commonly known as formatting. A huge variety of file systems have been developed these days. 

Supported File Systems 

The program provides the ability to format partitions of the following file systems: 

   - FAT12 & FAT16 

   - FAT32 

   - HFS+ 

   - NTFS 

   - Ext2 

   - Ext3 

   - Ext4 

   - Linux Swap v. 2 
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Wizard Startup 

 In the Main menu: select Wizards > Format Partition… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Dialog Startup 

1. Select a partition on the Disk Map; 

2. Select in the Main Menu: Partition > Format Partition. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Wizard Setup 

The wizard offers the following steps to accomplish the operation: 

 Partition to format. Select a hard disk (if the computer has several hard disks) and then the required partition to 

format. 

 

 

  
As a result of this operation contents of the selected partition will be lost. 

 

 Partition properties. On the next page of the wizard you can set the following partition parameters: 
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- Partition type. From the pull-down list select the desired file system type. In fact, the program displays only 

those file systems that can correctly be placed to the selected partition, taking its capacity into account. 

- Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually 

used for drive identification. 

- Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with the newly 

formatted partition. 

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). 

To activate the advance mode, you need to mark the appropriate option at the foot of the page. When it is marked, the 

next page enables to define: 

 

 Use OS built-in routine. Mark the checkbox to restrict the available values according to the used OS. 

 Whether the surface test will be performed. Define the level of the surface check to make the program find bad 

and unstable sectors and mark them unusable in the file system metadata. 

 The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. Set 

the number of sectors to be reserved for the boot area on the partition with this spinner control. 

 The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum 

amount of files/directories to be placed in the Root Directory on the FAT16 partition. 

 The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control. 

 

  
Number of available options depends on the selected file system type. 

 

Dialog Setup 

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Format 

button to confirm the operation. 
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 File system. From the pull-down list select the desired file system type. In fact, the program displays only those 

file systems that can correctly be placed to the selected partition, taking its capacity into account. 

 Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually 

used for drive identification. 

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). 

To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on 

the chosen file system, the following options become available: 

 

 Use OS built-in routine. Mark the checkbox to restrict the available values according to the used OS. 

 Whether the surface test will be performed. Define the level of the surface check to make the program find bad 

and unstable sectors and mark them unusable in the file system metadata. 

 The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. Set 

the number of sectors to be reserved for the boot area on the partition with this spinner control. 

 The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum 

amount of files/directories to be placed in the Root Directory on the FAT16 partition. 

 The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control. 

 

  
Number of available options depends on the selected file system type. 

 

Result 

After the operation is completed you receive a fully functional partition formatted to the specified file system. 

Deleting Partitions 

Wizard Startup 

 In the Main menu: select Wizards > Delete Partition… 
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There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Dialog Startup 

In order to start the operation you should take the following steps: 

Launcher 

1. Select a partition on the Disk Map; 

2. Select in the Main Menu: Partition > Delete Partition. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Wizard Setup 

The wizard offers the following steps to accomplish the operation: 

 Partition to delete. Select a hard disk (if the computer has several hard disks) and then the required partition to 

delete. 

 

 

  
As a result of this operation contents of the selected partition will be lost. 

 

 Merge free blocks. As a result of the operation you may get several blocks of the unallocated space on the hard 

disk. So choose whether to merge them all and place at the beginning of the disk or at the end by selecting the 

required operation from the pull-down list. 
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Dialog Setup 

Initially the program suggests you just to remove references to the selected partition from the Partition Table.  

 

 Enter the volume label to confirm deleting. To confirm deletion of the selected partition, enter its Volume 

Label. The current volume label is displayed above. 

 Do not ask volume label next time. Mark the option to inhibit confirmation next time you start the dialog. 

Result 

By default, the operation takes only a fraction of a second. However, the program waits until Windows completes the 

modification of the disk layout. 

Advanced Partitioning Operations 

Here you can learn how to accomplish advanced partitioning operations. 

Merging Partitions 

The Merge Partitions Wizard enables to consolidate the disk space, which originally belongs to two adjacent partitions, 

into a single, larger partition. The order, in which two partitions have been chosen, is important since all contents of the 

second selected partition will be placed in a folder on the resulted joined partition. 

The program provides the ability to merge only NTFS, FAT16 or FAT32 partitions. 

Startup 

 In the Main menu: select Wizards > Merge Partitions… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Setup 

The wizard offers the following steps to accomplish the operation: 

 The partition to expand. Select a partition, the size of which you need to increase by up-taking contents of an 

adjacent partition. 
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 The partition to merge with. Choose the second partition for the merge operation, the contents of which will be 

placed in a folder on the resulted joined partition. By default, the program offers an easy-to-understand folder 

name to store files of the second partition, which however can be customized. 

 

 

  

Be particularly careful when selecting system partitions to process, since the incorrect 

order, in which two partitions have been chosen, will result in inability to boot the 

operating system. 

 

Result 

After the operation is completed the disk space of the two adjacent partitions will be consolidated. 

Redistributing Unused Space between Partitions 

Express Resize Partitions Wizard 

The Express Resize Partitions Wizard enables to easily increase free space on one partition by up-taking the unused 

space of an adjacent partition of your hard disk. 

Startup 

 In the Main menu: select Wizards > Express Resize Partitions… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 
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Setup 

The wizard offers the following steps to accomplish the operation: 

 Adjacent partitions to resize. Click on the left partition of the pair of partitions you need to redistribute the 

unused space between, as the right one will be selected automatically. 

 

 Resulted size of partitions. Redistribute the unused space between the partitions with the slider or manually by 

entering the required value. 

 

Result 

After the operation is completed the unused space between the specified partitions will be redistributed according to 

your needs. 

Available operation scenarios: 

 Increasing size of a system partition by taking unused space of an adjacent logical partition 

 Resizing partitions of Apple Boot Camp 

Redistribute Free Space Wizard 

The Redistribute Free Space Wizard helps to increase free space on one partition by up-taking the on-disk unallocated 

space and the unused space of other partitions. By default, the wizard adds to the target partition all existing blocks of 

the free space. Besides you can specify partitions to act as a space donor. The wizard will automatically recalculate 

positions of the partitions and move their contents to new locations. 

Startup 

 In the Main menu: select Wizards > Redistribute Free Space… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 
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Setup 

The wizard offers the following steps to accomplish the operation: 

 Partition to enlarge. Select a partition, the size of which will be increased at the expense of other partitions. 

Blocks of the free space (if any) will be automatically added to the target partition. 

 

 Partition to donate. Choose any partition(s) (not only adjacent) to donate free space. 

 

 Partition size. By default, the program leaves 50% of the unused space on a partition and removes another 50% 

to add it to the target partition. However, the size to take can be customized by moving the slider or by 

manually entering the exact value. 
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Result 

After the operation is completed free space of the specified partition will be increased by up-taking the on-disk 

unallocated space and the unused space of other partitions. 

Undeleting Partitions 

When simply deleting a partition (without additional wiping) disk management software only removes references to it in 

the Partition Table, thus leaving the possibility to recover it later. 

The program enables to find and recover these partitions. A restored partition will be fully functional, as long as other 

partitions were not created, moved or exceeded the disk space occupied by that partition. That is why the program 

offers this function only for blocks of free space. 

The operation can be accomplished with the Undelete Partition Wizard. 

Startup 

 In the Main Menu: select Wizards > Undelete Partitions… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Setup 

The wizard offers the following steps to accomplish the undelete partition operation: 

 Free blocks to scan for lost partitions. Choose a free block from a tree-like list of available hard disks. 

 

 Search method. By default, the wizard selects the fastest search method for your operating system. In most 

cases that will do to find any accidentally deleted partition. However if you're under Windows XP for instance 

(the Conventional Search option is selected), but the deleted partition you're looking for has been created with 

the Disk Management utility under Vista, the wizard won't be able to find this partition, unless you manually 

select the appropriate option (Quick Search for Partitions Created by Vista or Later OS). Moreover if the wizard 

still fails to find the partition you need, you can select the Thorough Search option to scan every single sector in 

the specified search area to get the most accurate results. 
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To know more on the available search methods, please use the context sensitive hint 

system. 

 

 File system filter. By default, the wizard will search for all known file systems. However, by clicking on the 

appropriate option on the second page of the wizard, you can specify only those file systems you need. 

 

 A partition to undelete (if several). By default, the program searches records of any deleted partition ever 

existed on the selected block of free space. So you can get several partitions to choose from. 

 

Most likely the required partition will be found first. If so, you may abort the search operation by pressing the 

Stop search button. 

Result 

After the operation is completed you receive a fully functional partition. 

Installing a New Operating System 

Getting your computer ready to install a new operating system, especially when it is going to be an additional OS in the 

system, is a rather complicated task that implies quite a number of operations, from allocating space to create a new 

partition (resize, redistribution of free space) to formatting of the newly created partition to a particular file system and 

checking its surface for bad sectors to avoid possible data loss. Operating systems today are being supplied with basic 

tools of partitioning that only enable to create a partition (in case there is enough unallocated space on the disk) and 

then format it to the specified file system type. Our program offers a handy Install New OS Wizard to easily carry out all 

the necessary operations to install a new operating system. 

Startup 

 In the Main menu: select Wizards > Install New OS… 
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There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Setup 

The wizard offers the following steps to accomplish the operation: 

 Partition to install a new operating system. The program offers two ways of installing a new OS, i.e. to create a 

new primary partition for it or use an existing one. 

 

 

  
Only primary partitions can be used to install an operating system. 

 

- In case the first option has been marked, the wizard enables to specify: 

A hard disk (if several) where a new partition will be created. Thanks to an advanced program engine it is 

possible to use unallocated space of the disk (if any) and unused space of existing partitions to create a new 

partition; 

 

 

  

To avoid any possible problems, the new partition will in no way be created as the first 

partition of the disk which already contains at least one partition. 

 

And its size. If there are blocks of the free space on the disk, the wizard will merge them all and allocate the 

resulted space for a new partition in the first place. If not, it will take 50% of the unused space of an adjacent 

partition. However, the size to take can be customized by moving the slider. 
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- In case the second option has been marked, the wizard enables to choose an existing primary partition to 

install a new operating system. 

 

 

  
Your computer may fail if any other OS has already been installed on the selected partition. 

 

 Partition properties. 

 

- Partition type. From the pull-down list select the desired file system type. In fact, the program displays only file 

systems that can be correctly placed to the selected partition, taking its capacity into account. 

- Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with the newly 

formatted partition. 

- Surface test level. Define the level of the surface check to make the program find bad and unstable sectors and 

mark them unusable in the file system metadata. 

 OS Label. Enter a label for the selected partition in the textual field. It will later be used for the drive 

identification. 
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Result 

As the final step the wizard will offer you to insert a distributive CD/DVD of the new operating system and restart the 

computer to launch the installation procedure. 

 

  

The program will update your MBR, so most likely you won’t be able to start up any of the 

previously installed operating systems. Please launch the Boot Manager Setup Wizard after 

the installation has been completed to fix this issue. 

 

Available operation scenarios: 

 Creating Dual Boot Systems 

Moving/Resizing Partition 

The Move/Resize Partition function allows you to resize or change location of any partition without destroying its data. 

In order to move/resize a partition you should take the following steps: 

1. Select a partition on the Disk Map. 

2. Select in the Main menu: Partition > Move/Resize Partition… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. Define parameters of the operation. 

 

 Volume size. Define size (in Mb) of the modified partition. 

 Free space before. Define the partition position (in Mb) relative to the beginning of the available range of 

disk space. 
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 Free space after. Define the amount of trailing free space (in Mb) at the end of the available range of disk 

space. 

 Sector to sector move. Mark the checkbox to move the partition in the sector-by-sector mode to process its 

unused space as well. This can help to avoid problems with hidden data created by certain applications or 

the system administrator. However, it will take more time to accomplish the operation. 

 

  

Partition size and position may also be defined by using the drag-and-drop technique. To do 

that, just carry out the required operation on the Disk Map. The virtual operations are to be 

available. 

When resizing a FAT16 partition beyond the 2GB limit (maximum file system size), the 

partition will automatically be converted to FAT32. 

The program enables to enlarge NTFS partitions (system, locked) without rebooting 

Windows and interrupting its work, providing 100 percent guarantee that your data is kept 

intact. 

 

4. The operation will be performed immediately after confirmation. 

Available operation scenarios: 

 Increasing size of a system partition by taking unused space from any other 

 Shrinking a system partition to increase size of a data partition 

Converting File System 

With our program you can change type of the used file system without destroying its data. While performing the 

operation, it first checks the current file system for consistency and then verifies whether the on-partition data meet the 

requirements of the desired file system or not. After having passed the testing, the program re-organizes the file system 

metadata and user files. 

The program enables to convert the following file system types: 

- FAT16 > NTFS, FAT32 

- FAT32 > NTFS, FAT16 

- NTFS > FAT16, FAT32 

- Ext2 > Ext3 

In order to convert a file system you should take the following steps: 

1. Select a partition on the Disk Map. 

2. Select in the Main menu: Partition > Convert file system… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 
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3. Initially the program suggests some consistent values for all parameters. In most cases, you can just press the 

Convert button to confirm the operation. 

 

 New file system. From the pull-down list choose a file system you would like to convert to. Actually the 

program only displays variants available for the operation, taking into account the current parameters of the 

selected partition and limitations of the used file system. 

 New cluster size. Define the cluster size for the partition. This parameter can have a profound effect on the 

overall performance. In a nutshell, larger clusters waste more space, but generally provide for slightly better 

performance, because of less fragmentation. So be particularly careful with it. 

 

  

The cluster size value is expressed in sectors per cluster. To get it in Kbytes, please divide it 

into half. 

You may only decrease the current cluster size. 

 

 Surface test level. Define the level of the surface check to make the program find bad and unstable sectors 

and mark them unusable in the file system metadata. 

4. The operation will be performed immediately after confirmation. 

Changing Cluster Size 

Cluster size is one of the crucial parameters of any file system. Its value implicitly affects the performance of the files 

input-output activity since it defines the size of the file system metadata. Besides, the so-called waste space factor also 

depends on the cluster size. 

In order to change the cluster size of a partition you should take the following steps: 

1. Select a partition on the Disk Map. 

2. Select in the Main menu: Partition > Modify > Change Cluster Size… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. Define the cluster size for the partition. This parameter can have a profound effect on the overall performance. 

In a nutshell, larger clusters waste more space, but generally provide for slightly better performance, because of 

less fragmentation. So be particularly careful with it. 
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The Cluster Size value is expressed in Sectors Per Cluster. To get the Cluster Size in Kbytes, 

divide it into half. 

 

4. The operation will be performed immediately after confirmation. 

Making Logical/Primary 

The program allows you to include a primary partition in the extended partition, or exclude a logical partition from the 

extended partition, without partition duplication. 

In order to change a partition type you should take the following steps: 

1. Select a primary or logical partition on the Disk Map. 

2. Select in the Main menu: Partition > Modify > Make Partition Logical/Primary. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

 

 

  

The Make Primary > Logical option is only available when the selected partition is adjacent 

to the extended partition and vice versa. 

The Make Primary > Logical option of the system partition will result in inability to boot the 

operating system. 

 

3. The operation will be performed immediately after confirmation. 

Changing Partition Attributes 

This chapter explains how you can change partition attributes (Active flag, Hidden flag, Volume Label, etc.). 
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Mark Partition Active/Inactive 

The program enables to set an active/inactive flag for primary partitions of a hard disk. By default, an operating system 

will boot only if its partition is active or bootable. 

In order to mark a partition active/inactive you should take the following steps: 

1. Select a primary partition on the Disk Map. 

2. Select in the Main Menu: Partition > Mark Partition as Active/Inactive. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

 

3. The operation will be performed immediately after confirmation. 

 

 

There can only be one active partition on a hard disk, otherwise your operating system will 

fail to boot. 

 

Hide/Unhide Partition 

The program allows you to hide/unhide primary and logical partitions. By default, an operating system does not mount 

hidden partitions, thus preventing access to their contents. 

In order to hide/unhide a partition you should take the following steps: 

1. Select a partition on the Disk Map. 

2. Select in the Main Menu: Partition > Hide/Unhide Partition. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. The operation will be performed immediately after confirmation. 

 

 

It is strongly recommended not to hide the system partition. Otherwise your operating 

system will fail to boot. 
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Set Label of a Partition 

The Partition Label is a small textual field (up to 11 characters) that is located in the partition's boot sector. It is 

detectable by any partitioning tool and is used for notification purposes only. 

In order to change a partition label you should take the following steps: 

1. Select a partition on the Disk Map. 

2. Select in the Main Menu: Partition > Modify > Change Volume Label. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. Enter a label for the selected partition. 

 

4. The operation will be performed immediately after confirmation. 

Change Partition ID 

Partition ID is a file system identifier. It is saved in the Partition Table and is used to quickly detect a partition of the 

supported type. By manually changing its value, you can manipulate accessibility of partitions. 

In order to change a partition ID you should take the following steps: 

1. Select a partition on the Disk Map. 

2. Select in the Main Menu: Partition > Modify > Change Partition ID… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. Set a new ID for the selected partition. 
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 Predefined ID. Select from the pull-down list the required ID. 

 Enter ID manually. With the spinner control set the required ID value. It has to be a 1-2 digit hexadecimal 

number. 

4. The operation will be performed immediately after confirmation. 

Change Serial Number of a Partition 

FAT16, FAT32, and NTFS file systems include the Serial Number parameter. A partition's serial number is saved in the 

boot sector. Its value is generated while formatting. 

The program enables to modify the serial number parameter for FAT16, FAT32, or NTFS partitions without re-

formatting. 

In order to change a serial number you should take the following steps: 

1. Select a partition on the Disk Map. 

2. Select in the Main Menu: Partition > Modify > Change Serial Number. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. Enter a new serial number for the selected partition. It should contain 8 hexadecimal figures (0..9 or A..F). The 

operation cannot proceed until you enter all 8 symbols. 

 

4. The operation will be performed immediately after confirmation. 

Hard Disk Management 

In this chapter you will find all the information necessary to carry hard disk operations supported by the program. 

Converting Dynamic MBR to Basic 

The program allows you to convert a dynamic MBR disk containing simple volumes into a basic one while keeping its 

contents intact. 

In order to convert a dynamic MBR disk into basic you should take the following steps: 

1. Select a dynamic MBR disk containing simple volumes on the Disk Map.  

2. Select in the Main Menu: Hard Disk > Convert to Basic… 

3. Set the required number of primary partitions if necessary. According to the DOS partitioning scheme a hard 

disk can have up to four Primary partitions. If there is an Extended partition on the disk, only three primary 

partitions are allowed. That is why if a dynamic disk contains several simple volumes the program enables to 
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choose the number of primary partitions. The rest of them if any will automatically be converted to logical disks 

within the Extended partition. 

 

 

 

The program can only process dynamic disks containing solid simple volumes (without 

extension). 

 

Converting GPT to Basic MBR 

The program allows you to convert a basic or a dynamic GPT disk containing simple volumes into a basic MBR disk while 

keeping its contents intact. 

In order to convert a basic or a dynamic GPT disk into a basic MBR disk you should take the following steps: 

1. Select a basic or a dynamic GPT disk containing simple volumes on the Disk Map. 

2. Select in the Main Menu: Hard Disk > Convert to Basic MBR Hard Disk… 

3. Set the required number of primary partitions if necessary. According to the DOS partitioning scheme a hard 

disk can have up to four Primary partitions. If there is an Extended partition on the disk, only three primary 

partitions are allowed. That is why if a GPT disk contains several volumes the program enables to choose the 

number of primary partitions. The rest of them if any will automatically be converted to logical disks within the 

Extended partition. 
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The program can only process dynamic GPT disks containing solid simple volumes (without 

extension). 

 

Converting Basic MBR to GPT 

The program allows you to easily convert a basic MBR disk into a basic GPT disk while keeping its contents intact. The 

operation is quite safe for the on-disk data, but you should know that only 64-bit Windows OSes since Vista are able to 

boot from this type of disks. So if you’ve got a 32-bit Windows OS accommodated on a disk you’d like to convert to GPT, 

it won’t start up after the operation is over.  

In order to convert a basic MBR disk to a basic GPT you should take the following steps: 

1. Select a basic MBR hard disk on the Disk Map. 

2. Select in the Main Menu: Hard Disk > Convert to GPT hard disk. 

 

3. The operation will be performed immediately after confirmation. 

 

 
The program can only convert basic MBR disks. 

 

Updating MBR 

The program enables to overwrite the current bootable code in the MBR (Master Boot Record) by the standard 

bootstrap code. This can help to repair a corrupted bootable code of a hard disk resulted from a boot virus attack or a 

malfunction of boot management software. 
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In order to update MBR of a hard disk you should take the following steps: 

Launcher 

1. Select a hard disk on the Disk Map. 

2. Select in the Main Menu: Hard Disk > Update MBR. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

 

3. The operation will be performed immediately after confirmation. 

Changing Primary Slot 

Different operating systems apply different approaches to enumeration of the primary partitions. 

In Linux: 

In Linux, every partition has a special symbolic name that encodes a hard disk containing a partition, and a partition 

itself. Partitions are addressed and accessed by using their symbolic names. Symbolic names are automatically 

generated by Linux in accordance with the order of hard disks in BIOS and the order of partition records in the Partition 

Table. Thus changing enumeration of the primary partitions can lead to changing of paths to some important resources. 

In DOS: 

The last versions of MS-DOS use a rather sophisticated algorithm for a drive letter assignment. A drive letter, which is 

assigned to a partition, depends on the order of records in the Partition Table. Thus changing enumeration of the 

primary partitions affects the drive letters assignment. In early versions of MS-DOS, it could even lead to the 

unavailability of a partition. 

The program provides the ability to change enumeration of the primary partitions. This feature will allow you to fix 

problems concerning an inappropriate order of partitions. 

In order to modify enumeration of the primary partitions you should take the following steps: 

1. Select a hard disk on the Disk Map. 

2. Select in the Main Menu: Hard Disk > Change Primary Slot. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 
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3. In the opened dialog you can see the current enumeration of the primary partitions of the selected hard disk in 

the Partition Table. To help you distinguish partitions from one another, the program provides the following 

parameters for every partition: 

- Slot 

- Volume 

- Partition type 

- File system 

- Partition size  

- Volume label 

There are two buttons on the right to move the selected partition up and down within the primary part of the 

Partition Table. 

4. The operation will be performed immediately after confirmation. 

Wipe Tasks 

In this chapter you will find all the information necessary to wipe a hard disk/partition of any file system or only destroy 

any remnants of deleted files/directories left on disk without affecting the used data, thus providing high level of 

security. 

The operation can be accomplished with the Wipe Wizard or corresponding dialogs. 

Wizard Startup 

 In the Main Menu: select Wizards > Wipe Hard Disk or Partition… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 
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Wizard Setup 

The wizard offers the following steps to accomplish the operation: 

 The hard disk/partition to wipe. Select a hard disk/partition the data of which you want to destroy. 

 

 Wipe mode. This section enables to switch between two options: 

 

- Wipe out all data. Select the option to irreversibly destroy all on-disk data of the selected object. 

- Clear (wipe) free space. Select the option to destroy any remnants of deleted files/directories left on disk 

without affecting the used data. 

 

  

The Clear Free Space operation is available only for Logical and Primary partitions of known 

file systems. 

 

 Wipe method. Here you can select a specific data erasure algorithm or create a customized method by marking 

the appropriate option. 

 

- In case you preferred to use a specific algorithm, the next page of the wizard enables to get detailed 

information on the selected algorithm, choose whether to carry out residual data verification or not specifying 

the percentage of sectors to check and estimate the time required to accomplish the operation. 
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The list of supported military and government standards may vary for your product. 

 

- In case you preferred to create a customized algorithm, the next page of the wizard enables to define up to 4 

wiping patterns, number of passes for each wiping pattern and for the group of patterns. The Mask spinner 

control allows you to set a two-figure hexadecimal character value ("00" by default). The available range is from 

"00" to "FF". You can also choose whether to carry out residual data verification or not specifying the 

percentage of sectors to check. 

 

 Revise your changes. This page informs on all the actions to be made in the wizard in a bright, graphical form. 
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Wizard Result 

After the operation is completed you can see a well informative summary page, providing structurally divided in-depth 

information on all the actions made in the wizard. 

 

The program also enables to store the resulted report. To do that, just press the Save button and choose the exact 

location in the opened dialog. 

To make sure that all on-disk data is irreversibly destroyed call the Disk Viewer dialog by clicking the appropriate tab and 

see it for yourself. 

 

 

  
The Summary page will be available only when the Virtual operations are disabled. 



113 

Copyright© 1994-2011 Paragon Software Group. All rights reserved. 

 

Available operation scenarios: 

 Hard Disk Utilization 

Task Scheduling 

Automation of operations can really help you out when you’ve got to accomplish certain routine operations on a regular 

basis as it enables to execute them without your involvement while optimizing your computer’s work-load. 

Setting a Timetable 

Thanks to the embedded Scheduler, you can set a timetable for execution of any operation. It has two categories for 

time settings (these correspond to appropriate items in the Schedule type menu): 

 Initiating the operation by an event: 

- One time only (i.e. the Once item) 

- When the system starts (i.e. the At System Startup item) 

- When the user logs on (i.e. the At Logon item). 

 Initiating the operation periodically (i.e. Daily, Weekly, Monthly). 

 

You need to select one of the variants. Depending on your choice, the scheduler displays a form that enables to set a 

timetable. 

 

 

 

To run the task in the log-off mode, please specify administering login info by following the 

appropriate link in the left lower corner of the page. 
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The Shutdown System on Complete option enables to automatically switch off the 

computer on the successful accomplishment of the operation. 

 

Managing Tasks 

All scheduled tasks are placed in a separate list, which can be retrieved by clicking the Scheduled Tasks tab in the 

Explorer Bar: 

 

On every task you can get in-depth information, including: 

 The task name 

 The full path to the generated script of the task 

 Scheduled time of launch 

 Statistics on the last launch 

 Scheduled time of the next launch 

 Used account information 

 Comments to the task 

To easily manage tasks, the program enables to arrange them according to a certain characteristic just by clicking on the 

required property. 

 

 

This feature can be particularly beneficial when the Scheduled Tasks list contains too many 

items. 

 

You can also enable/disable, rename, delete, refresh or modify properties of the selected task. 

Task Editor  

With the Task Editor you can easily modify properties of scheduled tasks. To do that, you should take the following 

steps: 

1. Select a task on the Scheduled Tasks list. 

2. Click the Properties button on the Scheduled Tasks list. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 
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3. In the opened dialog window you can see two tabs - General and Schedule. Click the General tab to modify: 

 Full path to the macro-command program-interpreter, which describes the scheduled task; 

 Command line for starting the interpreter (i.e. the task described in macro-language) 

 Comments referring to the task 

 The option of enabling/disabling the task. 

By clicking the Schedule tab you can modify the task timetable. 

In order to apply the changes, you need to click the Apply button at the foot of the dialog. 

Creating a Scheduled Task 

You can set a timetable for execution of any operation. For backup and copy operations the program offers handy 

wizards, while all the others can be scheduled with the Save to Scheduler dialog. 

To create a scheduled task you should take the following steps: 

1. Make sure the virtual mode of execution is enabled; 

2. Carry out with the program all operations you need to schedule; 

3. Call the Save to Scheduler dialog in the Main Menu: Tools > Save to Scheduler…; 
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4. In the opened dialog enter the required task name and specify the task timetable; 

5. The operation will be performed immediately after confirmation. 

 

 
This command is unavailable if there are no operations on the List of Pending Operations. 

 

Scripting 

The program actions can also be represented in form of a script. The script describes the appropriate operation with 

macro-language commands. There is an interpreter utility - SCRIPTS.exe, which is included in the program installation 

package. This utility works in the unattended mode, which enables to automate operations. 

Startup 

You have no need to write a script since the program has a convenient interface for such a task. In order to generate a 

script on the base of the entered parameters of the required operation, you should take the following steps: 

1. Make sure the virtual mode of execution is enabled; 

2. Carry out with the program all operations you need to be scripted; 

3. Call the Generate Script dialog in the Main Menu: Tools > Generate Script…. 

Setup 

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Generate 

button to confirm the operation. 
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 Script file name and location. By default, the program offers to add the script to the Task List with a name 

containing its creation date and time. Unmark the Add to Task List checkbox to define an exact location and a 

filename for the script file. The default file extension that is reserved for scripting files is .psl, which however can 

be modified. 

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). 

To activate the advance mode, you need to click the More options button at the foot of the dialog page, so you will be 

able to define: 

 

 Interaction with the user. Mark the option to pause the script interpreter during the execution to prompt the 

user’s confirmation or other input. Otherwise the program will not stop using default values for parameters if 

needed. 

 Commit after each operation. Mark the option to commit changes after each operation. 

 Check for errors after each operation. Mark the option to insert a special code in script, which checks the status 

of the last executed operation and stops the script processing if there are errors of any kind. 

 Discard all operations on close. Mark the option to empty the List of Pending Operations after generating the 

script. 

Result 

After the operation is completed you receive a new script file. It is placed into the specified destination, its features 

defined in the dialog. 

 

 

This command is unavailable if there are no operations on the List of Pending Operations. 

To learn more about scripts please consult the Paragon Scripting Language manual. 

 

Extra Functionality 

This chapter describes the supplementary functionality available in the program. 
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View Partition/Hard Disk Properties 

The program enables to obtain in-depth information on the properties of hard disks and partitions. Besides the general 

information, such as capacity, used space or file system type it provides the possibility to get info on hard disk geometry, 

cluster size, exact partition location, etc. 

To get properties on a partition/hard disk, please do the following: 

1. Choose a partition/hard disk on the Disk Map. 

2. Select in the Main Menu: Partition/Hard Disk > Properties… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

 

In the opened dialog information will be grouped according to its properties, thus by clicking tabs you can get 

information you need. 

Volume Explorer 

Volume Explorer is a special tool to browse and export contents of the local mounted/unmounted volumes formatted to 

FAT16, FAT32, NTFS, Ext2FS, Ext3FS, ReiserFS file systems. Besides it enables to access Paragon backups as regular 

folders to explorer their contents or to retrieve certain files. 

To launch the Volume Explorer you should click Disk View tab in the Explorer Bar and then choose Volume Explorer: 
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Call the popup menu for the selected file/folder (right click of the mouse button) to export it to some other location 

(local or network drive, etc.). 

 

Available operation scenarios: 

 Restoring separate files and folders from a backup 

File Transfer Wizard 

File Transfer Wizard is designed to make such operations as copying of separate files/directories or burning of them to 

CD/DVD as easy and convenient as possible. It may be of particular use in case of a system malfunction, caused either by 

a virus attack or files corruption, in order to get the system back on track again. Besides it provides access to Paragon 

backups as regular folders to browse through their contents or copy required files. 

Startup 

 Select in the Main Menu: Tools > File Transfer Wizard. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 
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Setup 

The wizard offers the following steps to accomplish the transfer operation: 

 Place to look for files/directories. Select a source disk from the pull-down list in the left pane of the page. The 

program enables to process both mounted and unmounted (without drive letter assigned) partitions. Besides it 

is possible to map a network drive. 

 

 Object(s) of operation. Choose files/directories you want to copy and place them to Clipboard by pressing the 

Add button. To delete a file/directory from the Clipboard, select it in the Clipboard pane and press the Remove 

button. You can also create a new folder, rename or irreversibly delete existing files/directories of the left pane 

by pressing the appropriate buttons. 

 

 

 
Files/directories deleted from the Clipboard remain intact on source disks. 

 

 Destination to store the object(s). The File Transfer Wizard allows copying data to local or network drives, to 

physical partitions (without drive letters assigned), or burning them to CD/DVDs. Choose the way the data will 

be stored. 

 

 Revision of changes. The Transfer Summary page provides structurally divided information on all the actions 

made in the wizard. Check the changes and come back to any step of the wizard (if necessary) by following the 

required hyperlink. 
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Result  

After the operation is completed the required data will be placed into the specified destination. 

Available operation scenarios: 

 Copying of data from the corrupted system disk to another hard disk 

 Burning of data from the corrupted system disk to CD/DVD 

 Copying of data from a backup to the corrupted system partition 

 Restoring separate files and folders from a backup 

Mount Partition 

The program enables to assign or remove drive letters of existing formatted partitions. 

Assign Drive Letter 

In order to mount a partition you should take the following steps: 

1. Select a partition on the Disk Map.  

2. Select in the Main Menu: Partition > Assign Drive Letter… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. Specify a drive letter for the selected partition. Initially the program suggests some consistent value for this 

parameter. So you may just press the Yes button to confirm the operation. 

 

However you can manually define the required letter by selecting it from the pull-down list of available drive 

letters.  

4. The operation will be performed immediately after confirmation. 

Remove Drive Letter 

In order to un-mount a partition you should take the following steps: 
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1. Select a partition on the Disk Map. 

2. Select in the Main Menu: Partition > Remove Drive Letter. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. The operation will be performed immediately after confirmation. 

 

 

Modifying drive letter of the system partition will result in inability to boot the operating 

system. 

After having processed partitions with installed software, some programs may not run 

properly. 

 

Downgrade NTFS Version 

With our program you can decrease version of an existing NTFS partition. This feature can be particularly useful when, 

for instance, dealing with different versions of the Windows NT family operating systems. 

In order to start the operation you should take the following steps: 

1. Select a partition on the Disk Map. 

2. Select in the Main menu: Partition > Modify > Downgrade NTFS Version… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. Decrease version of the selected NTFS partition by selecting the one you need from the pull-down list. 

 

4. The operation will be performed immediately after confirmation. 

Mount Archive 

The program provides the ability to assign a drive letter to a partition backup image. As a result of the operation you will 

get a new read-only partition in the system to easily browse through its contents and copy the required information 

even with the standard Windows tools. 
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Assign Drive Letter 

In order to mount an archive you should take the following steps: 

1. Select a backup image in the Archive Database. 

2. Select in the Main Menu: Archives > Mount the Selected Archive. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. Specify a drive letter for the selected backup image. Initially the program suggests some consistent value for this 

parameter. So you may just press the Yes button to confirm the operation. 

 

However you can manually define the required letter by selecting it from the pull-down list of available drive 

letters. 

4. The operation will be performed immediately after confirmation. 

 

 

The current version of the program allows the user to mount archives of separate partitions 

only. 

There is no possibility to mount archives located on physical (unmounted) partitions or in 

the bootable capsule. 

Archives will only be mounted for the current session and won’t be available after the 

system restart. 

It is strongly recommended not to un-mount backup images with Windows Disk Manager 

or other third side software. 

 

Remove Drive Letter 

In order to un-mount a backup image you should take the following steps: 

1. Select a backup image in the Archive Database. 

2. Select in the Main Menu: Archives > Unmount the Selected Archive. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. The operation will be performed immediately after confirmation. 
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Test Surface 

The program enables to test surface of existing partitions and blocks of free space for bad or unstable sectors. If found 

any it automatically marks them unusable in the file system metadata, thus minimizing the risk of data loss. 

In order to start the surface test you should take the following steps: 

1. Select a partition or a block of free space on the Disk Map. 

2. Select in the Main Menu: Partition > Test Surface… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. From the pull-down list choose the level of the surface check. 

 

4. The operation will be performed immediately after confirmation. 

Check File System Integrity 

The program allows you to check integrity of a file system. It can be used to detect possible file system errors before 

performing any operation on a partition. 

To start the system integrity check you should take the following steps: 

1. Select a partition on the Disk Map. 

2. Select in the Main Menu: Partition > Check File System Integrity 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

 

3. The operation will be performed immediately after confirmation. 
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Check Archive Integrity 

The program provides the ability to check integrity of a backup image. The function allows distinguishing between valid 

and corrupted images before using them. The Check Archive Integrity Wizard will help you do that. 

Startup 

 In the Main Menu: select Wizards > Backup Utilities > Check Archive Integrity… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Setup 

The wizard offers the following steps to accomplish the operation: 

 An archive to verify. The Browse for Archive page enables to find a backup image you need. 

By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive Database (if 

any). 

 

To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. 

Archive File Details) display a short description. 

 

 
To know more on the subject, please consult the Viewing Image Properties chapter. 

 

By clicking the Switch to File View link, you can find the required image in the browser-like window. The section 

below (i.e. Archive File Details) will also display a short description of the selected image. 
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Moreover, on this page you’ve got the possibility to create new folders, delete existing files/folders or map 

network drives by clicking the appropriate buttons. 

 

 
To know more on the subject, please consult the Viewing Image Properties chapter. 

 

Result 

After the operation is completed you can see results of the check. 

Check Recovery Discs 

You’ve got the ability to check whether backup media created with the program is 100 percent error-free and ready to 

use. The Check Recovery Disc Wizard will help you do that. 

Startup 

 In the Main Menu: select Tools > Check Recovery Discs… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Startup 

The wizard offers the following steps to accomplish the operation: 

 CD/DVD drive. Select from the pull-down list of available CD/DVD devices the required drive to use during the 

operation. 

 

 Set whether to eject the disk after the operation is completed or not. 

Result 

After the operation is completed you can see results of the check. 
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Edit/View Sectors 

With the built-in Edit/View Sectors tool the program enables to view/edit sectors on existing partitions/hard disks 

providing the possibility to directly access and modify sectors, save and restore sectors from specified files, navigate 

through the system metadata, etc. 

In order to edit/view sectors of a hard disk/partition you should take the following steps: 

1. Select a hard disk/partition on the Disk Map. 

2. Select in the Main Menu: Partition/Hard Disk > Edit/View Sectors. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

 

 

 
Careless use of the Edit Sectors function may result in the irreversible data corruption. 
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Send Log Files 

The program enables to simplify the procedure of sending support requests to the Paragon Support Team. In case of 

having difficulties with handling the program, you, with the help of this very function, can address the company support 

engineers and provide them with all the information they need such as the disk layout, performed operations, etc. in 

order to tackle the encountered problem. Information of that kind is stored in Log files. 

In order to send log files to the Paragon Support Team you should take the following steps: 

1. Call the Send Log Files dialog in the Main Menu: Tools > Send Log Files; 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

2. Provide a customer name and a product serial number; 

3. Give a detailed description on the encountered problem. 

 

By clicking the Send button the built-in mail client will generate a template request with attached compressed log files 

and then send it to the Paragon Support Team. 

Log Files 

Log files are simple textual files that can be opened by any text editor. There are several log files automatically 

generated by the program: 

Stubact.log Contains in-depth information on parameters and performance of all operations 

carried out by the program 

Pwlog.txt Besides brief overview on operations it also contains detailed information about the 

state of all hard disks 

Cdb.log Contains low-level information on the CD/DVD devices used in the system 

BioNTlog.txt It is an OS-dependent supplementary log file derived from Bioxx.dll. It may contain 

valuable information on Windows family operating systems 
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Log files do not contain any confidential information on the operating system settings or 

the user documents. 

The Send Log Files function is only available when outgoing mail server (SMTP) and the user 

e-mail address are properly set. To learn more about it please consult the Settings 

Overview chapter. 

 

View Logs 

With a handy dialog you can study logs on any operation carried by the program. To make this job as easy as possible, all 

the information is structurally divided, besides there is the possibility to see the disk layout before and after an 

operation, what is very convenient.  

In order to view logs on carried out operations select in the Main Menu: Tools > View Log Files 

 

Typical Scenarios 

This chapter lists a number of the most frequently used scenarios that may be accomplished with the program. You can 

find here useful recommendations and descriptions of operations. 
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Backup Scenarios 

Creating the Backup Capsule 

Let us take a computer of a rank and file user who is most likely to have only one hard disk with only one partition (the 

only partition is always system). Suppose that there is enough free space on the hard disk to create the backup capsule 

as well. It can be created with the Manage Backup Capsule Wizard: 

1. Click the Manage Backup Capsule item of the Wizards menu. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

2. On the Wizard's Welcome page, click the Next button. 

3. Select a place on the disk where the backup capsule will be created. It can be created as a primary partition or 

as a logical drive within an extended partition. It can be inserted into any place on the hard disk: at the end 

(preferable), at the beginning or somewhere in the middle between other partitions. 

 

 

 

By default, the program allows the user to create the backup capsule only as the last 

primary or as the last logical drive within the extended partition. However, by activating 

the advance mode on the first page of the wizard you can remove this restriction that in its 

turn might result in some boot problems. 

 

4. Set the size for the backup capsule. It will be created at the expense of free space of the selected disk. 

 

There is no restriction on the size of the backup capsule, merely depending on the available space of the hard 

disk and the capacity needed for the backup. 

If the wizard cannot find enough free space in one block, it will redistribute free space, joining all free space 

blocks together into one united block and moving partitions if necessary. If the total amount of free space is still 

not enough, it is possible to split a fragment of space from one of the existing partitions, thus resizing it. 
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If the partition is locked and cannot be resized, the wizard makes the system reboot to 

create the backup capsule and automatically boots the system again. (The rebooting 

mechanism is different for different versions of Windows). 

 

5. Activate the bootable recovery environment if needed. With its help you will get the choice to boot directly 

from the backup capsule for maintenance or recovery purposes every time you start up the computer. 

 

 

 

This operation will result in overwriting of the current MBR, thus in case of having a third 

side boot manager, it will be removed. To avoid that you can save the current MBR with the 

help of the Edit/View Sectors tool. 

The backup capsule can only be bootable if it is located on the bootable device (assigned in 

the BIOS). 

 

6. Start the operation (by clicking the Next button) or return to correct the settings. 

After the operation is completed you can place backup archives into the created backup capsule. 

 

 
This operation can also be accomplished with our recovery media. 

 

Backing up a hard disk or partition to the Backup Capsule 

To back up an entire hard disk or a separate partition and then place the resulted image into the backup capsule, please 

do the following: 

1. Create the backup capsule with the Manage Backup Capsule Wizard. 

2. Click the Smart Backup item of the Wizards menu. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. On the Wizard's Welcome page, click the Next button. 

4. On the What to back up page, select Disk or Partitions to create a sector-based backup of the whole disk 

system, or only separate partitions. 
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5. On the next page, mark the appropriate option opposite a hard disk’s name or a partition’s name depending on 

the chosen task. 

 

 

 

You’ve got the option to modify the default backup settings by marking the appropriate 

checkbox on this page. 

By default the program will take into account exclude filters set in the Settings dialog. 

 

6. On the Backup Destination page, select the Save data to the Backup Capsule option. 

 

7. Edit the archive name if necessary. 



133 

Copyright© 1994-2011 Paragon Software Group. All rights reserved. 

 

 

 

Please take into account values of the parameters Estimated archive size and Space 

available on backup destination - if the archive size exceeds the available space, delete 

outdated backups from the Backup Capsule or resize it with the Manage Backup Capsule 

Wizard. 

 

8. Add comments to your backup describing its contents. 

 

9. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the 

Next button to start the backup process. 

 

 
This operation can also be accomplished with our recovery media. 

 

Backing up a hard disk or partition to external media (CD/DVD) 

To back up an entire hard disk or a separate partition and then burn the resulted image to CD/DVD, please do the 

following: 

1. Click the Smart Backup item of the Wizards menu. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

2. On the Wizard's Welcome page, click the Next button. 

3. On the What to back up page, select Disk or Partitions to create a sector-based backup of the whole disk 

system, or only separate partitions. 
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4. On the next page, mark the appropriate option opposite a hard disk’s name or a partition’s name depending on 

the chosen task. 

 

 

 

You’ve got the option to modify the default backup settings by marking the appropriate 

checkbox on this page. 

By default the program will take into account exclude filters set in the Settings dialog. 

 

5. On the Backup Destination page, select the Burn the data to CD or DVD option. 

 

6. Select a recordable device on the list of available CD/DVD devices and edit the archive name, if necessary. 
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Please take into account the Estimated archive size value. It can give you a hint about the 

number of CD/DVD discs required for the operation. 

 

7. Add comments to your backup describing its contents. 

 

8. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the 

Next button to start the backup process. 

 

 
This operation can also be accomplished with our recovery media. 

 

Backing up a hard disk or partition to a network drive 

To back up an entire hard disk or a separate partition and then place the resulted image to a network share, please do 

the following: 

1. Click the Smart Backup item of the Wizards menu. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

2. On the Wizard's Welcome page, click the Next button. 

3. On the What to back up page, select Disk or Partitions to create a sector-based backup of the whole disk 

system, or only separate partitions. 
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4. On the next page, mark the appropriate option opposite a hard disk’s name or a partition’s name depending on 

the chosen task. 

 

 

 

You’ve got the option to modify the default backup settings by marking the appropriate 

checkbox on this page. 

By default the program will take into account exclude filters set in the Settings dialog. 

 

5. On the Backup Destination page, select the Save data to local/network drives option. 

 

6. Map a network disk to place your backup image to: 

- Call the Map Network Drive dialog by clicking the appropriate button; 
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- Click the standard browse button [...] to browse for the required network share or manually enter a path to 

it; 

- Define a  letter from the pull-down list of available drive letters; 

- Mark the checkbox to make this connection permanent. Otherwise it will only be available for the current 

Windows session; 

- Click the Connect as user button at the foot of the dialog page to specify a user name and password to 

access the selected network share if necessary. 

7. Edit the archive name if necessary. 

 

 

 

Please take into account values of the parameters Estimated archive size and Space 

available on backup destination - if the archive size exceeds the available space, another 

network drive needs to be selected. 

 

8. Add comments to your backup describing its contents. 

 

9. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the 

Next button to start the backup process. 

 

 
This operation can also be accomplished with our recovery media. 
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Backing up files to an FTP/SFTP server 

With our program you can protect the entire system, separate partitions, or particular files by backing up directly to 

online storages located on FTP or SFTP servers. Please note however, that due to certain limitations of the network 

bandwidth, the use of FTP/SFTP locations for storing many GBs of data (OS together with all on-disk data) isn’t the best 

choice, but it’s great for personal data, like your documents, email databases, photos, etc. 

So let’s see how to back up all office documents of the My Documents folder to an SFTP server: 

1. Click the Smart Backup item of the Wizards menu. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

2. On the Wizard's Welcome page, click the Next button. 

3. On the What to back up page, select Documents to protect all office documents inside the My Documents 

folder. 

 

4. On the next page, choose FTP Servers as backup storage. 

 

5. Click on the Create an FPT Location button to set up parameters for the required SFTP location. 
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- Use SFTP connection. Mark the option to connect to the desired SFTP server; 

- Address. Type in its address; 

- Port. Specify the required port (22 by default); 

- Anonymous login. Mark the option to set up anonymous connection. Typical username for this type of login is 

“anonymous”; 

- Allow Open SSH key-based authentication. If your SFTP provider requires this type of authentication, mark the 

option to specify public and private keys and a passphrase; 

 

- Login. Enter a login; 

- Password. Enter a password. Click Remember password to save it next time you back up to this location; 

- Name. By default, the program uses the provided address as the connection name, which can be modified 

however. 

 

 

You need to check out yourself Windows Firewall or programs of this kind let our program 

work with the required port (21 for FTP and 22 for SFTP by default). 

 
6. When ready, click the Connect button to check out you’ve got access to the provided location. If yes, you’ll get a 

new item on the list named after this location. By clicking the + icon you can browse it to specify a more exact 
location for your backup. At this stage you can also edit the default archive name if necessary. 
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7. Add comments to your backup describing its contents. 

 

8. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the 

Next button to start the backup process. 

 

 
This operation can also be accomplished with our recovery media. 

 

Backing up a dual boot Mac to an external USB drive 

To back up a dual boot Mac (Mac OS X and Windows XP/Vista/7) and then place the resulted image to an external USB 

drive, please do the following: 

1. Start up the computer from our Linux/DOS recovery media. 

 

 

Recovery Media Builder can help you prepare our recovery environment either on a 

CD/DVD disc or a thumb drive. 

To automatically boot from the recovery media please make sure the on-board BIOS is set 

up to boot from CD/USB first. 

 

2. Connect an external USB drive to the computer. 

3. Restart the computer. It will be automatically started up into the Linux recovery environment (Normal Mode), 

since it’s the only mode that provides support for Mac computers. 

4. In the Linux launch menu select Hard Disk Manager. 

5. Launch the Backup Wizard by selecting in the Main Menu of the program: Wizards > Backup Wizard. 
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6. On the Wizard's Welcome page, click the Next button. 

7. On the What to back up page, select your Mac hard disk. 

 

8. On the Backup Destination page, select the Save data to any local drive or a network share option. 

 

9. Select an external USB drive as a backup destination. 
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10. Edit the archive name if necessary. 

 

 

 

Please take into account values of the parameters Estimated archive size and Space 

available on backup destination - if the archive size exceeds the available space, another 

drive needs to be selected. 

 

11. Add comments to your backup describing its contents. 

 

12. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the 

Next button to start the backup process. 

 

 
This operation can also be accomplished under Windows. 

 

Backing up files to a local mounted/unmounted (without drive letter assigned) partition 

To back up required files or folders and then place the resulted image to a local mounted/unmounted drive, please do 

the following: 

1. Click the Smart Backup item of the Wizards menu. 
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There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

2. On the Wizard's Welcome page, click the Next button. 

3. On the What to back up page, first take a look at the ready-made backup templates. If none of the options 

meets you needs (just our case), then select Other Files and Folders to create a file-based backup of certain 

data. 

 

4. On the What folders and files to back up page you can see a list of all partitions (both mounted and unmounted) 

available in the system. Mark a checkbox opposite a file, folder or even a whole partition to build up contents of 

the future backup image. 

 

5. On the Backup Destination page, select a local mounted/unmounted (without drive letter assigned) disk as a 

backup destination. 
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6. Edit the archive name if necessary. 

 

7. Specify include masks. The program includes a lot of ready-made filters to effectively control contents of your 

backup images. 

 

You can also create your own filter by clicking the Add category… button.  

 

 Name. Give to the filter any name you like, but try to use an informative one; 

 Filter. Press the Browse button to select files or folders you would like to be included or specify a filter 

mask by using * or ? wildcards; 

 Description. Add a short description to the filter not to miss it up later. 
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Click the OK button and you will get a new item on the list of filters. By marking/unmarking a checkbox opposite 

its name you can choose whether to use it or not. 

 

 

By setting an include mask, you automatically ignore files that do not match to it, thus they 

won’t be added to the backup image. 

 

8. Specify exclude masks. The program includes a lot of ready-made filters to effectively control contents of your 

backup images. 

 

9. Add comments to your backup describing its contents. 

 

10. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the 

Next button to start the backup process. 

 

 
This operation can also be accomplished with our recovery media. 

 

Creating a differential to a full partition backup 

To update an image of the selected partition, please do the following: 

1. Click the Differential Partition Backup item of the Wizards menu. 

2. On the Wizard's Welcome page, click the Next button. 

3. On the Browse for Archive page, specify the required full (base) partition archive: 

 By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive 

Database (if any). 
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To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. 

Archive File Details) display a short description. 

 

 
To know more on the subject, please consult the Viewing Image Properties chapter. 

 

 By clicking the Switch to File View link, you can find the required image in the browser-like window. The 

section below (i.e. Archive File Details) will also display a short description of the selected image. 

 

 

 
To know more on the subject, please consult the Viewing Image Properties chapter. 

 

4. The Archive Content page displays detailed information about the contents of the archive. It includes a full 

description of properties about the partition. In addition, there is the possibility to modify backup settings. To 

activate the advance mode, you need to mark the appropriate option at the foot of the page. 
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5. On the Backup Destination page, select where you want to place your backup image. 

 

6. Edit the archive name if necessary. 

 

 

 

Please take into account values of the parameters Estimated archive size and Space 

available on backup destination - if the archive size exceeds the available space, another 

drive needs to be selected. 

 

7. Add comments to your backup describing its contents; 

 

8. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the 

Next button to start the backup process. 

After the operation is completed you receive a differential backup of the selected partition. It is placed into the specified 

destination (a local or network disk, the Backup Capsule or a CD/DVD disc), its features defined by the wizard. 
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This operation can also be accomplished with our recovery media. 

 

Creating an increment to a full partition backup 

To update only files you need since the last full partition backup, please do the following: 

1. Click the Create File Complement item of the Wizards menu. 

2. On the Wizard's Welcome page, click the Next button. 

3. On the Browse for Archive page, specify the required full (base) partition archive: 

 By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive 

Database (if any). 

 

To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. 

Archive File Details) display a short description. 

 

 
To know more on the subject, please consult the Viewing Image Properties chapter. 

 

 By clicking the Switch to File View link, you can find the required image in the browser-like window. The 

section below (i.e. Archive File Details) will also display a short description of the selected image. 
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To know more on the subject, please consult the Viewing Image Properties chapter. 

 

4. On the What folders and files to back up page you can see contents of the selected partition archive. Mark a 

checkbox opposite a file or folder to build up contents of the future incremental image. 

 

5. Specify include masks. The program includes a lot of ready-made filters to effectively control contents of your 

backup images. 
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You can also create your own filter by clicking the Add category… button.  

 

 Name. Give to the filter any name you like, but try to use an informative one; 

 Filter. Press the Browse button to select files or folders you would like to be included or specify a filter mask 

by using * or ? wildcards; 

 Description. Add a short description to the filter not to miss it up later. 

Click the OK button and you will get a new item on the list of filters. By marking/unmarking a checkbox opposite 

its name you can choose whether to use it or not. 

 

 

By setting an include mask, you automatically ignore files that do not match to it, thus they 

won’t be added to the backup image. 

 

6. Specify exclude masks. The program includes a lot of ready-made filters to effectively control contents of your 

backup images. 
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7. Add comments to your backup describing its contents. 

 

8. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the 

Next button to start the backup process. 

After the operation is completed you receive an incremental backup of the selected partition archive containing 

information specified in the wizard. It is placed into the same destination as the base image. 

 

 
This operation can also be accomplished with our recovery media. 

 

Creating an increment to a full file backup 

To update a file backup, please do the following: 

1. Click the Incremental File Backup item of the Wizards menu. 

2. On the Wizard's Welcome page, click the Next button. 

3. On the Browse for Archive page, specify the required full (base) file archive: 

 By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive 

Database (if any). 
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To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. 

Archive File Details) display a short description. 

 

 
To know more on the subject, please consult the Viewing Image Properties chapter. 

 

 By clicking the Switch to File View link, you can find the required image in the browser-like window. The 

section below (i.e. Archive File Details) will also display a short description of the selected image. 

 

 

 
To know more on the subject, please consult the Viewing Image Properties chapter. 

 

After the operation is completed you receive an incremental backup of the selected file archive. It is placed into the 

same destination as the base image. 

 

 
This operation can also be accomplished with our recovery media. 
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Creating a cyclic partition backup 

To automate the partition backup process, please do the following: 

1. Select in the Main Menu: Wizards > Backup Utilities > Cyclic Backup... 

2. On the Wizard's Welcome page, click the Next button; 

3. On the What to back up page, select a partition you want to make a cyclic backup of; 

 

 

 

The current version of the program enables to make a cyclic backup of only one partition at 

a time. 

 
4. On the Backup Destination page, select a mounted/unmounted partition, a network share, or an FTP server to 

place backup images to. 

 

5. Edit the archive name if necessary. 
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Please take into account values of the parameters Estimated archive size and Space 

available on backup destination - if the archive size exceeds the available space, another 

drive needs to be selected. 

 
6. Add comments to your backup describing its contents. 

 

7. Set a timetable for the operation.  

 

 

 
To know more on the subject, please consult the Task Scheduling chapter. 

 
8. On the Cyclic backup type page, choose the way of creating a cyclic backup: 
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 Base type. Every image created during the operation will be made as a full archive. 

 Differential type. Every first image will be made as a full (base) archive and all the others will be 

differentiated from it. This operation requires much less space, thus considerably saving your system 

resources.  

By setting the Maximum disk space to store images and the Maximum number of images to store parameters 

you may define when the operation will be cycled. That means that on exceeding these two parameters the 

oldest archives will be automatically overwritten (if choosing the Differential type only differential images will 

be overwritten). 

 

9. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the 

Next button to start the backup process. 

The operation will run according to the set timetable. The resulted backup images will be placed into the specified 

destination (a local or a network disk), its features defined by the wizard. 

Merging a full partition backup with one of its differentials 

To merge a full partition backup with one of its differentials, thus getting a new full partition archive, please do the 

following: 

1. Click the Synthetic Backup item of the Wizards menu. 

2. On the Wizard's Welcome page, click the Next button. 

3. On the Browse for Archive page, you only need to specify the required differential archive. The program then 

will automatically find its base image: 

 By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive 

Database (if any). 

 

To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. 

Archive File Details) display a short description. 
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To know more on the subject, please consult the Viewing Image Properties chapter. 

 

 By clicking the Switch to File View link, you can find the required image in the browser-like window. The 

section below (i.e. Archive File Details) will also display a short description of the selected image. 

 

 

 
To know more on the subject, please consult the Viewing Image Properties chapter. 

 
4. On the Synthesis Settings page you can additionally modify any property of the selected backup image if 

necessary. To accomplish our task we have no need to change anything at all. 

 

5. On the Synthetic Archive Destination page, select where you want to place the resulted backup image. 
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6. Edit the archive name if necessary. 

 

 

 

Please take into account values of the parameters Estimated archive size and Space 

available on backup destination - if the archive size exceeds the available space, another 

drive needs to be selected. 

 
7. Add comments to your backup describing its contents; 

 

8. On the Synthesis Summary page review all parameters of the operation and modify them if necessary. Click the 

Next button to start the backup process. 

 

After the operation is completed you receive a new full partition archive. It is placed into the specified destination (a 

local or network disk, or a CD/DVD disc), its features defined by the wizard. 

 

This function is currently unavailable for modification of entire hard disk backups. 

This operation can also be accomplished with our recovery media. 
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Recovery Scenarios 

Fixing MBR after a boot virus attack 

Let’s assume that the MBR (Master Boot Record) of your hard disk has been corrupted as a result of a boot virus attack, 

thus your system fails to boot. 

To fix the MBR of your hard disk, please do the following: 

1. Start up the computer from our Linux/DOS recovery media. 

 

 

Recovery Media Builder can help you prepare our recovery environment either on a 

CD/DVD disc or a thumb drive. 

To automatically boot from the recovery media please make sure the on-board BIOS is set 

up to boot from CD/USB first. 

 

2. In the boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode 

to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the 

option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware 

incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and 

keyboard drivers. This mode has simple graphics and a simple menu. 

 

 
By default the Normal Mode will be automatically initiated after a 10 second idle period. 

 

3. In the Linux launch menu select Boot Corrector. You can find it in PTS DOS as well. 

4. On the Wizard's Welcome page, select the Correct the Master Boot Record (MBR) option. 

 

5. On the next page choose the required hard disk from the pull-down list (if several) and then select the Update 

the MBR executable code option. 
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6. Confirm the operation. 

 

7. After the operation is completed click the Report button to see a well informative summary page. The program 

also enables to store the resulted report. To do that, just press the Save button and choose the exact location in 

the opened dialog. 

 

8. Click the Finish button to close Boot Corrector. 

9. Reboot the computer. 

Correcting BCD (Boot Configuration Data) 

To automatically correct Windows BCD, please do the following: 

1. Start up the computer from our WinPE recovery media. 

 

 

Recovery Media Builder can help you prepare our recovery environment either on a 

CD/DVD disc or a thumb drive. 

To automatically boot from the recovery media please make sure the on-board BIOS is set 

up to boot from CD/USB first. 

 

2. Launch Boot Corrector. 

3. On the Wizard's Welcome page, click the Next button. 

4. Select Correct boot parameters… to let the wizard fix BCD in all found Windows installations. 
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5. The wizard will ask you to confirm the operation. Apply the changes to complete. 

 

After completing the operation close the wizard, and then reboot the computer. 

Fixing Windows startup ability 

Let’s assume that due to an unknown reason your Windows fails to complete the startup procedure. At first everything 

seems quite OK, you can see the standard startup messages on the screen, but at some moment it hangs up. 

To fix your Windows startup ability, please do the following: 

1. Start up the computer from our Linux/DOS recovery media. 

 

 

Recovery Media Builder can help you prepare our recovery environment either on a 

CD/DVD disc or a thumb drive. 

To automatically boot from the recovery media please make sure the on-board BIOS is set 

up to boot from CD/USB first. 

 

2. In the boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode 

to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the 

option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware 

incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and 

keyboard drivers. This mode has simple graphics and a simple menu. 

 

 
By default the Normal Mode will be automatically initiated after a 10 second idle period. 

3. In the Linux launch menu select Boot Corrector. You can find it in PTS DOS as well. 

4. On the Wizard's Welcome page, select the Search for Windows installations to correct option. 
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5. On the next page choose the required Windows installation from the list of found installations (if several), then 

select the Edit the Boot.ini file option. If you’re not sure which installation you need, please use the Properties 

button to get more info on the selected item. 

 

6. Examine the file – maybe that’s where the problem is. If it contains a mistake, correct it by using the appropriate 

buttons. 

 

7. If the Boot.ini file does not contain any mistake, please return to the Correct Windows Installations page to 

correct drive letters in the Windows System Registry. 
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8. On the next page choose a hard disk from the pull-down list (if several), then the required partition. If you’re not 

sure which installation you need, please use the Properties button to get more info on the selected item. 

 

9. Click the Edit Letters button to correct an existing drive letter or assign a new one in the Windows System 

Registry. 

 

10. Once you’ve assigned the appropriate drive letter, close the dialog, then click the Apply button. 

11. Confirm the operation. 
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12. After the operation is completed click the Report button to see a well informative summary page. The program 

also enables to store the resulted report. To do that, just press the Save button and choose the exact location in 

the opened dialog. 

 

13. Click the Finish button to close Boot Corrector. 

14. Reboot the computer. 

Restoring a hard disk from the bootable Backup Capsule 

Let’s assume that your computer fails to boot because of a virus attack or corruption of some system critical files. But 

you’ve got the bootable backup capsule containing a backup of your hard disk. That’s just enough to easily get your 

system back on track again. 

To restore your hard disk from a backup image contained in the backup capsule when the current OS is down, please do 

the following: 

1. Start up the computer from the bootable backup capsule. By default, the program offers to use the F1 hot key to 

boot from it. 

 

 
This scenario implies that the backup capsule is bootable. 

 

2. In the boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode 

to use the PTS DOS recovery environment (in case you’ve got problems with Linux). 

 

 
By default the Normal Mode will be automatically initiated after a 10 second idle period. 

 

3. In the Linux launch menu select the Simple Restore Wizard. You can find the same wizard in PTS DOS as well. 

4. On the Wizard's Welcome page, click the Next button. 
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5. On the What to Restore page, you can see a list of available images (if several). Most likely the required archive 

will be there too. If not, click the standard browse button [...] to find it. When you find your image, double click 

on it to proceed. 

 

6. On the Image Properties page, make sure that you select the correct image by viewing the provided information 

about the archive. 

 

7. On the next page specify a hard disk to restore the image to (if several in your computer). By default, the 

program offers to restore the archive exactly where it belongs. That’s what we actually need. 

 

You can also make the program resize the on-disk partitions proportionally if necessary by marking the 

appropriate checkbox. 

 

 

All contents on the disk selected for restoring purposes will be deleted during the 

operation. 
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8. On the Restore Summary page you can see your hard disk layout before and after the operation. Click the Next 

button to initiate the restore process. 

 

9. In the Progress window you can see in real-time a detailed report on all actions carried out by the program. 

 

10. After completing the operation close the wizard and reboot the computer. 

 

 

To make Windows bootable on different hardware, please additionally complete the P2P 

Adjust OS Wizard. 

 

Restoring a system partition from external media (CD/DVD) 

Let’s assume that your computer fails to boot because of a virus attack or corruption of some system critical files. But 

you’ve got a backup of your system partition on a bootable DVD disc. That’s just enough to easily get your system back 

on track again. 

To restore your system partition from a backup image located on CD/DVD when the current OS is down, please do the 

following: 

1. Insert a CD/DVD disc containing the previously prepared backup image into a CD/DVD drive (the BIOS must be 

enabled to boot the system from the CD/DVD device). 

 

 

This scenario implies that you have got a bootable archive on your CD/DVD. 

In case the backup image is stored on several CD/DVD disks, please insert the first one. 

 

2. Restart the computer. 



166 

Copyright© 1994-2011 Paragon Software Group. All rights reserved. 

3. In the boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode 

to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the 

option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware 

incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and 

keyboard drivers. This mode has simple graphics and a simple menu. 

 

 
By default the Normal Mode will be automatically initiated after a 10 second idle period. 

 

4. In the PTS DOS launch menu select the Simple Restore Wizard. You can find the same wizard in Linux as well. 

5. On the Wizard's Welcome page, click the Next button. 

6. On the What to Restore page, you can see a list of available images (if several). Most likely the required archive 

will be there too. If not, click the standard browse button [...] to find it. When you find your image, double click 

on it to proceed. 

 

7. On the Image Properties page, make sure that you select the correct image by viewing the provided information 

about the archive. 

 

8. On the next page specify a hard disk, then one of its partitions to restore the image to (if several in your 

computer). By default, the program offers to restore the archive exactly where it belongs. That’s what we 

actually need. 
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All contents on the partition selected for restoring purposes will be deleted during the 

operation. 

 

9. On the Partition Start and Size page you can change size of the partition and its location if necessary. 

 

10. On the Restore Summary page you can see your hard disk layout before and after the operation. Click the Next 

button to initiate the restore process. 

 

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program. 
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12. After completing the operation close the wizard, and then reboot the computer. 

 

 

To make Windows bootable on different hardware, please additionally complete the P2P 

Adjust OS Wizard. 

 

Restoring a system partition from a network drive 

Let’s assume that your computer fails to boot because of a virus attack or corruption of some system critical files. But 

you’ve got a backup of your hard disk on a remote backup server. That’s just enough to easily get your system back on 

track again. 

To restore your system partition from a backup image located on a network drive, please do the following: 

1. Start up the computer from our WinPE recovery media. 

 

 

Recovery Media Builder can help you prepare our recovery environment either on a 

CD/DVD disc or a thumb drive. 

To automatically boot from the recovery media please make sure the on-board BIOS is set 

up to boot from CD/USB first. 

 

2. Once you accept the agreement, you will see the Universal Application Launcher. Select the Restore Wizard. 

3. On the Restore Wizard's Welcome page, click the Next button. 

4. On the Browse for Archive page you need to specify the required backup image. So you should take the 

following steps to do that: 

 Select Network as a backup destination; 
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 Map a network disk where your archives are placed: 

- Call the Map Network Drive dialog by clicking the appropriate button; 

 

- Click the standard browse button [...] to browse for the required network share or manually enter a path 

to it; 

- Define a letter from the pull-down list of available drive letters; 

- Click the Connect as user button at the foot of the dialog page to specify a user name and password to 

access the selected network share if necessary. 

 

 
You can also map a network disk with Network Configurator. 

 

 Choose the required archive in the browser-like window. The Archive File Details section displays a short 

description of the selected image. 
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5. The What to Restore page displays detailed information about the contents of the archive. Select the required 

item to restore. In our case it is the first partition of the disk. 

 

6. On the Where to Restore page specify a hard disk, then one of its partitions to restore the image to (if several in 

your computer). By default, the program offers to restore the archive exactly where it belongs. That’s what we 

actually need. 

 

 

 

All contents on the partition selected for restoring purposes will be deleted during the 

operation. 
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7. On the Restore Results page you can see the resulted disk layout. Besides there’s the possibility to change size 

of the partition and its location if necessary as well as assign a particular drive letter. 

 

8. On the next page of the wizard confirm the operation by selecting the appropriate option. 

 

9. In the Progress window you can see in real-time a detailed report on all actions carried out by the program. 

Mark the checkbox at the bottom of the window to automatically switch off the computer on the successful 

accomplishment of the restore operation. 

10. After completing the operation close the wizard, and then reboot the computer. 

 

 

To make Windows bootable on different hardware, please additionally complete the P2P 

Adjust OS Wizard. 

 

Restoring a system partition from a local drive 

Let’s assume that your operating system gives trouble after having installed brand new software. But you’ve got a 

backup of the system partition on a local disk. That’s just enough to easily roll it back to the point when run smoothly. 

To restore your system partition from a backup image located on a local disk, please do the following: 

1. Click the Restore item of the Wizards menu. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

2. On the Restore Wizard's Welcome page, click the Next button. 

3. On the Browse for Archive page, specify the required archive: 

 By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive 

Database (if any). 
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To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. 

Archive File Details) display a short description. 

 

 
To know more on the subject, please consult the Viewing Image Properties chapter. 

 

 By clicking the Switch to File View link, you can find the required image in the browser-like window. The 

section below (i.e. Archive File Details) will also display a short description of the selected image. 

 

 

 
To know more on the subject, please consult the Viewing Image Properties chapter. 
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4. On the Where to Restore page specify a hard disk, then one of its partitions to restore the image to (if several in 

your computer). By default, the program offers to restore the archive exactly where it belongs. That’s what we 

actually need. 

 

 

 

All contents on the partition selected for restoring purposes will be deleted during the 

operation. 

 

5. On the Restore Results page you can see the resulted disk layout. Besides there’s the possibility to change size 

of the partition and its location if necessary as well as assign a particular drive letter. 

 

6. Complete the wizard and then apply the pending changes. 

 

7. The program will require the system restart to accomplish the operation in a special boot-up mode. Click the 

appropriate button to agree. 
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8. In the Progress window you can see in real-time a detailed report on all actions carried out by the program. 

After completing the operation the program will automatically reboot the computer. 

 

  

This operation can also be accomplished with our recovery media. 

To make Windows bootable on different hardware, please additionally complete the P2P 

Adjust OS Wizard. 

 

Restoring a dual boot Mac from an external USB drive 

Let’s assume that your Mac fails to boot because of a hard disk malfunction. But you’ve got a backup of your hard disk 

on an external USB drive. Just replace the failed disk with a new one and carry out a bare metal restore. 

To restore a dual boot Mac from a backup image located on an external USB drive, please do the following: 

1. Start up the computer from our Linux/DOS recovery media. 

 

 

Recovery Media Builder can help you prepare our recovery environment either on a 

CD/DVD disc or a thumb drive. 

To automatically boot from the recovery media please make sure the on-board BIOS is set 

up to boot from CD/USB first. 

 

2. Connect an external USB drive to the computer. 

3. Restart the computer. 

4. In the boot menu select Normal Mode to use the Linux recovery environment, since it’s the only mode that 

enables to work with USB devices. 

 

 
By default the Normal Mode will be automatically initiated after a 10 second idle period. 
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5. In the Linux launch menu select the Simple Restore Wizard. 

6. On the Wizard's Welcome page, click the Next button. 

7. On the What to Restore page, click the standard browse button [...] to find the required archive. When done, 

double click on it to select. 

 

8. On the Image Properties page, make sure that you select the correct image by viewing the provided information 

about the archive. 

 

9. On the next page specify a hard disk to restore the image to. 
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All contents on disk selected for restoring purposes will be deleted during the operation. 

 

10. On the Restore Summary page you can see your hard disk layout before and after the operation. Click the Next 

button to initiate the restore process. 

 

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program. 

 

12. After completing the operation close the wizard, and then reboot the computer. 

Restoring a file increment 

Let’s assume that you’re busy with developing some project and you make file increments of it on a day-to-day basis not 

to lose valuable information. So you’ve got a file backup chain. One day you understand that the job of the last three 

days is a complete and utter failure. Don’t give up – recover your project to the state when everything’s ok. 

To restore a file increment, please do the following: 

1. Click the Restore item of the Wizards menu. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

2. On the Restore Wizard's Welcome page, click the Next button. 
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3. On the Browse for Archive page, specify the required file increment: 

 By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive 

Database (if any). 

 

To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. 

Archive File Details) display a short description. 

 

 
To know more on the subject, please consult the Viewing Image Properties chapter. 

 

 By clicking the Switch to File View link, you can find the required image in the browser-like window. The 

section below (i.e. Archive File Details) will also display a short description of the selected image. 
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To know more on the subject, please consult the Viewing Image Properties chapter. 

 

4. On the How to Restore page specify the way your archive will be restored. In our case we’d rather restore 

contents of the backup to its original location with replacing existing files as well. 

 

5. Complete the wizard and then apply the pending changes. 

 

6. In the Progress window you can see in real-time a detailed report on all actions carried out by the program. 

 

 
This operation can also be accomplished with our recovery media. 

 

Restoring a file increment to a partition backup 

Let’s assume that your operating system gives trouble because of a virus attack. But you’ve got a backup of your system 

partition on a local disk. Besides you make file increments of your documents and e-mail database to that backup on a 

regular basis. That’s just enough to easily roll everything back to the point when run smoothly. 

To restore your system partition with a file increment from a backup image located on a local disk, please do the 

following: 

1. Click the Restore item of the Wizards menu. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

2. On the Restore Wizard's Welcome page, click the Next button. 

3. On the Browse for Archive page, specify the required file increment archive to your system partition backup: 

 By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive 

Database (if any). 
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To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. 

Archive File Details) display a short description. 

 

 
To know more on the subject, please consult the Viewing Image Properties chapter. 

 

 By clicking the Switch to File View link, you can find the required image in the browser-like window. The 

section below (i.e. Archive File Details) will also display a short description of the selected image. 

 

 

 
To know more on the subject, please consult the Viewing Image Properties chapter. 
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4. On the How to Restore File Complement page select whether you want to restore both, the partition archive 

and the desired file increment or just the file increment. In our case we choose the first option. 

 

5. On the Where to Restore page specify a hard disk, then one of its partitions to restore the image to (if several in 

your computer). By default, the program offers to restore the archive exactly where it belongs. That’s what we 

actually need. 

 

 

 

All contents on the partition selected for restoring purposes will be deleted during the 

operation. 

 

6. On the Restore Results page you can see the resulted disk layout. Besides there’s the possibility to change size 

of the partition and its location if necessary as well as assign a particular drive letter. 

 

7. Complete the wizard and then apply the pending changes. 

 

8. The program will require the system restart to accomplish the operation in a special boot-up mode. Click the 

appropriate button to agree. 
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9. In the Progress window you can see in real-time a detailed report on all actions carried out by the program. 

After completing the operation the program will automatically reboot the computer. 

 

  
This operation can also be accomplished with our recovery media. 

 

Copying of data from the corrupted system disk to another hard disk 

To retrieve valuable information from your hard disk and copy it to another hard disk when the system fails to boot, 

please do the following: 

1. Connect the second hard disk to the computer. 

2. Start up the computer from our Linux/DOS recovery media. 

 

 

Recovery Media Builder can help you prepare our recovery environment either on a 

CD/DVD disc or a thumb drive. 

To automatically boot from the recovery media please make sure the on-board BIOS is set 

up to boot from CD/USB first. 

 

3. In the boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode 

to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the 

option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware 

incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and 

keyboard drivers. This mode has simple graphics and a simple menu. 

 

 
By default the Normal Mode will be automatically initiated after a 10 second idle period. 
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4. In the Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well. 

5. On the Wizard's Welcome page, click the Next button. 

6. Select a disk where the files you need are stored from the pull-down list in the right pane of the page. 

 

7. Select files you want to copy and place them to Clipboard by pressing the left arrow-button. 

 

Click the Calc button to estimate the resulted data size. 

8. On the Select Destination Type, choose the way the data will be stored. Select the Save data to any local drive 

or a network share item. 

 

9. On the Select Destination Path page, select a hard disk to copy the data to by pressing the standard browse 

button [...]. 
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10. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the 

operation. 

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program. 

 

12. After the operation is completed, close the wizard by pressing the appropriate button. 

13. Turn off the computer. 

 

 
This operation can also be accomplished with our recovery media. 

 

Burning of data from the corrupted system disk to CD/DVD 

To retrieve valuable information from your hard disk and burn it to CD/DVD when the system fails to boot, please do the 

following: 

1. Start up the computer from our Linux/DOS recovery media. 

 

 

Recovery Media Builder can help you prepare our recovery environment either on a 

CD/DVD disc or a thumb drive. 

To automatically boot from the recovery media please make sure the on-board BIOS is set 

up to boot from CD/USB first. 

 

2. In the boot menu select Normal Mode to use the Linux recovery environment, since it’s the only mode that 

enables to burn CD/DVD discs. 

 

 
By default the Normal Mode will be automatically initiated after a 10 second idle period. 
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3. In the Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well. 

4. On the Wizard's Welcome page, click the Next button. 

5. Select a disk where the files you need are stored from the pull-down list in the right pane of the page. 

 

6. Select files you want to copy and place them to Clipboard by pressing the left arrow-button. 

 

Click the Calc button to estimate the resulted data size. 

7. On the Select Destination Type, choose the way the data will be stored. Select the Burn data to CD/DVD item. 

 

8. On the Choose a Recorder page, select a recorder from the list of available devices and then set a volume label 

by entering it in the appropriate field. 
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9. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the 

operation. 

10. In the Progress window you can see in real-time a detailed report on all actions carried out by the program. 

 

11. After the operation is completed, close the wizard by pressing the appropriate button. 

12. Turn off the computer. 

 

 
This operation can also be accomplished with our recovery media. 

 

Copying of data from a backup to the corrupted system partition 

The system fails to boot since some files are damaged. If you have a backup of the system partition, you can recopy 

these files to make the system be operable again: 

1. Start up the computer from our Linux/DOS recovery media. 

 

 

Recovery Media Builder can help you prepare our recovery environment either on a 

CD/DVD disc or a thumb drive. 

To automatically boot from the recovery media please make sure the on-board BIOS is set 

up to boot from CD/USB first. 

 

2. In the boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode 

to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the 

option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware 
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incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and 

keyboard drivers. This mode has simple graphics and a simple menu. 

 

 
By default the Normal Mode will be automatically initiated after a 10 second idle period. 

 

3. In the Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well. 

4. On the Wizard's Welcome page, click the Next button. 

5. Select a disk where the system backup is stored from the pull-down list in the right pane of the page. 

 

6. Double click on the required backup to open. 

 

7. Select files you want to copy and place them to Clipboard by pressing the left arrow-button. 
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Click the Calc button to estimate the resulted data size. 

8. On the Select Destination Type, choose the way the data will be stored. Select the Save data to any local drive 

or a network share item. 

 

9. On the Select Destination Path page, select your system disk to copy the data to by pressing the standard 

browse button [...]. 

 

10. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the 

operation. 

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program. 

 

12. After the operation is completed, close the wizard by pressing the appropriate button. 

13. Turn off the computer. 
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This operation can also be accomplished with our recovery media. 

 

Restoring separate files and folders from a backup 

The program provides a very convenient option to access backup archives and restore only data you need (the so called 

selective restore functionality). 

Restore Wizard 

To restore separate files and folders from a backup image with the Restore Wizard, please do the following: 

1. Start up the computer from our WinPE recovery media. 

 

 

Recovery Media Builder can help you prepare our recovery environment either on a 

CD/DVD disc or a thumb drive. 

To automatically boot from the recovery media please make sure the on-board BIOS is set 

up to boot from CD/USB first. 

 

2. Once you accept the agreement, you will see the Universal Application Launcher. Select the Restore Wizard. 

3. On the Restore Wizard's Welcome page, click the Next button. 

4. On the Browse for Archive page choose the required archive in the browser-like window. The Archive File 

Details section displays a short description of the selected image. 

 

5. On the next page specify what you need to extract from the backup by marking checkboxes next to the required 

data items. At the right lower corner of the window you can see the resulted amount of the selected data. 
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6. On the How to Restore page specify the way the selected data will be restored. In our case we’d rather restore 

contents of the backup to its original location with replacing existing files as well. 

 

7. On the Restore Summary page review all parameters of the operation and modify them if necessary. 

 

8. On the next page of the wizard confirm the operation by selecting the appropriate option. 

 

9. In the Progress window you can see in real-time a detailed report on all actions carried out by the program. 

10. After completing the operation close the wizard, and then reboot the computer. 

 

 
This operation can also be accomplished under Windows. 
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File Transfer Wizard 

To restore separate files and folders from a backup image with the File Transfer Wizard, please do the following: 

1. Call the popup menu for the required backup image (right click of the mouse button) in the Archive Database 

and then select the menu item: Restore File from Archive. Thus you automatically open it with the File Transfer 

Wizard. 

 

2. Select files you want to copy and place them to Clipboard by pressing the left arrow-button. 

 

3. On the Select Destination Type, choose the way the data will be stored. Select the Save data to any local drive 

or a network share item. 

 

4. On the Select Destination Path page, specify the exact place to copy the data to. 
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5. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the 

operation. 

 

6. After the operation is completed, close the wizard by pressing the appropriate button. 

Volume Explorer 

To restore separate files and folders from a backup image with Volume Explorer, please do the following: 

1. Click the Disk View tab and then choose Volume Explorer; 

 

2. Browse for the required archive and then open it by double click of the left mouse button. 

 

3. Call the popup menu (right click of the mouse button) for a file/folder you need and then select the Export item. 
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4. Select a place on the disk where the file/folder will be extracted to. 

 

5. Click the OK button to accomplish the operation. 

 

 

The current version of the program does not enable to access file archives with Volume 

Explorer. 

 

Resize Scenarios 

Creating a new partition to detach operating system from the rest of data 

Let’s assume that you’re a rank and file user who is most likely to have only one hard disk with only one partition (the 

only partition is always system). To secure yourself against a system malfunction or a virus attack you’ve got nothing to 

do, but make a backup of the whole partition, which besides the operating system itself contains all your family photos, 

favorite films and music, program distributives, whatever. As a result you’ll get a very huge backup image. You can easily 

tackle this issue however by detaching your operating system from the rest of data. 

To create a new partition on your hard disk, please do the following: 

1. Click the Express Create Partition item of the Wizards menu. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 
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2. On the Wizard's Welcome page, click the Next button. 

3. Choose a method you find the most suitable to create the partition. The wizard is especially designed to 

minimize your participation in finding an appropriate place for it and its resulted size. The only thing you’re to 

do is to choose between several modes. The most relevant thing here is the amount of space that will be 

allocated for that partition. For easy perception, you can see the resulted disk layout on the disk map by 

selecting this or that mode. 

 

 

  

The number of available methods depends on your disk layout. 

To learn more on the way the wizard works, please click the corresponding link on the first 

page of the wizard. 

 

4. That’s basically it. By clicking the Next button the wizard will start modifying your disk layout. If you’ve got to do 

with the system partition resize, like we do in our case, you will be asked to restart your computer in a special 

boot-up mode to accomplish the operation. So click the appropriate button to agree. 
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5. In the Progress window you can see in real-time a detailed report on all actions carried out at the moment. 

After completing the operation your computer will be automatically restarted back to Windows where you can see the 

newly created NTFS partition. Now you’ve got a place to keep your stuff apart from Windows. 

Increasing size of a system partition by taking unused space of an adjacent partition 

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming 

applications and system updates your system partition has started to suffer from the lack of free space. But an adjacent 

partition has a plenty of redundant space. That’s just enough to make your system partition suffer no more. 

To increase size of a system partition by taking unused space from an adjacent partition, please do the following: 

1. Click the Express Resize Partitions item of the Wizards menu. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

2. On the Wizard's Welcome page, click the Next button. 

3. Click on your system partition. By doing that, the wizard will automatically select an adjacent partition as well. 

This partition will later act as a space donor. 
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If you’ve got more than two partitions on your hard disk and a partition you need to 

increase is surrounded by other partitions, you’ve got the choice to choose which partition 

will act as a space donor. Just click on the left partition of the pair, as the right one will be 

selected automatically. 

 

4. Increase size of the system partition with the slider or manually by entering the required value. Please note, 

when you change size of one partition the size of the other will be changed as well, thus redistributing the 

unused space between the partitions. 

 

5. On the next page of the wizard you need to confirm the operation by selecting the appropriate option. 

 

6. That’s basically it. By clicking the Next button the wizard will start modifying your disk layout. If you’ve got to do 

with the system partition resize, like we do in our case, you will be asked to restart your computer in a special 

boot-up mode to accomplish the operation. So click the appropriate button to agree. 
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7. In the Progress window you can see in real-time a detailed report on all actions carried out at the moment. 

After completing the operation your computer will be automatically restarted back to Windows where you can see that 

your system partition is bigger now. 

Increasing size of a system partition by taking unused space from any other 

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming 

applications and system updates your system partition has started to suffer from the lack of free space. But one of your 

partitions has a plenty of redundant space. That’s just enough to make your system partition suffer no more. 

To increase size of a system partition by taking unused space from any other on-disk partition, please do the following: 

1. Click Switch to Full Scale Launcher in the Express Launcher. 

2. In the main window select the required hard disk (if several) on the Disk Map. 

 

3. Choose a space donor partition and then call the context menu for it (right click of the mouse button) to launch 

the Move/Resize dialog. 
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4. In the opened dialog shift the edge of the partition to the right by the drag-and-drop technique. While doing 

this, free space from the partition will be released (displayed in aqua-green). You can also do it manually by 

entering the exact size of free space. Click the Yes button to continue. 

 

5. Now you’ve got a block of free space to add to the system partition. You cannot do it directly however, but by 

carrying out a number of extra move/resize operations. 

 

6. Since the block of free space is within the extended partition, you need to take it out first. The program enables 

to resize the extended partition only when there’s a block of free space adjoining its borders. In our case it’s 

between two logical disks. So we need to move it. To do that, please select the first logical partition and then 

call the context menu for it (right click of the mouse button) to launch the Move/Resize dialog. 
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7. At first shift the right edge of the partition to the right, then do the same with the left edge. Make sure the 

partition size has been left unchanged. 

 

8. Now you can resize the extended partition to take the block of free space out of it. Call the context menu for it 

(right click of the mouse button) to launch the Move/Resize dialog. 

 

 
Call a context menu for the extended partition (with the blue border), not the logical one. 

 

9. In the opened dialog shift the edge of the extended partition to the right. 
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10. The block of free space has been released. 

 

11. Now you need to move the second primary partition just the way we did it with the logical partition to make the 

block of free space adjoin the system partition. 

 

12. Finally increase size of the system partition. Call the context menu for it (right click of the mouse button) to 

launch the Move/Resize dialog. 

13. In the opened dialog shift the edge of the partition to the right, thus increasing its size. 

 

14. Apply all introduced changes. By default, our program works in the virtual mode of execution, so you have to 

confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual 

Operations Bar. 
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15. The program will require the system restart to accomplish the operation in a special boot-up mode. Click the 

appropriate button to agree. 

Increasing size of a system partition by taking unused space of an adjacent logical partition 

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming 

applications and system updates your system partition has started to suffer from the lack of free space. But an adjacent 

logical partition has a plenty of redundant space. That’s just enough to make your system partition suffer no more. 

To increase size of a system partition by taking unused space from an adjacent partition, please do the following: 

1. Click the Redistribute Free Space item of the Wizards menu. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

2. On the Wizard's Welcome page, click the Next button. 

3. Select a volume you want to expand, i.e. the system one. 

 

4. Select a volume to take the space from, i.e. the logical one. 

 

5. On the next page of the wizard you can specify size of the resulted system volume. Drag the slider or type in the 

exact value to set the volume size. 
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6. Apply all introduced changes. By default, our program works in the virtual mode of execution, so you have to 

confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual 

Operations Bar. 

 

Merging a system partition with an adjacent logical partition 

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming 

applications and system updates your system partition has started to suffer from the lack of free space. But an adjacent 

logical partition has a plenty of redundant space. That’s just enough to make your system partition suffer no more. 

To merge a system partition with an adjacent partition, please do the following: 

1. Click Switch to Full Scale Launcher in the Express Launcher. 

2. In the main window select the required logical volume on the Disk Map. 

 

3. Call the context menu for it (right click of the mouse button) to launch the Make Partition Primary dialog. 

 



202 

Copyright© 1994-2011 Paragon Software Group. All rights reserved. 

4. Confirm the operation by clicking the Yes button. By default, our program works in the virtual mode of 

execution, so you can either confirm all operations to let the program accomplish them or continue work in the 

virtual mode. 

 

5. Click the Merge Partitions item of the Wizards menu (any of the ways described earlier can also be used here). 

6. On the Wizard's Welcome page, click the Next button. 

7. Select a volume you want to expand, i.e. the system one. 

 

8. Select a volume you’d like the first volume to merge with. Please note that all contents of the selected partition 

will be placed into a specific folder after the merge operation is over. 

 

9. Review the changes and complete the wizard. 

10. Apply all introduced changes. By default, our program works in the virtual mode of execution, so you have to 

confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual 

Operations Bar. 
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11. If you’ve got to do with the system partition resize, like we do in our case, you will be asked to restart your 

computer in a special boot-up mode to accomplish the operation. So click the appropriate button to agree. 

12. In the Progress window you can see in real-time a detailed report on all actions carried out at the moment. 

After completing the operation your computer will be automatically restarted back to Windows where you can see that 

you have the merged volume now. 

Shrinking a system partition to increase size of a data partition 

Let’s assume you’ve got two partitions on your hard disk, the first one takes about 40% of all the disk space and is 

exclusively used for Vista 64-bit, while the second servers as a data storage. One day you realize that your system 

partition doesn’t need so much disk space, that’s what your data partition really requires at the moment. You can easily 

tackle this problem with Paragon Linux/DOS recovery environment. 

To increase size of a data partition by taking unused space from a system partition, please do the following: 

1. Start up the computer from our Linux/DOS recovery media. 

 

 

Recovery Media Builder can help you prepare our recovery environment either on a 

CD/DVD disc or a thumb drive. 

To automatically boot from the recovery media please make sure the on-board BIOS is set 

up to boot from CD/USB first. 

 

2. In the boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode 

to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the 

option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware 

incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and 

keyboard drivers. This mode has simple graphics and a simple menu. 

 

  
By default the Normal Mode will be automatically initiated after a 10 second idle period. 

 

3. In the Linux launch menu select Hard Disk Manager. You can find it in PTS DOS as well. 

4. In the main window select the required hard disk (if several) on the Disk Map. 

 

5. Choose your system partition and then call the context menu for it (right click of the mouse button) to launch 

the Move/Resize dialog. 
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6. In the opened dialog set a new size for the partition by moving the slider or by entering the exact value in the 

appropriate field. While doing this, free space from the partition will be released (displayed in aqua-green). Click 

OK to continue. 

 

7. Now you’ve got a block of free space to add to your data partition. 

 

8. Choose the data partition and then call the context menu for it (right click of the mouse button) to launch the 

Move/Resize dialog. 

9. Move the slider to the right to increase size of the partition. Click OK to continue. 

 



205 

Copyright© 1994-2011 Paragon Software Group. All rights reserved. 

10. Apply the pending changes. 

 

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program. 

 

Resizing partitions of Apple Boot Camp 

Let’s assume you’re a Boot Camp user who’s got Windows XP as the second operating system. Initially allocated space 

for the Windows partition has turned out to be insufficient for your current needs. The only way out is to take some 

space from your Mac partition, thus redistributing the unused space between the partitions. 

To increase size of the Windows partition by taking unused space from the Mac partition, please do the following: 

1. Click the Express Resize Partitions item of the Wizards menu. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

2. On the Wizard's Welcome page, click the Next button. 

3. The wizard will automatically select Windows (the NTFS file system) and Mac (the Apple HFS file system) 

partitions of your Boot Camp configuration. 
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On the disk map you can also see the GPT service partition (called EFI) as well as a 128-

megabyte free block between Mac and Windows partitions made with Boot Camp. It’s just 

for your information. 

 

4. Increase size of your Windows partition with the slider or manually by entering the required value. Please note, 

when you change size of one partition the size of the other will be changed as well, thus redistributing the 

unused space between the partitions. 

 

5. On the next page of the wizard you need to confirm the operation by selecting the appropriate option. 

 

6. That’s basically it. By clicking the Next button the wizard will start modifying your disk layout. If you’ve got to do 

with the system partition resize, like we do in our case, you will be asked to restart your computer in a special 

boot-up mode to accomplish the operation. So click the appropriate button to agree. 
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7. In the Progress window you can see in real-time a detailed report on all actions carried out at the moment. 

After completing the operation your computer will be automatically restarted back to Windows where you can see that 

your system partition is bigger now. 

Creating Dual Boot Systems 

For Windows computers 

Release of Windows Vista has given a new impetus to the problem of establishing a dual boot system. In this connection 

we decided to consider two the most frequently used situations a rank and file user may face, i.e. Windows Vista + 

Windows XP and Windows XP + Windows Vista. Please note that for reasons of better security and system 

independence these operating systems will be installed on different partitions. That is why we need to hide the first 

system partition before installation of the second OS. 

Windows Vista + Windows XP 

Suppose you have got Windows Vista coming with your brand new computer. Everything is great except one thing – 

your favourite applications simply reject to work correctly on it. Software updates are expected to release in the near 

future, but you cannot wait any more. Thus the best way out is to leave Windows Vista intact and install the time-

proved Windows XP. 

Most likely you have only one hard disk with only one partition (the only partition is always system). To install the 

second operating system you need to repartition your drive first, as it requires a separate primary partition. 

Install New OS Wizard 

 

  

This scenario implies that operating systems will be installed on different partitions to 

provide better security and system independence. 

 

1. Click the Install New OS item of the Wizards menu. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

2. On the Wizard's Welcome page, click the Next button. 
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3. Select the appropriate option to create a new primary partition on your hard disk. 

 

4. On the next page of the wizard, define size of the new partition. If the selected hard disk contains blocks of free 

space, the wizard will automatically merge them all and allocate the resulted space to create the partition. If 

not, it will take 50% of the unused space of an adjacent partition, thus resizing it. 

 

5. The next page enables to specify a file system and a number of additional parameters. Since we are going to 

install Windows XP, the most preferable file systems are NTFS and FAT32. Click the Yes button to continue. 

 

 

  

On this page you can specify a number of additional parameters that can also be of help. 

However here we pay attention to the most relevant to fulfill our task. 

 

6. Enter a label for the future partition in the textual field. It will later be used for the drive identification. 

 

7. The program will carry out all the necessary operations and then automatically restart the computer to initiate 

the installation process. 

 

  

If you’ve changed your mind on installing a new operating system, don’t insert its 

distributive CD but press ESC when the following message  appears: 
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All the mentioned above operations can also be accomplished with the WinPE recovery 

environment. 

 

8. Install Windows XP on the newly created partition. We won’t go into details as for its installation, as you can find 

all the necessary information in documentation that comes with the product. However to avoid any problems, 

we consider it necessary to draw your attention on the following issues: 

- You need a bootable distributive CD of Windows XP to install it; 

- To automatically start your computer from this CD, make sure the on-board BIOS is set up to boot from CD first 

or press F12 during startup to select a bootable device; 

- Do not forget to select the newly created partition as destination. 

 

9. So if everything is OK, you’ve got to have by this moment Windows XP successfully installed. Your Windows 

Vista however is still non-bootable. To fix this issue you need to launch the Boot Manager Setup wizard. To do 

that, please install our program once again, but this time in Windows XP to activate Boot Manager. 

 

  
To avoid double installation, please use our recovery media to activate Boot Manager. 

 

10. Click Boot Management and then select Boot Manager in the Express Launcher. 

11. Set up the Boot Manager wizard. The parameters offered by default will do in our case, so just complete the 

wizard and it will automatically find the two operating systems and update the MBR. 

 

12. Now restart the computer to make sure you have got a dual boot system. 



210 

Copyright© 1994-2011 Paragon Software Group. All rights reserved. 

Traditional way 

 

  

This scenario implies that operating systems will be installed on different partitions to 

provide better security and system independence. 

 

1. Click Switch to Full Scale Launcher in the Express Launcher. 

2. In the main window select your hard disk on the Disk Map to make a block of free space on it. 

 

3. Release some free space (not less than 10 GB to install Windows XP) from the partition. To do that, please call 

the context menu for the selected partition (right click of the mouse button) and launch the Move/Resize dialog. 
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4. In the opened dialog shift the edge of the partition to the left by the drag-and-drop technique. While doing this, 

free space from the partition will be released (displayed in aqua-green). You can also do it manually by entering 

the exact size of free space. Click the Yes button to continue. 

 

 

  

The Move/Resize dialog offers a number of additional parameters that can also be of help. 

However here we pay attention to the most relevant to fulfill our task. 

 

5. Now you have a block of free space sufficient in size to hold a new partition. 

 

6. Create a new partition to install Windows XP. To do that, please call the context menu for a newly created block 

of free space (right click of the mouse button) and launch the Create Partition dialog. 
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7. Define parameters of the future partition. By all means it has to be primary and since we are going to install 

Windows XP, the most preferable file systems are NTFS and FAT32. Click the Yes button to continue. 

 

 

  

The Create Partition dialog offers a number of additional parameters that can also be of 

help. However here we pay attention to the most relevant to fulfill our task. 

 

8. As a result of the operation we have got a newly created FAT32 partition just enough in size to comfortably 

work with Windows XP. 

 

9. Hide the Windows Vista partition to avoid writing any data on it during the Windows XP installation, as it is the 

best way to provide system independence. To do that, please call the context menu for it (right click of the 

mouse button) and launch the Hide Partition dialog. Click the Yes button to continue. 
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Hiding of the system partition will make OS non-bootable, what is quite normal. 

 

10. Apply all introduced changes. By default, our program works in the virtual mode of execution, so you have to 

confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual 

Operations Bar. 

 

11. The program will require the system restart to accomplish the operation in a special boot-up mode. Click the 

appropriate button to agree. 

 

  

After all the operations are completed you will not be able to restart the system, what is 

quite normal. Nevertheless if you do try it, the following error will occur: 

 

All the mentioned above operations can also be accomplished with the WinPE recovery 

environment. 

 

12. Install Windows XP on the newly created partition. We won’t go into details as for its installation, as you can find 

all the necessary information in documentation that comes with the product. However to avoid any problems, 

we consider it necessary to draw your attention on the following issues: 

- You need a bootable distributive CD of Windows XP to install it; 

- To automatically start your computer from this CD, make sure the on-board BIOS is set up to boot from CD first 

or press F12 during startup to select a bootable device; 

- Do not forget to select the newly created partition as destination. 
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Installation of Windows XP will make Windows Vista non-bootable. 

 

13. Launch the Boot Manager Setup wizard. As your Windows Vista is non-bootable any more, you need to install 

our program once again, but this time in Windows XP to activate Boot Manager. 

 

  
To avoid double installation, please use our recovery media to activate Boot Manager. 

 

14. Click Boot Management and then select Boot Manager in the Express Launcher. 

15. Set up the Boot Manager wizard. The parameters offered by default will do in our case, so just complete the 

wizard and it will automatically find the two operating systems and update the MBR. 

 

16. Now restart the computer to make sure you have got a dual boot system. 

Windows XP + Windows Vista 

If you’ve got Windows XP and are willing to try the latest Windows Vista but not sure your favorite applications will 

flawlessly work on it, the best way out is to leave the time-proved Windows XP intact and install Windows Vista for 

studying purposes. 

As this very situation is very close to the previous one, please use the Windows Vista + Windows XP scenario. However 

please take into consideration one more step you need to accomplish if you decide to use the traditional scenario: 

1. Besides hiding of the system partition before installation of the second OS you need to make it inactive as well. 

To do that, please call the context menu for it (right click of the mouse button) and launch the corresponding 

dialog. Click the Yes button to continue; 
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Reviving the system partition 

In case you are not able or not willing to complete the mentioned above scenarios, but have already reached the point 

when all changes are applied and everything is ready to install the second OS, please do the following to make your 

system bootable once again (only relevant for the traditional scenario): 

1. Start up the computer from our Linux/DOS recovery media. 

 

 

Recovery Media Builder can help you prepare our recovery environment either on a 

CD/DVD disc or a thumb drive. 

To automatically boot from the recovery media please make sure the on-board BIOS is set 

up to boot from CD/USB first. 

 

2. In the Linux launch menu select Hard Disk Manager. 

3. In the main window select your non-bootable Windows partition on the Disk Map. 

 

4. Unhide the partition by calling the context menu for it (right click of the mouse button) and then selecting 

Unhide. 
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5. Only for the Windows XP + Windows Vista scenario you need to make the system partition active as well by 

calling the context menu for it (right click of the mouse button) and then selecting Set Active. 

 

6. You will be notified after the operations are completed. 

 

7. Restart the computer. 
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System Migration Scenarios 

Migrating Windows OS to a solid state drive (Migrate OS to SSD) 

The latest SSDs do not boast high capacity, but rather smaller size and faster processing speeds over regular hard drives. 

Plus, they are completely indifferent to mechanical impact, a feature crucial for mobile computers. These benefits are 

leading more and more users to consider migrating at least OS to SSDs to get the most out of their systems. 

So, how do you migrate a Windows OS and hundreds of gigabytes of data on one huge volume to an SSD drive of 80-

128GB? Our Migrate OS to SSD Wizard can help you do that with minimal effort. 

To migrate any Windows OS since XP from a regular hard disk to a fast SSD, please do the following: 

1. Connect an SSD drive to the computer. 

2. Turn on the computer. 

3. Click the <Migration> button and then select Migrate OS to SSD. 

4. The first page of the wizard informs the user on the upcoming operation. Please read all notes carefully before 

you proceed. To get additional information on the subject, click the Learn more about migrating OS link at the 

bottom of the window (highly recommended). Once you’re done with that, click Next to continue. 

 

 

 

All data stored on the destination disk will be lost during the operation. Please save it to 

another location beforehand. 

 

5. The wizard will scan your computer for system partitions that accommodate any of the supported Windows 

OSes. If several are found, it will let you specify which operating system you'd like to migrate. 
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6. Depending on your choice, it will then automatically pick one or two on-disk partitions (Windows 7 may have 

Microsoft System Reserved, a special hidden partition that contains boot critical files) and prompt you to select 

a destination disk (if there are more than two drives besides the source). If the selected disk is enough in 

capacity to hold your OS, it will prompt you to start the migration. If not (just our case), click on the link below 

the warning note to additionally exclude some data from the partition.  

 

7. Unmark checkboxes opposite unnecessary files or folders to try to fit into the destination disk. We do not 

recommend you to exclude system files, but those that could take plenty of disk space, like video, music, 

photos, etc. Once you’re ready with the exclusion, click OK to let the wizard calculate the resulted size of the 

partition. 
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8. If a success, you’ll see a note that everything’s ready to start the migration. Since we’re going to use our SSD 

drive exclusively for Windows OS, we additionally mark the appropriate checkbox to let the wizard expand the 

resulted partition across all on-disk space. Click Copy to initiate the migration process.  

 

That’s actually it. After the migration is over, you will need to configure the destination disk as the first boot device in 

BIOS to automatically start up the system from it. If a success, delete the Windows OS partition from the source disk, 

then re-partition the disk according to your needs. 

Migrating system to a new HDD (up to 2.2TB in size) 

Let’s assume that you’ve bought a new hard disk that is up to 2.2TB in capacity. It’s faster and of much higher capacity 

than your current system disk, so it’s quite natural you start thinking about system migration. We can help you do that. 

 

 

If the target hard disk exceeds the 2.2TB capacity limit, please consult the Migrating system 

to a 2.2TB+ HDD scenario. 

 

To migrate your system to a hard disk that doesn’t exceed the 2.2TB capacity limit, please do the following: 

1. Connect both source and destination disks to the computer. 

2. Turn on the computer. 

3. Click the Copy Disk item of the Wizards menu. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

4. On the Wizard's Welcome page, click the Next button. 

5. On the Select Hard Disk to Copy page, select a source disk (a hard disk you want to copy). 
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6. On the Select Target Hard Disk page, select a destination disk (a hard disk to copy contents of the source disk). 

 

 

 
During the operation all contents of the destination disk will be deleted. 

 

7. On the next page of the wizard, define the copy options. In our case we’d rather copy data with a proportional 

resize to occupy the entire disk. 

 

8. On the Revise Copy Results page review all parameters of the operation. 
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9. Complete the wizard and then apply the pending changes. 

 

10. When copying is completed, shut down the computer. 

11. Disconnect (physically) the source hard disk. 

12. Boot the computer from the destination hard disk. 

 

 

To make Windows bootable on different hardware, please additionally complete the P2P 

Adjust OS Wizard. 

 

Using 2.2TB+ HDD as internal data storage in Windows XP 

As you know 2.2TB+ drives are out of the supported size range for the popular Windows XP system. Though two new 

Windows versions have been released since XP, it's still utilized on 51% of computers worldwide. Meaning, roughly half 

of PC users simply cannot use the new hard disk drives. 

We can help you augment Windows XP by adding support for GPT (GUID Partition Table) disks, thus you will be able to 

use all disk space on ultra high capacity drives: 

 

GPT Loader enables to use all disk space of modern 2.2TB+ drives under Windows XP, but 

only for storing data, not for the Windows XP accommodation. 

Only internally connected single 2.2TB+ drives are supported, not external storages, or 

those combined into RAID (Redundant Array of Independent Disks). 

1. As an example we’ve taken a new 3TB hard disk (Disk 1 in the system). As you see Windows XP detects it as a 

750GB disk. It’s due to the fact that this operating system works only with MBR (Master Boot Record) disks, so it 

cannot address disk space beyond 2.2TB limit. If a drive exceeds this limit, OS detects the remaining slice of 

space (750GB in our case) only, thus making the bulk of the disk space unavailable to the user. 
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2. First we need to add support for GPT disks to the operating system. To do that, install Paragon GPT Loader. It’s 

included to the product’s installation package, but it’s not allowed to install by default, so please take it into 

account. 

 

 

Windows OSes since Vista do not need functionality of Paragon GPT Loader, so it’s only 

available to install under Windows XP 32/64-bit. 

3. Restart the system when the installation is over. 

4. If you launch Windows Disk Management (WDM) now, it will show the same 750GB, since the hard disk is still 

treated as MBR in the operating system. If you launch our program, you will see that the entire disk space is 

now correctly detected. Being MBR though, there are two unallocated slices: the maximum available for MBR 

2.2TB and 750GB. 
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5. To get access to the entire disk space, we need to convert the disk to GPT. To do that, select in the Main Menu: 

Hard Disk > Convert to GPT hard disk. 

 

6. Confirm the operation and then apply the pending changes. 

 

7. Now you’ve got access to the entire disk space and are able to perform functions such as creating a volume 

using our program or Windows Disk Management. 
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When trying to create a volume in WDM just after the conversion to GPT, you will be asked 

to restart the computer first. The system restart is not required for our program.  

When partitioning in WDM, it additionally creates an MSR (Microsoft Reserved) partition, 

which size may vary from 32MB (for disks up to 16GB in size) to 128MB (for all the others). 

It’s a service partition, which reserves space for particular needs of Microsoft. You won’t 

see it in WDM, but it’s available in our program. You’re free to delete it. 

 

Making system bootable on different hardware (P2P Adjust OS) 

Let’s assume you had to migrate to a new hardware platform. You connected your system hard disk to the brand new 

PC and tried to start up the operating system - you do know for sure now that this operation had been doomed to 

failure from the very beginning. With our program you can easily tackle this naughty problem. 

Before you start, please make sure the following conditions are met: 

 You’ve got drivers for the new hardware ready to use, not zipped or in .exe files. 

 Your OS is unrolled on the new computer, not in a backup image. 

To make a Windows physical system bootable on different hardware, please do the following: 

1. Start up the computer from our WinPE recovery media. 
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Recovery Media Builder can help you prepare our recovery environment either on a 

CD/DVD disc or a thumb drive. 

To automatically boot from the recovery media please make sure the on-board BIOS is set 

up to boot from CD/USB first. 

 

2. Launch the P2P Adjust OS Wizard. 

 

  

Our WinPE 3.0 based environment offers excellent hardware support. However in case it 

doesn’t have a driver for your disk controller, your hard disks will be unavailable. Please 

consult the Adding specific drivers scenario to know how to tackle this issue. 

 

3. On the Wizard's Welcome page, click the Next button. 

4. From the list of all found Windows systems (if several) select one you need to adjust to the new hardware. If 

you’re willing to adjust them all, just re-launch this wizard for each. 

 

5. There are two execution modes to choose from: fully automatic and advance. Below we will go set-by-step 

through the automatic scenario to show the whole process, and then take a closer look at specifics of the 

advance scenario. 

 

6. Select Adjust the OS to the new hardware automatically. 

7. The wizard will automatically accomplish all the necessary actions. 

 

8. The only action that might be required from your side is to set a path to an additional driver repository in case 

the wizard has failed to find drivers for some boot critical devices in the built-in Windows repository. Generally 

together with new hardware you get its drivers for different operating systems on removable media (mostly CD 

or DVD). By collecting all these drivers in one folder you can let the wizard automatically pick and install only 

those required for your OS. Select Search for drivers in a specific folder. 
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Click on the link at the bottom of the page to see what boot critical devices have no drivers. 

The wizard names all devices according to their model description, not some alphanumeric 

code, which is very convenient. 

 

9. Though you’ve got the option to continue without injecting missing drivers for boot critical devices (The Ignore 

all missing drivers option), we strongly recommend you not to do it. Otherwise we cannot guarantee your 

Windows will start up on the new hardware. 

 

10. The wizard can search for drivers on a local disk or a mapped network share. In our case it’s on a network share, 

this is why we need to map it first. 
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11. When done, we can select it as target. 
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The wizard enables to specify several driver repositories. 

 

12. If the wizard has found all missing drivers, it will ask you to confirm the operation. Apply the changes to 

complete. 

 

After the operation is completed the system will be bootable on the new hardware. After the startup, Windows will 

initiate reconfiguration of all Plug'n'Play devices. It’s a standard procedure, so please don’t worry and prepare the latest 

drivers at this step to get the most out of the system. 

Advance scenario specifics 

1. To launch the advance mode, select Set parameters for the OS adjustment. 

 

2. When setting additional driver repositories, you can specify how to process drivers for found hardware. 

 

 Inject all necessary drivers… Mark the checkbox to force injection of all drivers for your devices from the 

given driver repository(s), even if there are already installed drivers for some hardware. Please use this 

option if you suspect any of the installed drivers of not matching your hardware. 
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 Keep the latest driver version. Mark the checkbox to keep the latest version of drivers during the forced re-

injection. You can use this option only when the above option is active. 

3. Just before the OS adjustment, you can additionally: 

 View all found hardware devices and their driver status by clicking . The wizard names all devices 

according to their model description, not some alphanumeric code, which is very convenient. So you can 

compare the listed devices with the given hardware to make sure the wizard has analyzed your system 

correctly. 

 

 Filter devices without drivers by clicking . Unlike the automatic mode, where only boot critical devices 

(storage controllers) without drivers are being reported, here you can view and inject drivers for network 

cards as well. 

 

 Add a driver for each device that lacks it by clicking on the device, then browsing for the required location. 

The wizard will then match the device with drivers inside the given location and pick the right one. 
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 Manually add a driver for a device that has not been found by our wizard by clicking , then specifying 

the required .INF file. 
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When selecting an .INF file that contains several driver records for hardware you both, have 

in the system and don’t have, you can filter the list by marking the appropriate checkbox. 

 

 Remove a driver for a device, which has not been found in the system. 

 

Virtualizing the current system (P2V Copy) 

Let’s assume that you’re about to migrate to a brand-new hardware platform with the latest operating system available 

for it. Your current system is quite obsolete, but you still need access to some of its software. You don’t want to waste 
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time re-installing the old software to the new system, and you do know for sure that the bulk of it won’t work anyway. 

The best way out is to virtualize your old system. 

But before you start, please make sure the following conditions are met: 

 Your hard disk has enough free space to store a virtual image of your Windows (depends on the system). 

 You’ve got one of the supported virtualization software. 

To make a virtual disk out of your current system, please do the following: 

1. Click the P2V Copy item of the Wizards menu. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

2. On the Wizard's Welcome page, click the Next button. 

3. Select objects you need to virtualize. You’re allowed to select any combination of hard disks and partitions, but 

don’t forget to choose your system partition (Local Disk C: in our case) to use it as guest. Otherwise the resulted 

virtual machine won’t start up. 

 

4. Specify the guest OS and a virtualization software vendor. If your system hosts several Windows OSes, our 

wizard will find them all and automatically patch to run in a virtual environment. However we cannot guarantee 

smooth startup of all found Windows systems for their configuration parameters may be incompatible with 

each other. This is why we additionally prompt you to specify what operating system you’d like to use as guest 

to configure the virtual machine for that particular system. 
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Not all vendors may be available to choose. If capacity of one of the selected objects 

exceeds the maximum virtual disk capacity of any vendor, this vendor will be shadowed. 

 

5. Set properties of the future virtual machine: 

 Virtual machine version. Please make sure you choose a version which is supported by your virtualization 

software, otherwise you won’t be able to work with the newly created machine. 

 Virtual machine name. By default the wizard picks the name of your guest OS, which can be modified 

however. 

 CPU number. If your computer supports multiprocessing, select how many CPUs you’d like to allocate for 

the virtual machine. 

 Memory amount. Depending on the guest OS the wizard calculates the recommended size of RAM, which 

can be modified however. 

 

6. Set properties of the resulted virtual disk(s): 
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 Virtual disk interface. By default the wizard sets the most appropriate interface for each disk. Anyway 

you’ve got the option to change it to one of the supported by your guest OS. Just click on a disk, and then 

select the required interface from the pull-down list. But be ready to provide drivers for it on the next page. 

 

 

 

 

Our program supports injection of drivers delivered in .iso or .flp images, so you can for 

instance download and inject drivers for the BusLogic controller from the VMware website. 

 

 Additional properties that depending on the selected virtualization vendor may include: 

- Size of the virtual disk. By default the wizard offers to create a virtual disk exactly the size of the selected 

object(s), which you can resize however (available for all); 

- Resize partitions proportionally. If you upsize the resulted virtual disk, you can make the wizard 

proportionally change the size of partitions keeping their relative order intact (available for all); 

- Create a split disk. You can choose whether to automatically cut the resulted virtual image to files of 2 

GBs or not (available for VMware only); 

- Pre-allocate all disk space. You can choose whether to pre-allocate all space of the future virtual disk, or 

do it dynamically (not available for VMware ESX and Oracle VirtualBox). 

 

 

 
The maximum limit you can downsize the virtual disk is the capacity of its first partition. 

 



235 

Copyright© 1994-2011 Paragon Software Group. All rights reserved. 

7. Specify a file name for the virtual machine and its location. By default the wizard scans all your local disks for 

available free space and picks the most appropriate location taking into account the total capacity of all virtual 

disks inside the virtual machine. 

 

8. Complete the wizard and then apply the pending changes. 

 

Virtualizing system from its backup image (P2V Restore) 

Let’s assume that your system has been corrupted as a result of a hardware failure. You realize it’s quite obsolete and 

it’s next to impossible to replace the damaged hardware devices. Migration to a new hardware platform seems the best 

way out, if not for one thing – you still need access to your software, but you do know for sure that the bulk of it won’t 

work on the new platform. Luckily you’ve got a backup image of your old system made with Paragon software – that’s 

just enough for its virtualization. 

Before you start, please make sure the following conditions are met: 

 You’ve got a backup image of your old system. 

 You’ve got enough free space to store a virtual image of your old system (depends on the system). 

 You’ve got one of the supported virtualization software. 

To restore a Windows system from a Paragon’s backup directly to a virtual environment, please do the following: 

1. Click the P2V Restore item of the Wizards menu. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 
2. On the Wizard's Welcome page, click the Next button. 

3. Browse for the required backup image. The section below (i.e. Archive File Details) will also display a short 

description of the selected image. 
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4. Select objects you need to virtualize. You’re allowed to select any combination of hard disks and partitions, but 

don’t forget to choose your system partition (Local Disk C: in our case) to use it as guest. Otherwise the resulted 

virtual machine won’t start up. 

 

5. Specify the guest OS and a virtualization software vendor. If the selected backup contains several Windows 

OSes, our wizard will find them all and automatically patch to run in a virtual environment. However we cannot 

guarantee smooth startup of all found Windows systems for their configuration parameters may be 

incompatible with each other. This is why we additionally prompt you to specify what operating system you’d 

like to use as guest to configure the virtual machine for that particular system. 
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When using old Paragon’s backup images (prior to Backup & Recovery 10), please be ready 

to manually specify the guest OS. 

Not all vendors may be available to choose. If capacity of one of the selected objects 

exceeds the maximum virtual disk capacity of any vendor, this vendor will be shadowed. 

 
6. Set properties of the future virtual machine: 

 Virtual machine version. Please make sure you choose a version which is supported by your virtualization 

software, otherwise you won’t be able to work with the newly created machine. 

 Virtual machine name. By default the wizard picks the name of your guest OS, which can be modified 

however. 

 CPU number. If your computer supports multiprocessing, select how many CPUs you’d like to allocate for 

the virtual machine. 

 Memory amount. Depending on the guest OS the wizard calculates the recommended size of RAM, which 

can be modified however. 
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If the selected version does not officially support the guest OS, you will be notified and 

prompted to select another one. 

 
7. Set properties of the resulted virtual disk(s): 

 Virtual disk interface. By default the wizard sets the most appropriate interface for each disk. Anyway 

you’ve got the option to change it to one of the supported by your guest OS. Just click on a disk, and then 

select the required interface from the pull-down list. But be ready to provide drivers for it on the next page. 

 

 

 

 

Our program supports injection of drivers delivered in .iso or .flp images, so you can for 

instance download and inject drivers for the BusLogic controller from the VMware website. 

 

 Additional properties that depending on the selected virtualization vendor may include: 

- Size of the virtual disk. By default the wizard offers to create a virtual disk exactly the size of the selected 

object(s), which you can resize however (available for all); 

- Resize partitions proportionally. If you upsize the resulted virtual disk, you can make the wizard 

proportionally change the size of partitions keeping their relative order intact (available for all); 

- Create a split disk. You can choose whether to automatically cut the resulted virtual image to files of 2 

GBs or not (available for VMware only); 

- Pre-allocate all disk space. You can choose whether to pre-allocate all space of the future virtual disk, or 

do it dynamically (not available for VMware ESX and Oracle VirtualBox). 
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The maximum limit you can downsize the virtual disk is the capacity of its first partition. 

 
8. Specify a file name for the virtual machine and its location. By default the wizard scans all your local disks for 

available free space and picks the most appropriate location taking into account the total capacity of all virtual 

disks inside the virtual machine. 

 

9. Complete the wizard and then apply the pending changes. 

 

Creating an empty virtual disk (Create VD) 

To create an empty virtual disk, please do the following: 

1. Click the Create Virtual Disk item of the Wizards menu. 

2. On the Wizard's Welcome page, click the Next button. 

3. Select Create an empty virtual disk. 

 

4. Specify a virtualization software vendor and a number of additional parameters, including: 

 Type of the virtual disk. You can either create an IDE or a SCSI virtual disk (relevant for VMware only); 

 Create a split disk. You can choose whether to automatically cut the resulted virtual image to files of 2 GBs 

or not (available for VMware only); 

 Pre-allocate all disk space. You can choose whether to pre-allocate all space of the future virtual disk, or do 

it dynamically (not available for VMware ESX and Oracle VirtualBox); 
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5. Specify a file name for the resulted virtual disk and its location. 

 

6. Complete the wizard and then apply the pending changes. 

 

Making Windows Vista/7 backup bootable on virtual hardware (P2V Adjust OS) 

As you probably know, Windows Vista and later operating systems from Microsoft include a built-in disaster recovery 

tool, which enables to create backup images of Windows OS in a .vhd (Virtual Hard Disk) format, used now by Microsoft 

Virtual PC/Server/Hyper-V, and Oracle VirtualBox. Unfortunately you cannot just take this type of backup to run 

Windows OS in a virtual environment – it won’t start up. We can help you out with this naughty problem. Our P2V 

Adjust OS Wizard can patch Windows OS inside a .vhd backup image according to the specified virtualization vendor to 

let you start up and work with your Windows on virtual hardware. 

To make a Windows .vhd backup image start up in a virtual environment, please do the following: 

1. Click the P2V Adjust OS item of the Wizards menu. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

2. On the Wizard's Welcome page, click the Next button. 

3. Browse for the required .vhd backup image of your Windows. 
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4. Our wizard will detect a version of Windows OS inside the image and offer to specify a virtualization software 

vendor. At the present moment the .vhd format is supported by Microsoft Virtual PC/Server/Hyper-V, and 

Oracle VirtualBox. We choose the last one. 

 

5. Set properties of the future virtual machine: 

 Virtual machine version. Please make sure you choose a version which is supported by your virtualization 

software, otherwise you won’t be able to work with the newly created machine. 

 Virtual machine name. By default the wizard picks the name of your guest OS, which can be modified 

however. 

 CPU number. If your computer supports multiprocessing, select how many CPUs you’d like to allocate for 

the virtual machine. 

 Memory amount. Depending on the guest OS the wizard calculates the recommended size of RAM, which 

can be modified however. 
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If the selected version does not officially support the guest OS, you will be notified and 

prompted to select another one. 

 

6. Complete the wizard and then apply the pending changes. 

 

Connecting a virtual disk (Connect VD) 

You’ve got the option to connect a virtual disk of one of the supported types directly to our program as if it’s an ordinary 

physical disk, so opening up enormous possibilities: 

 Exchange data between your physical environment and the virtual one through Volume Explorer (data import 

only) or File Transfer Wizard (data import and export). The way we offer is much easier and faster, as you don’t 

need a VM shared folder, the network, or the slow-goer drag-and-drop; 

 Import data from a parent virtual disk to one of its snapshots; 

 Accomplish drive partitioning (create, format, delete, move, resize, etc.); 

 Modify partition attributes (Active flag, Hidden flag, Volume Label, etc.); 

 Clone a partition or an entire hard disk; 

 Edit/View sectors, and many more. 

To connect a virtual disk (snapshot) to our program, please do the following: 

1. Click the Connect a Virtual Disk item of the Hard Disk menu. 

2. In the opened dialog browse for the required virtual disk, then click Connect to accomplish the operation. 

You’ve also got the option to connect this disk in the read-only mode or/and have it connected automatically at 

every program startup by marking appropriate checkboxes. 
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Click the “Show recently used disks” link to select and connect one of the disks you’ve 

already worked with. 

 
3. That’s all. The selected virtual disk will be available on the disk map, as if it’s an ordinary physical disk. 

 

Limitations: 

 A virtual disk opened for writing with a 3rd party tool (e.g. being used by a virtual machine) won’t be connected, 

as asynchronous parallel writing to the disk file will most likely result in data corruption; 
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 A virtual disk opened for reading with a 3rd party tool (e.g. it’s a parent VMware disk, which snapshot is being 

used by a virtual machine) will be opened for reading only with the corresponding notification; 

 A double disk connection is prohibited. 

Repartitioning a virtual disk 

Let’s assume you’ve got several partitions on a virtual disk. After installing a number of resource-consuming applications 

and system updates the system partition has started to suffer from the lack of free space. But an adjacent partition has 

a plenty of redundant space. That’s just enough to make the system partition suffer no more. 

To increase size of a system partition by taking unused space from an adjacent partition, please do the following: 

1. Connect the required virtual disk to our program. 

2. Select it on the disk map. 

 

3. Right click on the space donor partition, then select Move/Resize Partition… 
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In case you’ve got more than two partitions on the disk, and the required space donor is 

not adjacent to the system partition, you can still use this scenario by consecutively 

redistributing free space between all partitions involved in the operation. 

 
4. In the opened dialog drag-and-drop the left edge of the partition to the right to release the required amount of 

the free space (displayed in aqua-green). You can also do it manually by entering the exact size of free space. 

 

5. Now you’ve got a block of free space to add to the system partition. 

 

6. Right click on the system partition, then select Move/Resize Partition… 
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7. In the opened dialog shift the right edge of the partition to the right end, thus increasing its size. 

 

8. Apply all introduced changes. By default, the program works in the virtual mode of execution, so you have to 

confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual 

Operations Bar. 

9. When done, either disconnect the virtual disk or close our program. 

Exchanging data between physical and virtual environments 

Let’s assume you need to import a lot of data from one of your virtual disks. The best way out is to use our program, as 

it can help you do that without starting up the virtual environment and the other actions typical for this task. 

To import data from a virtual environment, please do the following: 

1. Connect the required virtual disk to our program. 

2. Select in the Main Menu: Tools > File Transfer Wizard (any of the ways described earlier can also be used here). 

3. On the Wizard's Welcome page, click the Next button. 
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4. Select a disk where the required data is stored from the pull-down list in the right pane of the window. You can 

find it among physical partitions, as a connected virtual disk cannot have an assigned drive letter either. 

 

 

 

To easily find the required disk, please use its volume label or sequence number as a check 

point. 

 
5. Select files you want to copy and place them to Clipboard by pressing the left arrow-button. Click Next to 

continue. 

 

6. Select the Save data to local/network drives item. Click Next to continue. 

 

7. Specify the exact place to copy the data to. 



248 

Copyright© 1994-2011 Paragon Software Group. All rights reserved. 

 

8. Finish the wizard to accomplish the operation. 

Copying data from a parent virtual disk to one of its snapshots 

Let’s assume you’ve got a virtual machine with several snapshots. You need to copy some data from a parent image to 

one of its snapshots. You can’t just roll back to the parent image, as you don’t want to lose the latest data of the 

snapshot, so the best way out is to copy the required data from the parent image to the snapshot. 

To copy data from a parent image to one of its snapshots, please do the following: 

1.  Connect the required snapshot disk to our program. 

2. Connect its parent disk to our program. It’ll be connected for reading only. 

3. Copy the required data from the parent disk to the snapshot. 

4. Disconnect the virtual disks or close the program. 

Migrating from one virtual environment to another (V2V) 

Let’s assume you’re willing to shift to another virtualization software vendor (e.g. from Microsoft Virtual PC to VMware 

Workstation). The only thing that holds you back from it is a lot of virtual machines of MS Virtual PC, which are not fully 

compatible with VMware Workstation. Don’t worry, we can help you out. 

 

 

Before you start, please make sure you’ve got enough free space to accomplish the 

operation. 

 

To make a virtual machine of one vendor out of an existing virtual machine of another vendor, please do the following: 

1. Connect all virtual disks of the required virtual machine to our program. 

2. Complete the P2V Copy Wizard. Do not forget to select all virtual disks as objects of virtualization. 

As a result you’ll get two virtual machines containing the same virtual environment, but of different vendors. You can 

now delete the original to release some free space. 

Hard Disk Optimization 

To defragment an NTFS or FAT partition, please do the following: 
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You must have administrator’s privileges to accomplish defragmentation of the system 

partition. 

 

1. Click the <Security and Optimization> button and then select Defragment Partition. 

2. In the main window, select a partition you want to defragment on the Disk Map. 

 

3. Launch the Defragment Partition dialog by calling the popup menu for the selected partition (right click of the 

mouse button) and then selecting the menu item: Defragment Partition… 

 

4. In the opened dialog define settings of the operation. To improve the performance we recommend you to mark 

the Do not save content of the Pagefile.sys or (and) Hiberfile.sys checkbox as these files are only needed for 

the current Windows session. 

 

 

  

The Defragment Partition dialog offers a number of additional parameters that can also be 

of help. However here we pay attention to the most relevant to fulfill our task. 

 

5. Start the operation by clicking the Yes button. 
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Hard Disk Utilization 

To irreversibly destroy all on-disk information without any possibility to recover and that way providing the maximum 

level of security, please do the following: 

1. In the Main Menu: select Wizards > Wipe Hard Disk or Partition… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

2. On the Wizard's Welcome page, click the Next button. 

3. Select a hard disk, the data of which you want to wipe out. 

 

4. On the Wipe Mode page, select the wipe out all the data to irreversible destroy all on-disk information. 

 

5. On the Wipe Method page select a specific data erasure algorithm or choose to create a customized one (in our 

case we prefer to use a certified military standard). 

 

 

  
The list of supported military and government standards may vary for your product. 

 

6. The next page of the wizard enables to get detailed information on the selected algorithm, choose whether to 

carry out residual data verification or not specifying the percentage of sectors to check and estimate the time 

required to accomplish the operation. 
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7. Review all parameters of the operation and modify them if necessary. 

 

8. Complete the wizard and then apply the pending changes. 

Extra Scenarios for WinPE 

Adding specific drivers 

Our WinPE 3.0 based recovery environment offers excellent hardware support. Anyway you’ve got the option to add 

drivers for specific hardware with a handy dialog. 

To add drivers for specific hardware, please do the following: 

1. Once you accept the agreement, you will see the Universal Application Launcher. Click Load Drivers. 

2. In the opened dialog browse for an .INF file of the required driver package located on a floppy disk, local disk, 

CD/DVD or a network share. Then click the Open button to initiate the operation 
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To know how to map a network share, please consult the Configuring network scenario. 

 

3. You will be notified on the successful accomplishment of the operation. Click Yes to load another driver or No to 

close the dialog. 

 

 

 

Our WinPE 3.0 recovery environment is 32-based, thus you need to use 32-bit drivers for 

injection. 

 

Configuring network 

If your local network has a DHCP server, a network connection will be automatically configured once our WinPE 

recovery environment has been started up. Otherwise you will need to do it manually with a handy dialog by providing 

an IP address, a network mask, default gateway, etc. Besides with its help you can easily map network shares.   

To manually set up a network connection and map a network share, please do the following: 

1. Once you accept the agreement, you will see the Universal Application Launcher. Click Configure Network. 

2. In the opened dialog provide an IP address, a network mask, default gateway, etc. for your network device. 
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3. Click the Network drivers tab to map a network share. 

 

4. Click Map Network Drive and provide all the necessary information to map a network share in the opened 

dialog:  

 

 Click the standard browse button [...] to browse for the required network share or manually enter a path to 

it; 

 Define a letter from the pull-down list of available drive letters; 

 Click the Connect as user button at the foot of the dialog page to specify a user name and password to 

access the selected network share if necessary. 

By clicking Disconnect Drive… you can delete an existing network share if necessary. 

5. Click the Network identification tab to change a network name of your computer (generated automatically) and 

a workgroup name. 

 

6. By default, the wizard saves all network settings in the netconf.ini file located on the WinPE RAM drive, thus it 

will only be available until you restart the computer. However, you can just once configure your network device 

and then save this file to some other destination, for instance a local drive, and this way avoid constant re-
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configuration, just by providing a path to it. So Click Save to file to save the netconfig.ini file to the required 

destination. 

Saving log files 

The program enables to simplify the procedure of sending support requests to the Paragon Support Team. In case of 

having difficulties with handling the program, you, with the help of this very function, can address the company support 

engineers and provide them with all the information they need such as the disk layout, performed operations, etc. in 

order to tackle the encountered problem. Information of that kind is stored in log files. 

To prepare a log files package, please do the following: 

1. Once you accept the agreement, you will see the Universal Application Launcher. Click Log Saver. 

2. In the opened dialog browse for the required location of the log files package or manually provide a full path to 

it. Click Collect to initiate the operation. 

 

 

 

Log files do not contain any confidential information on the operating system settings or 

the user documents. 

 

Troubleshooter 

Here you can find answers to the most frequently asked questions that might arise while using the program. 

1. I try to run an operation, but the program claims my partition is in use and suggests restarting the computer. 

There are a number of operations that cannot be performed while your partition is in use (or locked in other 

words). Please agree to reboot your machine to make the program accomplish the operation in a special boot-

up mode. 

2. I run an operation and restart the machine as required, but it just boots back into Windows without 

accomplishing the operation. 

Please run 'chkdsk /f' for the partition in question. 

3. I cannot create a new partition on the disk. 

There can be a number of reasons for that: 

 The program cannot create a new partition on a dynamic disk. 

 The program allows creating new partitions only within blocks of un-partitioned space. It cannot convert 

a free space on an existing partition to a new partition. 

4. I cannot copy a partition. 

There can be a number of reasons for that: 

- The source or target disk you select is a dynamic disk; 

- 4 primary partitions (or three primary partitions and an extended one) already exist on the target disk. 
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5. I need to copy a partition. But when selecting a place where to make a copy, I always get a crossed circle sign no 

matter which partition is selected. 

The program enables to copy a partition only to a block of un-partitioned space. If you don’t have a block of free 

space on your hard disk, please delete or reduce an existing partition to accomplish the operation. 

6. I cannot do anything with my USB flash drive. I get a crossed circle sign when trying to select any area on it. 

Some USB flash drives don't have the MBR (Master Boot Record), that’s the cause of your problem. To fix the 

issue please use the Update MBR function of our program or 'fixmbr' of the Windows installation disc to write a 

standard code to your flash drive. 

7. When trying to back up my system the program asks to restart the computer. 

Most likely the Hot Processing mode is disabled. Please make it active in the program settings. 

8. When backing up a partition with the VSS (Volume Shadow Copy Service) mode, the program throws "VSS could 

not be started for processed volume". 

Most likely you try to back up a FAT32 partition, which is not supported by VSS. Please use the Paragon Hot 

Processing mode instead. 

9. I cannot back up my hard disk to an external hard drive. Once started, the operation is aborted with the 

following error: Hard Disk management, Error Code 0x1100a. What is wrong here? 

The problem is that the Microsoft VSS service is set as the default Hot Processing mode in the program. But this 

service has not been started in your WindowsXP/Windows2003/Vista. Please start this service (right click on My 

Computer > Manage > Services > find Microsoft Volume Shadow Copy Service and make it active. Set also to 

start it automatically). 

10. When running a backup operation with the Paragon Hot Processing mode enabled, I get an error: error code 

0x1200e "Internal error during Hot Backup" 

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer's tool. 

You can find a name of the tool you need here: http://kb.paragon-software.com 

11. When running a backup operation with the Microsoft VSS mode enabled, I get the following error: error code 

0x12016 "VSS: can't read volume data” 

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer's tool. 

You can find a name of the tool you need here: http://kb.paragon-software.com 

12. When trying to back up to a network share, I get the following error: "i/o error" or "can't open/create file" 

Please check whether you’ve got a permission to write to the selected destination or not. 

13. When trying to restore a backup archive, I get the following error: "Can't restore to current selection" or 

"Archive does not fit" 

Most likely you’re trying to restore a backup of the whole hard disk to a partition or vice versa. 

14. I set up a timetable for a task, but it fails to execute. 

There can be a number of reasons for that: 

- Windows Task Scheduler does not work properly. Check whether it is so or not by scheduling a simple task (call 

Notepad through scheduling); 

- You don’t have permission to write to the selected backup destination. 
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Glossary  

Active Partition is a partition from which an x86-based computer starts up. The active partition must be a primary 

partition on a basic disk. If you use Windows exclusively, the active partition can be the same as the system volume.  

In the DOS partitioning scheme, only primary partitions can be active due to limitations of the standard bootstrap. 

The term backup originates from the time when the best way to protect valuable information was to store it in form of 

archives on external media. It’s become now a general notion to mean making duplications of data for protection 

purposes. 

Bootable Archive is created by adding a special bootable section when backing up the data to CD/DVDs. Thus you will 

be able to restore the data from these archives without having to run the program, but by simply booting from these 

CD/DVDs. 

Cluster is the smallest amount of disk space that can be allocated to hold a file. All file systems used by Windows 

organize hard disks based on clusters, which consist of one or more contiguous sectors. The smaller the cluster size, the 

more efficiently a disk stores information. If no cluster size is specified during formatting, Windows picks defaults based 

on the size of the volume. These defaults are selected to reduce the amount of space that is lost and the amount of 

fragmentation on the volume. A cluster is also called an allocation unit. 

Extended Partition is a partition type you create only on a basic MBR (Master Boot Record) disk. Extended partition is 

used if you want to create more than four volumes on a disk, since it may contain multiple logical drives. 

File System Metadata. The servicing structures of a file system, which contain information about allocating files and 

directories, security information etc, are named the file system metadata. It is invisible for users and regular 

applications because its accidental modification usually makes a partition unusable. 

Hard Disk Geometry. Traditionally, the usable space of a hard disk is logically divided into cylinders, cylinders are 

divided into tracks (or heads), and tracks are divided into sectors. 

The triad of values {[Sectors-per-Track], [Tracks-per-Cylinder], [Amount-of-Cylinders]} is usually named the Hard Disk 

Geometry or C/H/S geometry. 

Tracks and cylinders are enumerated from "0", while sectors are enumerated from "1". These disk parameters play an 

essential role in the DOS Partitioning scheme. 

Modern hardware uses an advanced scheme for the linear addressing of sectors, which assumes that all on-disk sectors 

are continuously enumerated from “0”. To allow backward compatibility with older standards, modern hard disks can 

additionally emulate the C/H/S geometry. 

Hidden Partition. The concept of a "hidden" partition was introduced in the IBM OS/2 Boot Manager. By default, an 

operating system does not mount a hidden partition, thus preventing access to its contents. 

A method of hiding a partition consists in changing the partition ID value saved in the Partition Table. This is achieved by 

XOR-ing the partition ID with a 0x10 hexadecimal value. 

Master File Table (MFT) is a relational database that consists of rows of file records and columns of file attributes. It 

contains at least one entry for every file on an NTFS volume, including the MFT itself. MFT is similar to a FAT table in a 

FAT file system. 

MBR & 1st track of the hard disk is the 0th sector of the disk. MBR (Master Boot Record) contains important 

information about the disk layout: 

- The used partitioning scheme; 

- The starting records of the Partition Table; 

- The standard bootstrap code (or the initial code of boot managers, disk overlay software or boot viruses). 
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Generally, the 0th sector is used for similar purposes in all existing partitioning schemes.  

The MBR capacity is not sufficient to contain sophisticated boot programs. That’s why the on-boot software is allowed 

to use the entire 0th track of the disk. For example, boot managing utilities such as LILO, GRUB and Paragon Boot 

Manager are located in the 0th track. 

Partition ID (or File system ID) is a file system identifier that is placed in the partition. It is used to quickly detect 

partitions of supported types. A number of operating systems completely rely on it to distinguish supported partitions. 

Partition ID is saved in appropriate entries of the Partition Table and takes only 1 byte of space. 

Partition Label (or Volume Label) is a small textual field (up to 11 characters) that is located in the partition's boot 

sector. This value is used for notification purposes only. It is detectable by any partitioning tool including the DOS FDISK 

utility. 

Modern operating systems save it within a file system, e.g. as a special hidden file. Thus it is able to contain a relatively 

large amount of text in multiple languages. 

Partitioning Scheme is a set of rules, constraints and format of the on-disk structures to keep information on partitions 

located on a hard disk. 

There are known several partitioning schemes. The most popular of them is the so-called DOS partitioning scheme. It 

was introduced by IBM and Microsoft to use multiple partitions in the disk subsystems on IBM PC compatible 

computers. 

Another popular partitioning scheme is the so-called Logical Disks Model (LDM) that originates from the UNIX 

mainframe systems. Veritas Executive accommodates a simplified version of LDM to the Windows 2000 operating 

system. 

Windows 2000 and XP support two quite different partitioning schemes: the old DOS partitioning scheme and the new 

Dynamic Disk Management (DDM). The problem is that earlier versions of Windows do not support DDM. In addition, 

most hard disk utilities do not support it as well. 

Recovery Media is a CD/DVD disc, a USB flash card or even a floppy disk from which you can boot for maintenance or 

recovery purposes. 

Root Directory is the top-level directory of a formatted logical drive to include other files and directories. In modern file 

systems (Ext2/Ext3, NTFS and even FAT32) it does not differ from other directories. This is not the case for old FAT12 

and FAT16 file systems. 

Serial Number. In the DOS partitioning scheme, every hard disk and every partition has a 32-bit serial number 

represented by an 8-figure hexadecimal value. It is stored in the MBR and its value is assigned when the MBR sector is 

initialized by Microsoft standard disk managing tools, such as Windows Disk Administrator and the FDISK utility. 

In fact, a hard disk's serial number is not important for most operating systems and software. It is known that Windows 

NT, 2000 and XP store its value in the database of assigned drive letters. 

A partition's serial number is stored in its boot sector (in FAT16, FAT32 and NFTS file systems). Its value is assigned when 

the partition is formatted. It does not play an important role for most operating systems and software as well. 


